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Chapter 1: Introduction

This document provides information about installing, configuring, and using
the Wavelink Telnet Client for Windows CE-based mobile devices.

This section provides the following information:
¢ Document Assumptions

¢ Document Conventions

¢ Document Revision History

* About the Telnet Client

¢ Telnet Client Version and Supported Features Matrix

Document Assumptions

This document assumes that the reader has the following:

¢ Familiarity with Windows CE operating systems and the mobile device to
which you are deploying the Wavelink Telnet Client.

* Knowledge of wireless networks and wireless networking protocols (IEE
802.11b).

¢ Knowledge of TCP/IP, including IP addressing, subnet masks, routing,
BOOTP/DHCP, WINS, and DNS.

¢ Knowledge of Telnet services and terminal emulation, including IBM
5250/3270, HP, and VT100/220.

* Knowledge of Wavelink Avalanche Manager and Avalanche Enablers

(optional, for users that intend to install and configure the Telnet Client via
Avalanche Manager).

Document Conventions

The following section contains information about text-formatting conventions
in this manual.
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Table 1-1 lists the conventions that are used in this manual.

Convention Description

courier new Any time you interact directly with text-based user interface
options, such as a button, or type specific information into an
text box, such as a file pathname, that option appears in the
Courier New text style. This text style is also used for
keys that you press, filenames, directory locations, and
status information.

For example:
Press ENTER.

Click OK.

bold Any time this document refers to a labelled user interface
option, such as descriptions of the choices in a dialog box,
that option appears in the Bold text style.

Examples:
Enable the DHCP checkbox.

Access the Telnet Client Session menu.

italics Italicized text is used to indicate the name of a window or
dialog box.

For example:
The Update Utility dialog box.
The Profile Manager dialog box.

Table 1-1: Text-Formatting Conventions

If you have questions about the terminology in this document, see the
Glossary on page 263.
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Document Revision History

The following table shows the Wavelink Telnet Client User’s Guide revision

history:
Release

Document Number Date Notes

wltn-cegeneric-200411120-01 11/12/04 Initial release of generic Telnet Client
document

witn-wince-20040729-02 07/29/05 - Reorganized manual into new chapters
and sections
- Added information to support new Telnet
Client version 5.0 and 5.1 features,
including SSL, scripting, and the keyboard
builder

witn-wince-20050805-03 08/05/2005 Updated screen captures

wltn-ug-20060818-04 07/21/2006 - Added information to support new Telnet

Client Industrial Browser feature

- Changed name from “TelnetCE Client” to
“Telnet Client”

Table 1-2: Document Revision History

About the Telnet Client

This section provides an overview of the Telnet Client.

Telnet Client Overview

The Telnet Client is a Windows-based application that facilitates IBM 5250/
3270, VT 100/220, HP Telnet, and WEB emulation.

Deployment Methods

Currently, you can use one of the following methods to install and configure
the Telnet Client on a mobile device:

* Microsoft ActiveSync. You can install the Telnet Client configuration
utility on a host PC. The configuration utility uses an ActiveSync
connection between the host PC and the mobile device to deploy the
Telnet Client and Telnet Client configurations to the mobile device.
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* Wavelink Avalanche Manager. If your mobile device is running the
Avalanche Enabler, you can use Avalanche Manager to deploy the Telnet
Client and Telnet Client configurations to a mobile device.

e Third-Party Applications. Wavelink supports some third-party
deployment applications. For more information about supported
deployments for your device, please see the Telnet Client installation
guide for your mobile device.

Telnet Client Components

The Telnet Client has a number of configurable components, including:

* Host profiles

* Emulation parameters

¢ Localization

¢ SSL settings

* Scripts

* Virtual keyboards

NOTE Scripts and virtual keyboard settings may only be deployed to mobile
devices via Avalanche Manager. If you are using Microsoft ActiveSync or a
third-party application to deploy the Telnet Client and Telnet Client
configurations to your mobile devices, you will need to manually transfer the
script files and virtual keyboard files to each mobile device.

About Host Profiles

A host profile contains all of the information that a mobile device needs to
connect to a particular host, including the IP address of the host, the TCP port
number on which the host is listening for Telnet requests, the emulation type,
and login information.

Host profiles provide an easy way for users at a mobile device to establish a
connection with a host without having to remember the parameters that are
required to establish the session.
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About Emulation Parameters

The configuration utility allows you to configure the emulation parameters

for Telnet sessions. For example, you can change the way the virtual screen

displays on the mobile device, the type and size of font that is used, and the
type of printer to which the mobile device may be connected.

You can configure global and per-host emulation parameters.

Global emulation parameters apply to terminal emulation with hosts for
which you have not configured a per-host profile.

Configuring per-host emulation parameters allows you to specify the
emulation parameters for terminal emulation sessions with a particular host.

About Localization

Localization allows you to deploy language profiles with the Telnet Client.
The language profile allows you to convert common textual strings into a
different language. The Telnet Client will then display the converted string
rather than the native string.

About SSL

The Telnet Client allows SSL-encrypted Telnet connections between a mobile
device and a host system. The Telnet Client also provides certificate
verification for SSL connections. You may import your own trusted
certificates into the Telnet Client, or you may use the Telnet Client installation
and configuration utility to create your own certificates, which you can then
import to your Telnet server or Wavelink TermProxy server.

About Scripting

The Telnet Client provides automated services through scripting. For
example, you might create a user-login script. Telnet Client scripting provides
for the automatic generation of scripts through script recording.
Alternatively, use the Script Editor to create your own scripts or to modify
recorded scripts.

About Keyboard Creator

Use the Telnet Client Keyboard Creator to modify the standard Telnet Client
virtual keyboards to meet the needs of your production environment. The
Keyboard Creator allows you to completely modify the layout of the virtual
keyboard for each emulation type. Additionally, import your own graphic
files (bitmaps) to create your own unique buttons for the keyboard.
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Telnet Client Functionality

The Telnet Client provides the following functionality:

* Use host profiles to initiate Telnet sessions with hosts.
¢ Connect to a host through Wavelink TermProxy.

* Engage in up to four simultaneous Telnet sessions.

¢ Configure Wavelink licensing.

* Configure new host profiles.

* View and modify certain per-host emulation parameters, including scan
codes and symbologies.

* View the current device wireless and IP settings.
¢ View Telnet Client version information.

¢ Integration with the Avalanche framework to provide session monitoring
and viewing of real-time statistics from Avalanche Management Console.

¢ Use WEB Emulation to connect to web pages with your mobile device.

Telnet Client Version and Supported Features Matrix

The key features of the Telnet Client - host profiles, emulation parameters,
localization, SSL support, scripting, keyboard building, and Avalanche
integration - may not be supported in your version of the Telnet Client.
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The following table provides information about the supported features in

each major revision of the Telnet Client.

(2 c
ko S
=
g s E| 2
[ = o 3
© 3 € o
g8 & 5 3 8l £ &
= c b= o kel (] —
o) () © o o] E = ©
= = N S = 2 =
o © T 7] = _8 c o
Telnet = = © Y, o L % a
Client o £ 3 7] 7} @ > b=
Version I 1T] | n (/2] X < £
4. XX-XX Yes Yes Yes No No No No No
5.00-xx Yes Yes Yes Yes No No Yes No
5.1-xx Yes Yes Yes Yes Yes Yes Yes No
6.0-xx Yes Yes Yes Yes Yes Yes Yes Yes

Table 1-3: Telnet Client Version and Supported Features Matrix

The Telnet Client version number consists of three numbers:

e A version number

e A revision number

e A build number

For example, if your version number is 5.00-10, then:

e 5is the version number

¢ (0 is the revision number

¢ 10 is the build number
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Chapter 2:

Installation and Configuration

This section provides the following information:

Installing the Telnet Client
Configuring the Telnet Client

Deploying Configurations

Installing the Telnet Client

This section provides an overview of the Telnet Client.

Currently, you can use one of the following methods to install the Telnet
Client on a mobile device:

Microsoft ActiveSync. You can install the Telnet Client configuration
utility on a host PC. The configuration utility uses an ActiveSync
connection between the host PC and the mobile device to deploy the
Telnet Client and Telnet Client configurations to the mobile device.

Wavelink Avalanche Manager. If your mobile device is running the
Avalanche Enabler, you can use Avalanche Manager to deploy the Telnet
Client and Telnet Client configurations to a mobile device.

Third-Party Applications. Wavelink supports some third-party
deployment applications. For more information about supported
deployments for your device, please see the Telnet Client reference guide
for your mobile device.

Because installation methods vary across mobile devices, each mobile device
has its own reference guide. For information about installing the Telnet Client
on your mobile device, please see the reference guide for that mobile device.

NOTE To obtain the reference guide for your mobile device, please contact
Wavelink customer service. Appendix D: Wavelink Contact Information on
page 261 contains Wavelink contact information.
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Cold Boot Recovery

All Telnet Client installations are designed to survive a device cold boot.
Additionally, the Telnet Client is configured to automatically re-install in the
event of a cold boot. The cold boot recovery process ensures that not only the
Telnet Client application survives a cold boot, but also the Telnet Client
configuration. Any deviation or exception to this process will be noted in the
reference guide for your mobile device.

To allow the Telnet Client to survive a cold boot, a backup copy of the Telnet
Client is stored in the non-volatile (Flash) memory of the device. A copy of
any configuration files for the Telnet Client are also stored in this location
when they are downloaded to the mobile device.

Cold boot recovery processes vary across mobile devices. Each Telnet Client is
designed to use the recovery method of the mobile device for which it has
been designed.

Configuring the Telnet Client

This section provides the following information:

* Configuration Overview

* Configuration Support Matrix

* Using Microsoft ActiveSync to Configure the Telnet Client
¢ Using Avalanche Manager to Configure the Telnet Client
Configuration Overview

Under most circumstances, you will use the same installation/configuration
application to configure the Telnet Client that you used to deploy the Telnet
Client to your mobile device.

The following tasks describe the process of configuring the Telnet Client:

1 Use the installation and configuration application to create and store
Telnet Client configuration files on the host system.

2 Use the installation and configuration application to download the
configuration files to the mobile device.
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For example, if you installed the Telnet Client to a mobile device using the
Microsoft ActiveSync installation and configuration utility, then you would
also use the same utility to create the Telnet Client configuration files. After
creating and saving the configuration files on the host system, you would
then use the installation and configuration utility to push the configuration
files down to the mobile device over an ActiveSync connection between the
host system and the mobile device.

#) Wavelink Product Configuration - Device ... E|

Configuration

1 X Huost Prafiles

WEVEIin k ‘ Localization

E mulation Parameters

[nztallation

Application & Config | Application Only | Config Only

Figure 2-1. ActiveSync Installation and Configuration Utility

You may configure the following parameters and options for the Telnet
Client:

* Host Profiles. A host profile contains all of the required information for a
mobile device to connect to a host system, including an alias, IP address,
TCP port, and other emulation-specific parameters. The Telnet Client
supports multiple host profiles to allow a user at the device to easily create
a Telnet session with a host system.

* Emulation Parameters. Emulation parameters provide control over many
aspects of an emulation session, including key macros, text and screen
display, and barcode scanning. You may control the settings of an
emulation session on a global level or on a per-host level.
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* Localization. Localization allows you to convert strings of text from one
language to another. Use the Localization tool to create conversions, then
configure the Telnet Client to use the appropriate language. For example,
you might create support files to convert server strings from English to
Spanish.

* SSL and SSL Certificates. Some versions of the Telnet Client support
encryption-protected Telnet connections via SSL. You may also configure
the Telnet Client for SSL certificate validation. SSL is configured via host
profiles. You may also use the configuration and installation utility to
import certificates from trusted servers or to generate new certificates that
you can then export to your Telnet or Wavelink TermProxy server(s).

* Scripting. Scripting allows you to automate functions within the Telnet
Client. For example, you might create a login script for users. You may
record scripts, or you may use the Script Editor to create new scripts or
modify existing scripts.

* Keyboard Builder. Use the Keyboard Builder to generate virtual
keyboards for your Telnet Client. You may create any number of virtual
keyboards to meet the needs of your production environment.

Configuration Support Matrix

Depending on the Telnet Client installation and configuration utility that you
are using, the applications and tools that allow you to configure Telnet Client
features may not be available. Table2-1 provides information about the
configuration tools that are available for your chosen installation and
configuration method:

Emulation Key-
Deployment Host Para- Local- SSL board
Method Profiles | meters ization Support Scripting* | Builder
Avalanche Yes Yes Yes Yes Yes Yes
ActiveSync Yes Yes Yes Yes No No
Third-Party Yes Yes Yes Yes No No
Application

* You may configure scripting through the Telnet Client interface on the mobile device

Table 2-1: Telnet Client Configuration Support Matrix
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Using Avalanche Manager to Configure the Telnet Client

You may use the Avalanche framework to update the Telnet Client
configuration.
To configure the Telnet Client through Avalanche Manager:

1 Ensure that the Telnet Client Avalanche package is installed in Avalanche
Manager.

NOTE For more information about installing the Telnet Client in Avalanche
Manager, see the reference guide for your mobile device.

2 Launch the Management Console and connect to the Agent.

3 In the Tree View of Management Console, locate and right-click the Telnet
Client package.

A menu list appears.

4 Select Configure Package (Figure 2-2).

Configure Package » Host Profiles

Copy Packane Emulation Parameters
Delete Package Script Editar
Enable Packane keyhoard Creator

I Localization

Figure 2-2. Configuring the Telnet Client Package

A menu list appears.

5 From the menu list, select the component of the Telnet Client that you
want to configure:

* Select Host Profiles to access the Host Profiles dialog box, which
will allow you to configure host profiles and SSL settings for the Telnet
Client.
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NOTE For more information about configuring host profiles, see Chapter 3:
Host Profiles on page 33.

¢ Select Emulation Parameters to access Configuration Manager,
which will allow you to modify emulation parameters for the Telnet
Client.

NOTE For more information about configuring emulation parameters, see
Chapter 4: Emulation Parameters on page 63.

* Select Script Editor to access the script editor, which will allow
you to import and configure scripts for the Telnet Client.

NOTE For more information about configuring scripts, see Chapter 5: Scripting
on page 83.

* Select Keyboard Creator to access the Keyboard Creator, which
will allow you to create and import virtual keyboards for the Telnet
Client.

NOTE For more information about using the Keyboard Creator, see Chapter 6:
Keyboard Creator on page 107.

* Select Localization to configure the Localization settings for the
Telnet Client.

6 After you have configured the new settings for the Telnet Client, use
Avalanche Manager to deploy the new configuration to the mobile device.

NOTE For information about deploying Telnet Client configurations to the
mobile device, see Deploying Configurations on page 24.
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Using Microsoft ActiveSync to Configure the Telnet Client

Use the Microsoft ActiveSync installation and configuration utility to
configure host profiles, emulation parameters, and localization. After you
have created the configuration, push the configuration files to the mobile
device over a Microsoft ActiveSync connection between the host system and
the mobile device.

To configure the Telnet Client using Microsoft ActiveSync:

1 Ensure that the Microsoft ActiveSync Telnet Client installation and
configuration utility is installed on the host system.

NOTE For more information about installing and using the Microsoft
ActiveSync installation and configuration utility, see the Telnet Client
reference guide for your mobile device.

2 Launch the installation and configuration utility on the host system.

The Wavelink Product Configuration dialog box appears (Figure 2-3).

#) Wavelink Product Configuration - Device ... E|

Configuration

1 X Huost Prafiles
w X E mulation Parameters

WEVEIin k ‘ Localization

[nztallation

Application & Config | Application Only | Config Only

Figure 2-3. Wavelink Product Configuration Dialog Box
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3 Click the icon button for the Telnet Client component that you want to
configure:

e C(lick the Host Profiles icon button to access the Host Profiles
dialog box, which will allow you configure host profiles and SSL
settings for the Telnet Client.

NOTE For more information about host profiles, see Chapter 3: Host Profiles on
page 33.

¢ C(lick the Emulation Parameters icon button to access
Configuration Manager, which will allow you to configure emulation
settings for the Telnet Client.

NOTE For more information about emulation parameters, see Chapter 4:
Emulation Parameters on page 63.

¢ C(lickthe Localization icon button to access the Localization dialog
box, which will allow you to configure localization settings for the
Telnet Client.

4 After you have created the new configuration for the Telnet Client, use the
installation and configuration utility to download the new configuration
files to the mobile device over an ActiveSync connection between the host
system and the mobile device.

NOTE For more information about deploying configuration, see Deploying
Configurations on page 24.

Deploying Configurations

This section provides the following information:
* Deploying Telnet Client configurations via Avalanche Manager

* Deploying Telnet Client configurations via Microsoft ActiveSync
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Deploying Configurations via Avalanche Manager

Use the Avalanche framework to deploy new Telnet Client configurations to
the mobile device.

Deploying Telnet Client configurations to the mobile device involves the
following tasks:

1 Prepare Avalanche Manager and the Avalanche Enabler on the mobile
device for the update.

2 Create a connection to download the configuration to the mobile device.

Preparing for Updates

Avalanche Manager provides communication between the Avalanche Agent
and the Avalanche Enabler on the mobile device over the following media:

¢ Serial port
e RAPI (Microsoft ActiveSync)

e IP

NOTE RAPI support is available in Avalanche Manager 3.5 (or greater
version). On the device-side, RAPI connections are supported available for
mobile devices with a 3.5 (or greater) version of the Avalanche Enabler and
for some pre-3.5 Avalanche Enablers.

Before you can create a connection between the Avalanche Agent and the
mobile device over which the new configuration will be download, you must
prepare both the mobile device and Avalanche Manager for the update
media.

Before you install the Telnet Client on a mobile device, ensure that the host
system and the mobile device are properly configured.

Preparing the host system and the mobile device depends on the type of
media that you are using to connect the host system to the mobile device.

Avalanche Manager allows serial connections and RF connections.
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Preparing for Serial Updates
Use the following guidelines to prepare the serial connection between the
mobile device and Avalanche Manager:

* Ensure that the Avalanche Enabler is installed and functioning properly on
the mobile device.

* Ensure that the Avalanche Enabler on the mobile device is configured
properly. If you have problems, verify the following:

¢ The Avalanche Enabler is configured to use serial updates.

¢ The Avalanche Enabler is configured with the IP address of the
Avalanche Manager.

¢ Ensure that the software collection in which you have installed the Telnet
Client software package is configured to allow RF updates.

* Ensure that Avalanche Manager is configured to use the serial port on the
host system that is connected to the mobile device (Figure 2-4).

7 Avalanche Agents

EI@ localhost [host=localhost]
& Agent Connection Info
=€) Enabler Install Kits
&P Avalanche Gateways

#-4F Client Licensing

D Mobile Device Groups

S Metwark Profiles

glcErial Ports

et el

-4 COom2

Figure 2-4. Serial Ports Enabled in Avalanche Manager

Preparing for RAPI Updates
Use the following guidelines to prepare the RAPI connection between the
mobile device and the Avalanche Manager:

* Ensure that your Avalanche Manager supports RAPI gateways. (RAPI
gateways are available in Avalanche Manager 3.5 and greater versions.)
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* Ensure that the Avalanche Enabler on the mobile device supports RAPI

connections. (RAPI connections are supported in 3.5 and greater versions
of the Avalanche Enabler.)

* Because RAPI gateways use Microsoft ActiveSync, ensure that you can
create a Microsoft ActiveSync connection between the mobile device and
the host system (that is, the system that hosts the Avalanche Agent).

* Ensure that you have created a RAPI gateway in Avalanche Manager
(Figure 2-5).

i Avalanche Agents

EI@ localhost [host=localhost]
-t Agent Connection Infa
ﬂ Enahler Install K|t5

= 5@ Local RAF| Gateway
""" Address=127.0.0.1:17300
~-Local Port= 2065

“-Status = Registered

=7 Client Licensing

3 Mobile Device Groups

=k Metwork Profiles

H-7T Serial Ports

3’ Software Collections

b YWireless MNetwork Security

Figure 2-5. RAPI Gateway in Avalanche Manager

Preparing for IP Updates

Use the following guidelines to prepare the IP connection between the mobile
device and the Avalanche Manager:

¢ Ensure that the Avalanche Enabler is installed and functioning properly on
the mobile device.

* Ensure IP connectivity between the mobile device and the host system. If
you have problems, verify the following;:

¢ The host system has a valid IP address.

e The mobile device has a valid IP address.
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¢ The mobile device is configured with the correct ESSID.

¢ The mobile device is using the correct WEP key, if WEP is enabled on
the wireless LAN.

¢ The host system has a valid IP route to the mobile device.
* The mobile device has a valid IP route to the host system.

* Any firewalls between the host system and the mobile device are
configured to allow TCP traffic to port 1779 (the port that Avalanche
uses for TCP communication).

Ensure that the Avalanche Enabler on the mobile device is configured with
the correct IP address of the Avalanche Manager.

Ensure that the synchronization settings for the selection criteria for the
software collection to which the Telnet Client package belongs allows IP
synchronization (Figure 2-6).
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I Software Collection Settings: All Devices @

@ Sofware collections are groups of sofware packages targeted for clignts with
some cormaon characteristics.

Collection Status: Enabled
Owhned By Group: [Mone]
Client Filter

Selection Criteria:

Synchronization Medium: = Any " |P Qnly " Serial Only

0154 | Cancel ‘ |

Figure 2-6. Setting the Software Collection Synchronization Medium

Downloading the Configuration to the Mobile Device

After you have prepared the synchronization medium, create a connection
between the Avalanche Agent and the mobile device to download the new
configuration.

To deploy the new configuration to the mobile device:

1 Launch Avalanche Manager and connect to the Agent.

2 Inthe Avalanche Agents tree, locate and right-click the Telnet Client
software package.

A menu list appears.
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3 From the menu list, select Enable Package.

The software package is enabled and ready to download to mobile
devices.

4 Use one of the following methods to update the client:

From the Avalanche Enabler on the mobile device, select File >
Connect.

In the Device View of Avalanche Manager, right-click the mobile device
and select Update Now (Allow User Override) or Update
Now (Disallow User Override).

NOTE You cannot use Update Now to force an update over a serial or RAPI
connection. Serial connections must be initiated from the mobile device. RAPI
updates occur whenever a Microsoft ActiveSync connection is initiated
between a mobile device and the host system.

Wait for the mobile device to perform a periodic update according to
the Avalanche Enabler configuration on the mobile device.

Wait until Avalanche Manager instructs the mobile device to perform
an update, which occurs according to the Scheduled Updates
configuration of Avalanche Manager.

For RAPI updates, connect the mobile device to the host system in a
manner that will initiate a Microsoft ActiveSync connection between
the mobile device and the host system.

When you create the connection between the host system and the mobile
device, the configuration files are downloaded to the mobile device.

NOTE Only the configuration files that have changed are pushed down to the
mobile device. The new configuration files replaced (overwrite) the existing
configuration files on the device.
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Deploying Configurations via Microsoft ActiveSync

Use a Microsoft ActiveSync connection between the host system and the
mobile device to download new Telnet Client configurations to the mobile
device.

To deploy a new configuration to the mobile device using Microsoft ActiveSync:

1 Ensure that you have a Microsoft ActiveSync between the host system and
the mobile device.

NOTE For more information about using Microsoft ActiveSync, see Appendix
A: Using Microsoft ActiveSync on page 215.

2 Launch the Microsoft ActiveSync Telnet Client installation and
configuration utility (Figure 2-7).

(%) Wavelink Product Configuration - Device ... E|

Configuration

1 X Haost Prafiles
w X E mulation Parameters

WEVEIin k ‘ Localization

[nztallation

Application & Config | Application Only | Coanfig Only

Figure 2-7. Wavelink Product Configuration Dialog Box

3 C(lick Config Only.

The new configuration is downloaded to the mobile device. Any existing
Telnet Client configuration files on the mobile device are overwritten.
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NOTE All configuration files, including those for host profiles, emulation
parameters, and localization settings are downloaded to the mobile device
when you click the Config Only button.
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Chapter 3: Host Profiles

This section provides the following information:
e Overview of Host Profiles

* Configuring a Host Profile

* Host Profiles and SSL

* Host Profiles and Wavelink TermProxy

* Host Profile Settings

Overview of Host Profiles

A host profile defines the parameters that the Telnet Client should use when
it attempts to initiate a Telnet connection with a specific host. You may
configure as many host profiles for the Telnet Client as you wish.

When a user at the mobile device attempts to use the Telnet Client to initiate a
Telnet session with a host, the Telnet Client displays a list of available host
profiles (Figure 3-1).
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No host connection

<Enter> to Connect

Figure 3-1. Telnet Client Available Host Profiles

The user selects the host to which they wish to connect, and the Telnet Client
uses the host profile settings to attempt to establish a session with the host.

You may configure the following settings for a host profile:

e Alias. This is the alias of the connection. Use a name that adequately
describes the host system to which the user is connecting.

* Emulation Type. This is the emulation type that the Telnet Client should
use when connecting to the host system.

e IP Address. This is the IP address of the host system to which the user is
connecting.

¢ Port. This is the TCP listening port of the host system.
* SSL Settings. You may select to protect the Telnet connection to the host

system via SSL. You may also configure the SSL connection for certificate
validation and import trusted certificates.
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TermProxy Settings. You may configure the Telnet Client to connect to a
Wavelink TermProxy server. You may define up to three TermProxy
connections for failover purposes. You may configure the TermProxy
connection to use SSL with certificate validation.

Language. If your Telnet Client supports the language feature, you may
configure the Telnet Client to display a certain set of characters while
connected to the host system.

Workstation ID. If you have configured the host profile for IBM-type
emulation, then you may configure a unique and/or dynamic workstation
ID that the Telnet Client will use when connecting to the host system.

Telnet Negotiation String. If you have configured the host profile for VT-
type emulation, then you may configure a Telnet negotiation string that
the Telnet Client will use when connecting to the host system.

Autologin. If you have configured the host profile for VT-type emulation,
then you may configure autologin settings that the Telnet client will use
when connecting to a host system.

Host-Specific Emulation Parameters. You may configure host-specific
emulation parameters. These parameters will override global emulation
parameter settings during Telnet connections to the host system that the
host profile specifies.

Configuring a Host Profile

Use the Host Profiles dialog box to configure host profiles (Figure 3-2). See
Chapter 2: Installation and Configuration on page 17 for information about using
your specific installation and configuration utility to access the Host Profiles
dialog box.
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e

& Host Profiles ['5__<
Huost 2 Hast l TermProsy 1 ] Language] WT Settingsl Autologin 4 | *
Hosgt 3

I ame:

|H03t1

Address: Port:
[132.160.1.2 23

[ Only uze TermProxy connections

[ Use SSLATLS enciyption
B

Hew Delete Cancel | Ok

Figure 3-2. Host Profiles Dialog Box

Each host profile that you configure appears in the left panel of the Host
Profiles dialog box.

The following tasks outline the process of configuring host profiles for the
Telnet Client:

1 Access the Host Profiles dialog box.
2 Add, modify, or remove host profiles and save the changes.
3 Download the configuration to mobile devices.

When you save the host profiles that you have configured, the changes you
have made are saved to a configuration file.

Adding a Host Profile
You can use the Host Profiles dialog box to create a new host profile.

To create a new host profile:

1 Access the Host Profiles dialog box.
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2 In the Host Profiles dialog box, click New.

Various tabs appear in the Host Profiles dialog box that allow you to
configure the parameters for a new host profile. The tabs that appear are
dependent on the type of emulation that you select for the host profile. The
Host Profiles dialog box automatically defaults to an IBM 5250 emulation

type.

3 Use the tabs in the Host Profiles dialog box to configure the host profile.

The name (alias) of the host profile appears in the left text box of the Host
Profiles dialog box.

NOTE For information about the various tabs in the Host Profiles dialog box,
see Host Profile Settings on page 49.

4 After you have finished configuring the host profile, click OK.
The new host profiles configuration is saved to the host system.

5 Download the new host profiles configuration to the mobile device.

NOTE For information about using the Microsoft ActiveSync utility or the
Avalanche Telnet Client to download configurations to mobile devices, see
Deploying Configurations on page 24.

NOTE To exit the Host Profiles dialog box without saving the changes that you
have made, click Cancel.

Modifying an Existing Host Profile
You can use the Host Profiles dialog box to modify an existing host profile.

To modify an existing host profile:

1 Access the Host Profiles dialog box.

2 From the list of host profiles in the text box in the left of the dialog box,
select the host profile that you want to modify.
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3 Use the various tabs in the Host Profiles dialog box to configure the host
profile.

NOTE For information about the parameters in the various tabs of the Host
Profiles dialog box, see Host Profile Settings on page 49.

4 After you have finished modifying the host profile, click OK.
The new host profiles configuration is saved to the host system.

5 Download the new host profiles configuration to the mobile device.

NOTE For information about using the Microsoft ActiveSync utility or the
Avalanche Telnet Client to download configurations to mobile devices, see
Deploying Configurations on page 24.

NOTE To exit the Host Profiles dialog box without saving the changes that you
have made, click Cancel.

Deleting a Host Profile
You can use the Host Profiles dialog box to delete an existing host profile.
1 Access the Host Profiles dialog box.

2 In the text box on the left side of the Host Profiles dialog box, select the host
profile that you want to remove.

3 C(lick Delete.
The host profile is removed from the Host Profiles dialog box.

4 After you have finished configuring the host profile, click OK.
The new host profiles configuration is saved to the host system.

5 Download the new host profiles configuration to the mobile device.
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NOTE For information about using the Microsoft ActiveSync utility or the
Avalanche Telnet Client to download configurations to mobile devices, see
Deploying Configurations on page 24.

NOTE To exit the Host Profiles dialog box without saving the changes that you
have made, click Cancel.

Host Profiles and SSL

The Telnet Client supports encryption-protect Telnet sessions via SSL. The
Telnet Client supports SSL Telnet connections to host servers, as well as to the
Wavelink TermProxy server.

NOTE Wavelink TermProxy provides SSL support for connections between
the mobile device and the TermProxy server. Wavelink TermProxy does not
support SSL connections between the TermProxy server and host systems.

The Telnet Client also supports certificate validation for SSL connections.
To enable and use SSL for the Telnet Client requires the following;:

¢ Install the SSL support package on the host system.

¢ Install the SSL support package on the mobile device.

e Enable SSL for the host profile.

* Enable certificate validation for the host profile and import server
certificates (optional, if you want to use SSL with certificate verification).

Installing the SSL Support Package on the Host System

Before you can begin configuring SSL and SSL certificates from the
installation and configuration utility that you are using, you must install the
SSL support package on the host system.
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The SSL support package is a self-extracting executable that installs the
required files that will allow you to configure SSL and SSL certificates.

NOTE To obtain the SSL support package, please contact Wavelink customer
service. Appendix D: Wavelink Contact Information on page 261 contains
Wavelink contact information.

Installing the SSL Support Package on the Mobile Device

The Telnet Client will not be able to initiate SSL connections with hosts until
you install the SSL support package on the mobile device.

Use one of the following methods to deploy the SSL support package to the
mobile device:

* Avalanche Manager. The SSL support package is available as an
Avalanche software package.

* Microsoft ActiveSync. The SSL support package is available as a bundled
package that you can deploy over a Microsoft ActiveSync connection
between a host system and the mobile device.

e Third-Party Application. The SSL support package is available for some
third-party deployment applications.

NOTE To obtain the SSL support package for the mobile device, please contact
Wavelink customer service. Appendix D: Wavelink Contact Information on
page 261 contains Wavelink contact information.

Enabling SSL

SSL is enabled via the Host Profiles dialog box. It enabled on a per-host profile
basis.

When you configure a host profile to use SSL, the TCP port for the host profile
is automatically changed to 992, which is the well-known port number for
SSL Telnet communication. If the host system uses a different port, then
change the port to the correct setting.
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To configure a host profile to use SSL:

1 Access the Host Profiles dialog box.

2 From the left panel of the dialog box, select the host profile that you want
to configure.

3 Depending on the connection requirements for the host profile, select one
of the following;:

* If the host profile specifies a direct connection to a server, then enable
the Use SSL/TLS Encryption option box in the Host tab (Figure 3-3).

¢ If the host profile specifies a connection to a Wavelink TermProxy
server, then enable the Use SSL/TLS Encryption option box in the
TermProxy tab.

NOTE You will not be able to configure the Use SSL/TLS Encryption option
box in the TermProxy tab until you select an option from the TermProxy
Server menu list.

% Host Profiles E|
Host 2 Host l Language] WT Settlng&] .-’-'-.uh:ulu:ugln] Ennflguratlnn]
Host 3
M arme: Type:
[Host 1 w1100 R
Address: Port:
[192.160.1.2 |332

-

Hew Delete Cancel | 0k,

Figure 3-3. Enabling SSL for a Host Profile
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4 After you have finished configuring the host profile, click OK.
The new host profiles configuration is saved to the host system.

5 Download the new host profiles configuration to the mobile device.

NOTE For information about using the Microsoft ActiveSync utility or the
Avalanche Telnet Client to download configurations to mobile devices, see
Deploying Configurations on page 24.

Enabling Certificate Verification

When SSL is enabled, you may configure the Telnet Client to perform
certificate verification. This prevents the Telnet Client from connecting to
unauthorized servers.

Use the Host Profiles dialog box to import trusted certificates, which you can
then download to the mobile device using the installation and configuration
utility. When certificate verification is enabled for a host profile, the Telnet
Client will test the credentials of the host system against the imported
certificates and will refuse connections with host systems that present a
certificate that is not in its list of imported certificates.

To enable certificate validation and import valid certificates:

1 Access the Host Profiles dialog box.

2 From the left panel of the dialog box, select the host profile that you want
to configure.

3 Depending on the connection requirements for the host profile, select one
of the following;:

¢ If the host profile specifies a direct connection to a host, then enable the
Verify Server Certificates option box in the Host tab.

¢ If the host profile specifies a connection to a Wavelink TermProxy
server, then enable the Verify Server Certificates option box in the
TermProxy tab (Figure 3-4).
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w4 Host Profiles r$__(|

Host 2 Hast l Language] WT Settings] .ﬁ.utalngin] Eanfiguratiun]
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M armne: Type:
Host 1 WT100 |
Address: Pat:
|192_1sn_1_2 |992
-
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Select Verfication Certificates |

Hew Delete Cancel | Ok

Figure 3-4. Enabling Certificate Validation

4 C(lick the corresponding Select Verification Certificates
button.

The Certificate Manager dialog box appears.

5 Click Insert Certificate... tobrowse toand import a server
certificate.
6 Click Create Certificate... to create a certificate and private key

that you can then export to a TermProxy server or other host system
(Figure 3-5).
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&' Certificate Manager
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Figure 3-5. Managing SSL Certificates

NOTE The certificates that you import and/or configure are available for all
host profiles that you configure. The imported certificates should be
considered a database or list of certificates against which the Telnet Client
will check when initiating an SSL Telnet session with a host. If the host does
not present a certificate that is in the list, then the Telnet Client will not
establish a connection with the host.

7 After you have finished importing/configuring certificates, click OX.
The Certificate Manager dialog box closes.

8 C(lick OK to close the Host Profiles dialog box and save your new host
profile settings.

9 Download the new host profiles configuration to the mobile device.



Chapter 3: Host Profiles

45

NOTE For information about using the Microsoft ActiveSync utility or the
Avalanche Telnet Client to download configurations to mobile devices, see
Deploying Configurations on page 24.

Host Profiles and Wavelink TermProxy

The Telnet Client provides integration with Wavelink TermProxy 2.x and 3.x.

Wavelink TermProxy provides proxy services, mainly for session persistence,
between the Telnet Client and host systems.

NOTE For more information about Wavelink TermProxy, contact Wavelink
customer service. Appendix D: Wavelink Contact Information on page 261
provides Wavelink contact information.

You may use the Host Profiles dialog box to configure the following:
¢ TermProxy-only connections

* TermProxy-failover connections

NOTE TermProxy support (via the Host Profiles dialog box) is only available in
version 5.0 (and greater) of the Telnet Client. While TermProxy 2.x allows
connections from any type of Telnet Client, TermProxy 3.x requires
connections from a 5.0 (or greater) Telnet Client.

Configuring a TermProxy-Only Connection

By default, if the Telnet Client cannot connect to the specified TermProxy
server, then it will attempt a direct connection to the host. You may, however,
configure the Telnet Client to only connect to a host through a Wavelink
TermProxy server.

To configure a TermProxy-only connection to a host system:

1 Access the Host Profiles dialog box.

2 Select the host profile that you want to configure.
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3 In the Host tab, enable the Only Use TermProxy Connections checkbox
(Figure 3-6).

% Host Profiles E|
_ _
Huost 2 Host l TermPraxy 1 ] Language] WT Settlng&l Autalogin 4 | ¥
Host 3
M arme: Type:
[Host 1 w1100 R
Address: Port:
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1
.

Hew Delete Cancel | 0k,

Figure 3-6. Enabling TermProxy-Only Connections

4 Use the TermProxy tab to configure the settings for the TermProxy server.

NOTE For more information about settings in the TermProxy tab, see Host
Profile Settings on page 49.

5 After you have finished configuring the host profile, click OK.
The new host profiles configuration is saved to the host system.

6 Download the new host profiles configuration to the mobile device.

NOTE For information about using the Microsoft ActiveSync utility or the
Avalanche Telnet Client to download configurations to mobile devices, see
Deploying Configurations on page 24.
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Configuring TermProxy Failover

Use the TermProxy tabs in the Host Profiles dialog box to configure host and
TermProxy failover. You may configure up to three failover connections for a
host profile.

When the Telnet Client attempts to use the host profile to initiate a connection
with a host, it will attempt connections in the following order:

Host specified in the Host tab of the host profile. (If you have specified a
TermProxy-only connection, then it will attempt the host specified in the
TermProxy 1 tab.)

Host specified in the TermProxy 1 tab
Host specified in the TermProxy 2 tab

Host specified in the TermProxy 3 tab

If the Telnet Client is unable to contact any of the specified host, then it will
return an error message.

To configure TermProxy failure for a host profile:

1

2

Access the Host Profiles dialog box.
Select the host profile for which you want to configure TermProxy failover.
Configure the Host tab.

Configure the TermProxy 1 tab (Figure 3-7).
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Figure 3-7. Configuring the TermProxy Tab

5 Configure the TermProxy 2 tab

6 Configure the TermProxy 3 tab

NOTE For more information about the settings in the Host and TermProxy
tabs, see Host Profile Settings on page 49.

7 After you have finished configuring the host profile, click OK.

The new host profiles configuration is saved to the host system.

8 Download the new host profiles configuration to the mobile device.

NOTE For information about using the Microsoft ActiveSync utility or the
Avalanche Telnet Client to download configurations to mobile devices, see
Deploying Configurations on page 24.
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Host Profile Settings

This section describes the parameters of each tab in the Host Profiles dialog
box.

Host Settings

Use the Host tab in the Host Profiles dialog box to configure the basic settings
of the host profile (Figure 3-8).

':E‘ Host Profiles

Huost 2 Host l TermPrawg 1| TermProxy 2] Language] WT Setti 4 | *
Host 3
M arme: Type:
[Host 1 w1100 R
Address: Pot:
|192.1EEI.1.2 |23
[ iOnly uze TermProsy connections
[ Use SSLATLS encrption
B
Hew Delete Cancel | 0k,

Figure 3-8. Configuring Host Settings
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The following list describes the options and configurable parameters in the
Host tab.

Name Indicates the name of the host profile, which should
be synonymous with the name (alias) of the host
system to which the mobile device connects when
the host profile is used.

Possible Values: 1 - 50 alpha-numeric characters

Default Value: New Host

Type Indicates the type of emulation that the mobile
device uses when connected to the host system.

Possible Values: <IBM-5251-11> <IBM-3278-2>
<IBM-3279-2> <IBM-3279-2-E> <VT100> <VT220>
<HP> <WEB>

Default Value: <IBM-5251-11>

Address Indicates the IP address or host name of the host
system to which the mobile device will connect.

Possible Values: Any valid IP address, host name, or
web address.

Default Value: <None>

Port Indicates the TCP port number on which the host
system is listening for Telnet requests from clients.

Possible Values: 0 - 65535

Default Value: 23
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Only Use TermProxy Indicates whether the Telnet Client should only

Connections connect to the host through a TermProxy server. If
you enable this checkbox, you must configure the
host information (name, IP address, emulation type,
and port) and you must also configure the
TermProxy 1 tab.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Use SSL/TLS Encryption Indicates whether the Telnet Client should use SSL
to connect to the host system. When you enable SSL/
TLS, the port will automatically change to 992, which
is the well-known port for SSL Telnet
communication.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Verify Server Indicates whether the Telnet Client should use

Certificates certificate verification before allowing a connection
to the host. If you enable certificate verification, then
use Certificate Manager to import trusted server
certificates and/or to create your own server
certificates.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Select Verification Click this button to access the Certificate Manager,

Certificates which allows you to import trusted server
certificates and/or create your own server certificates
for SSL certificate verification.

TermProxy Settings

You may configure up to three TermProxy connections. Use the TermProxy
tabs to specify the parameters of the TermProxy connection (Figure 3-9).
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& Host Profiles r>__(|
Hosgt 2 Host  TermProzy 1 l TermPro=y 2] Language] WT SettilLlLl
Hozt 3

TermProxy Server: |"v"ersi|:|n dn j
Address: [10.10.10.1 Port: |4430
Terminate TermProxy Session; |Eln Seszzion Exit j

Reconnect String: |

[ Werify server certificates

Hew Delete Cancel | Ok

Figure 3-9. Configuring TermProxy Settings
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The following list describes the configurable options in the TermProxy tab:

TermProxy Server

Address

Port

Select the TermProxy server to which the Telnet
Client will connect.

Possible Values:

* None. Specifies no TermProxy or alternate host is
used.

* Version 2.x. Specifies TermProxy 2.x. TermProxy
2.x will accept connections from any Telnet
Client.

* Version 3.x. Specifies TermProxy 3.x. TermProxy
3.x will only accept connections from 5.x (or
greater) Telnet Clients.

¢ Alternate Telnet Host. Specifies an alternate host
system for failover purposes.

Default Value: <None>

Indicates the IP address of the TermProxy server or
alternate host system.

Possible Values: Any valid IP address

Default Value: None

Indicates the TCP listening port of the TermProxy
server or alternate host system.

Possible Values: 0 - 65535

Default Value: 4430
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Terminate TermProxy
Session

Reconnect String

Indicates when the Telnet Client should terminate
the connection to the TermProxy server.

Possible Values:

¢ Never. The Telnet Client never terminates the
session established with the TermProxy server.
The TermProxy server is responsible for
terminating the session.

¢ On Network Error. The Telnet Client terminates
the session with the TermProxy server when a
network error occurs, such as a loss of network
connectivity.

¢ On Session Exit. The Telnet Client terminates the
session with the TermProxy server when it
disconnects from the host system.

¢ Always. The Telnet Client will terminate the
session with the TermProxy server on a network
error or when it disconnects from the host
system.

Default Value: <On Session Exit>

Specifies the reconnect string that the mobile device
should use when connecting to the host. (You may
also configure reconnect strings in TermProxy.)

Possible Values: Any valid reconnect string

Default Value: None

Use SSL/TLS Encryption Specifies whether the Telnet Client should use SSL to

connect to the TermProxy server or alternate Telnet
host. (TermProxy 2.x does not support SSL
connections.)

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>
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Verify Server
Certificates

Select Verification
Certificates

IBM Settings

Indicates whether the Telnet Client should use
certificate verification before allowing a connection
to the TermProxy server or alternate Telnet host. If
you enable certificate verification, then use
Certificate Manager to import trusted server
certificates and/or to create your own server
certificates.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Click this button to access the Certificate Manager,
which allows you to import trusted server
certificates and/or create your own server certificates
for SSL certificate verification.

Use the IBM settings tab of the Host Profiles dialog box to configure the
creation of a dynamic name for mobile devices that are loaded with this host

profile (Figure 3-10).

The IBM Settings tab only appears you have configured the host profile for an
IBM-type emulation in the Host tab.
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v Host Profiles r>__(

Host 1
Host 2

Huost ] TermPraxy 1 ] Language |BM Settings ]Eunfiguralion]

“wiarkztation [D: |ahu:d°/aa°/oh2c2d

MOTE: The workstation ID MUST be different for
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%t = terminal 1D
Hew Delete Cancel 0k,
Figure 3-10. Configuring IBM Settings
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The following list provides information about the configurable parameters in

the IBM Settings tab.

Workstation ID

VT Settings

Indicates the workstation ID that mobile devices use
to connect to the host system. This includes static
characters and the following switches, which are
used to capture dynamic data that is specific to each
mobile device:

* %a - %d. Captures specific octets of the IP
address of the mobile device. For example, use
Y%a%b%c%d to capture all four IP octets of the
address of the mobile device, or use %d to
capture only the last octet of the IP address of the
mobile device.

* %m - %r. Captures specific octets of the MAC
address of the mobile device. (For example, use
%pY%q%r to capture the last three octets of the
MAC address of the mobile device.)

*  %s. Captures the session number.

* %t. Captures the Avalanche terminal ID of the
mobile device. (If the mobile device is not an
Avalanche client, then this parameter is not
valid.)

Possible Values: 0 - 20 alpha-numeric characters
plus switches (see above)

Default Value: None

NOTE: IBM hosts usually truncate workstation IDs
that are more than 10 characters. Also, the
workstation ID should not begin with a numeric
character.

Use the VT Settings tab in the Host Profiles dialog box to configure a Telnet
negotiation string for the host connection (Figure 3-11).
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A Telnet negotiation string allows you to specify the function or type of
mobile device that is sending the Telnet request to the host system. The host
system can then supply information to the mobile device based on Telnet
negotiation string (for example, menus or display options).

The VT Settings tab only appears if you have configured the host profile for
VT- or HP-type emulation in the Host tab.

% Host Profiles E|
:
Hast 2 TemProsy 1 ] TermPraxy 2] Language T Settings ].-'fxul ull L
Host 3

Telnet Megotition String: |rfgur‘

Mew Delete Cancel k.

Figure 3-11. Configuring VT Settings

The following list describes the configurable parameters in the VT Settings
tab.

Telnet Negotiation Specifies the Telnet negotiation string that the client
String should use when connecting to the host system.

Possible Values: 0 - 20 alpha-numeric characters

Default Value: <None>
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WEB Settings

When you configure the host profile for WEB-type emulation, various tabs
appear offering different options for WEB settings.

%3 Host Profiles [g|
HTTPS Proxy Access List Configuration
Host | HTTF Prosy
MHame: Tuvpe:
H|:|:E:t 1 | WEB W

Address:
| hiktp: A v wanelink, com |

Hew l [ Delete ] Cancel ] [ u].9

Figure 3-12. Configuring WEB Settings

For instructions on configuring each WEB settings tab, see “Industrial
Browser Host Profile Settings” on page 159.

Autologin Settings

Use the Autologin tab in the Host Profiles dialog box to configure autologin
parameters for the mobile device, such as a user name and password (Figure
3-13).

The Autologin tab only appears if you have selected VT- or HP-type
emulation for the host profile in the Host tab.
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w4 Host Profiles

Host 2
Host 2

Hew Delete

3

TemProsy 2] Language] WT Seftings  Autalogin l Config 4 | ¥

CFG in
Prampts terminal  Responses

Mame: lagin: [ uzer
Fassword: |Pazsward: [ pasaword
Cormand: I

Cancel Ok

Figure 3-13. Configuring Autologin Settings

The following list describes the configurable options Autologin tab.

Name - Prompts

Name - CFG in terminal

Name - Responses

Indicates the user name prompt that the host system
uses.

Possible Values: 0 - 60 alpha-numeric characters

Default Value: login:

Indicates whether users should configure the
response to the login prompt at the mobile device.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Indicates the response that the mobile device should
send to the login prompt.

Possible Values: 0 - 30 alpha-numeric characters

Default Value: <None>
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Password - Prompts

Password - CFG in
terminal

Password - Responses

Command - Prompts

Command - CFG in
terminal

Command - Responses

Indicates the password prompt that the host system
uses.

Possible Values: 0 - 60 alpha-numeric characters

Default Value: <None>

Indicates whether users should configure the
response to the password prompt at the mobile
device.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Indicates the password that the mobile device
should send to the host system at the password
prompt.

Possible Values: 0 - 30 alpha-numeric characters

Default Value: <None>

Indicates the command prompt that the host system
sends to the Telnet Client after the login is complete.

Possible Values: 0 - 60 alpha-numeric characters

Default Value: <None>

Indicates whether users should configure the
response to the command line prompt at the mobile
device.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Indicates the command that the mobile device
should send the host system at the command
prompt.

Possible Values: 0 - 30 alpha-numeric characters

Default Value: <None>
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Configuration Settings

Use the Configuration tab in the Host Profiles dialog box to access and
configure per-host emulation parameters (Figure 3-14).

NOTE For more information about global and per-host emulation parameters,
see Chapter 4: Emulation Parameters on page 63.

% Host Profiles r'5__(|
Host 2 Language] YT Settings] Autalagin - Configuration ] A
Hoszt 3

E mulation parameters for this host profile can be modified.
Feszet |
Hew Delete Cancel Ok

Figure 3-14. Configuring Per-Host Emulation Settings

The following list describes the options in the Configuration tab.

Modify Click this button to access Configuration Manager
and modify the emulation parameters for the host
connection.

Reset Click this button to reset the emulation parameters

for the host connection back to the default settings.
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Chapter 4: Emulation Parameters
This section provides the following information:
* About Emulation Parameters
¢ Configuring Emulation Parameters

* Using Configuration Manager

About Emulation Parameters

The Telnet Client allows you to configure emulation parameters for host
connections.

You make changes to emulation parameters with the Configuration Manager
utility, which provides an organized list of the emulation parameters that you
can modify.

Emulation parameters are divided into two groups:
* Per-host

* Global

About Per-Host Emulation Parameters

Per-host emulation parameters apply only to a specific host connection, as
dictated by the host profile the Telnet Client is using to connect to the host
system. You can access the emulation parameters for a specific host profile
through the Host Profiles dialog box.

When you choose to modify per-host emulation parameters, you access and
use Configuration Manager to modify the Hostcfg.bin configuration file.
Configuration Manager displays the name of the file that it is modifying in
the title bar.

NOTE Per-host parameters are a subset of parameters. Not all Telnet Client
emulation parameters are available for modification on a per-host basis.
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About Global Emulation Parameters

Global emulation parameters apply to all of the host profiles with which you
have configured a client. Per-host emulation parameter configurations
preempt global emulation parameter configurations.

When you choose to modify global emulation parameters, you access and use
Configuration Manager to modify the Termcfg.bin configuration file.
Configuration Manager displays the name of the file that it is modifying in
the title bar

Configuring Emulation Parameters

This section provides information about accessing Configuration Manager to
modify global and per-host emulation parameters.

Overview of Configuring Emulation Parameters
The following tasks outline the process of configuring emulation parameters:

1 Use the product configuration utility or the Telnet Client Avalanche
software package to access the Configuration Manager.

2 Use the Configuration Manager to modify emulation parameters and save
the new emulation parameters configuration file.

3 Download the new configuration file to the mobile device.

When you download the configuration file to the mobile device, any existing
configuration file is overwritten.

Accessing Global Emulation Parameters
This section provides the following information:

* Using the Microsoft ActiveSync installation utility to access the
Configuration Manager for global and parameters

* Using the Avalanche software package to access the Configuration
Manager for global emulation parameters
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Using Microsoft ActiveSync

If you used the product installation and configuration utility to install the
Telnet Client to the mobile device via a Microsoft ActiveSync connection, use
the same product installation and configuration utility to access the
Configuration Manager and modify global emulation parameters.

To access global emulation parameters from the Microsoft ActiveSync utility:

1 On the host system, launch the Microsoft ActiveSync installation utility.

The Wavelink Product Configuration dialog box appears (Figure 4-1).

(¥ Wavelink Product Configuration - Device ... E|

Configuration

1 X Huost Prafiles
w X Emulation Parameters

anElin k ‘ Localization

[nztallation

Application & Config | Application Only | Config Only

Figure 4-1. Wavelink Product Configuration Dialog Box

2 C(Click the Emulation Parameters icon button.

The Configuration Manager appears (Figure 4-2).
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Each configurable option is represented by a diamond icon. These icons are contained in
folders. Circles represent the actual settings of the options which contain them. When a
citcle is filled in or & diamond is filled iy, the value assigned to this option is not the default
setting,
Highlight any of the options to get more information. Dowble clicking on the option will
present the option for modification. Right-mouse clicking on the option brings up the
cortext mer allowing youto edit of reset a value back to its default if previously modified.
Copyright 2005 Wavelink Corporation. All Rights Reserved.

Ready MM

Figure 4-2. Configuration Manager

3 Use the Configuration Manager to configure the global emulation
parameters for the Telnet Client.

NOTE For information about using Configuration Manager, see Using
Configuration Manager on page 76.

4 After you have configured the emulation parameters, use one of the
following methods to save the configuration to the host system:

¢ (lick the save icon button in the Configuration Manager tool bar.
* Select File > Save.
5 Close the Configuration Manager.

6 Download the new emulation parameters to the mobile device.
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NOTE For more information about downloading configuration to mobile
devices, see Deploying Configurations on page 24.

Using Avalanche Manager

If you used Avalanche Manager to install the Telnet Client on the mobile
device, use Avalanche Manager to access the Configuration Manager and
modify global emulation parameters.

To access global emulation parameters from Avalanche Manager:

1 On the host system, launch Avalanche Manager and connect to the Agent.

2 Inthe Avalanche Agents tree, locate and right-click the Telnet Client
software package.

A menu list appears.

3 From the menu list, select Configure Package > Emulation
Parameters (Figure 4-3).

-
Configure Package » Host Profiles

Copy Packane Emulation Parameters
Delete Package Script Editar

i Enahle Package kevboard Creatar

! Localization

Figure 4-3. Configuring Emulation Parameters from Avalanche

The Configuration Manager appears (4-4).



68

Wavelink Telnet Client User’s Guide
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Copyright 2005 Wavelink Corporation. All Rights Reserved.
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Figure 4-4. Configuration Manager

4 Use the Configuration Manager to configure the global emulation
parameters for the Telnet Client.

NOTE For information about using the Configuration Manager, see Using
Configuration Manager on page 76.

5 After you have configured the emulation parameters, use one of the
following methods to save the configuration to the host system:

* C(lick the save icon button in the Configuration Manager tool bar.
* Select File > Save.
6 Close the Configuration Manager.

7 Download the new emulation parameters to the mobile device.
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NOTE For more information about downloading configuration to mobile
devices, see Deploying Configurations on page 24.

Accessing Per-Host Emulation Parameters
This section provides the following information:

* Using the Microsoft ActiveSync installation utility to access the
Configuration Manager for per-host settings

* Using the Avalanche Telnet Client software package to access the
Configuration Manager for per-host settings

Per-host emulation parameters are specific to a host connection and are
accessed through the corresponding host profile in the Host Profiles dialog
box.

Using Microsoft ActiveSync

If you used the product configuration utility to install the Telnet Client on the
mobile device via a Microsoft ActiveSync connection, use the same product
configuration utility to access and configure per-host emulation parameters.

To access per-host emulation parameters from the Microsoft ActiveSync utility:

1 On the host system, launch the Microsoft ActiveSync installation utility.

The Wavelink Product Configuration dialog box appears (Figure 4-5).
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Figure 4-5. Wavelink Product Configuration Dialog Box

2 C(Clickthe Host Profiles icon button.
The Host Profiles dialog box appears.

3 From the list of host profiles, select the host profile that you want to
configure.

4 Select the Configuration tab (Figure 4-6).
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& Host Profiles r>__(|
Host 1 ) ) . .
Languagel YT Settlngs] Autologin - Configuration l LlLl
Host 2
E mulation parameters faor this host profile can be modified.
Fezet |
Hew Delete Cancel Ok

Figure 4-6. Selecting to Configure Per-Host Emulation Parameters

5 Click Modify.

The Configuration Manager appears (Figure 4-7).
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Figure 4-7. Configuration Manager for Per-Host Emulation Parameters

6 Use the Configuration Manager to configure emulation parameters for the
host profile that you have selected.

NOTE For information about using Configuration Manager, see Using
Configuration Manager on page 76.

7 After you have configured the emulation parameters, use one of the
following methods to save the configuration to the host system:

* C(lick the save icon button in the Configuration Manager tool bar.
® Select File > Save.

8 Close the Configuration Manager.

9 Close the Host Profiles dialog box.

10 Download the new emulation parameters to the mobile device.
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NOTE For more information about downloading configuration to mobile

devices, see Deploying Configurations on page 24.

Using Avalanche Manager

If you used Avalanche Manager to deploy the Telnet Client to the mobile
device, use the Telnet Client software package in Avalanche Manager to

access and configure per-host emulation parameters.

To access per-host emulation parameters from Avalanche Manager:

1 On the host system, launch Avalanche Manager and connect to the Agent.

2 Inthe Avalanche Agents tree, locate and right-click the Telnet Client

3 From the menu list, select Configure Package > Host Profiles

software package.

A menu list appears.

(Figure 4-8).

Configure Package F Host Profiles

Copy Package Emulation Parameters
Delete Package Script Editar
Enable Packane Kevhoard Creator

I Localization

Figure 4-8. Configuring Per-Host Emulation Parameters from Avalanche

The Host Profiles dialog box appears.

From the list of host profiles, select the host profile that you want to
configure.

Select the Configuration tab (Figure 4-9).
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e
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Mew Delete Cancel k.

Figure 4-9. Accessing Per-Host Emulation Parameters

6 Click Modify.

The Configuration Manager appears (Figure 4-10).
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Figure 4-10. Configuration Manager for Per-Host Emulation Parameters

7 Use the Configuration Manager to configure emulation parameters for the
host profile that you have selected.

NOTE For information about using Configuration Manager, see Using
Configuration Manager on page 76.

8 After you have configured the emulation parameters, use one of the
following methods to save the configuration to the host system:

* C(lick the save icon button in the Configuration Manager tool bar.

e Select File > Save.

9 Close the Configuration Manager.

10 Close the Host Profiles dialog box.
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11 Download the new emulation parameters to the mobile device.

NOTE For more information about downloading configuration to mobile
devices, see Deploying Configurations on page 24.

Using Configuration Manager
This section provides the following information:
* An overview of Configuration Manager
* Using the Configuration Manager to modify emulation parameters
* Using the Configuration Manager find function

The Configuration Manager (Figure 4-11) is the utility that allows you to
modify global and per-host emulation parameters.
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Figure 4-11. Configuration Manager

The left pane of the Configuration Manager displays the emulation
parameters that you can modify. The emulation parameters are grouped by
category.

The following list describes the different categories:

com Parameters in this category configure the function of
the COM port on mobile devices.

Emulation Parameters in this category configure terminal
emulation functions on mobile devices.

Scanner Parameters in this category configure the function of
bar code scanners on mobile devices.

When you select a parameter in the left pane, information about the
parameter displays in the right pane (Figure 4-12).
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Figure 4-12. Emulation Parameter Information

Modifying Emulation Parameters

Determine the emulation parameters that you want to modify and use the
Configuration Manager to make modifications.

To modify an emulation parameter:

1 Access the Configuration Manager.

2 In the left pane of the Configuration Manager, locate the parameter that
you want to modify.

3 Double-click the emulation parameter or right-click the emulation
parameter and choose Edit from the menu list.

A dialog box appears that allows you to modify the parameter
configuration (Figure 4-13).

Com Port Baud Rate

Baud Fate:

9500
= Cancel

Figure 4-13. Modifying an Emulation Parameter
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4 Use the dialog box to configure the parameter.

5 After you have configured the parameter, click OK to keep the setting.

NOTE Click Cancel orthe Close button to cancel any changes you have
made.

6 Use one of the following methods to save the new configuration:
* C(lick the save icon button.
* Select File > Save.

7 Close the Configuration Manager.

8 Download the new configuration to the mobile device.

NOTE For more information about deploying new Telnet Client
configurations to mobile devices, see Deploying Configurations on page 24.

Using the Find Function

Use the Find function of the Configuration Manager to locate parameters or
information by supplying a partial or full string that the Configuration
Manager can use to locate the parameter or information that you want to find.

To use the find function:

1 From the Configuration Manager Edit menu, select Find.
The Find dialog box appears.

2 Input a partial or full string for the parameter or information that you
want to find (Figure 4-14).
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Find What: |password

[ Search all text Find Mext | Cancel

Figure 4-14. Inputting a String to Find

3 Enable the Search all text checkbox to search not only the parameters, but
also the help files.

4 C(Click Find Next to begin the search.

Continue to click Find Next until you locate the parameter or
information for which you are searching.

Switching to Alphabetized View

By default, emulation parameters are displayed in a hierarchical tree view.
You may switch to an alphabetized view, if you desire. When the
alphabetized view is enabled, the Configuration Manager displays the
emulation parameters in alphabetical order.

To switch to the alphabetized view in Configuration Manager:

1 In the Configuration Manager, access the View menu.
2 Inthe View menu, disable the Tree Mode option.

The Configuration Manager now displays the emulation parameters in an
alphabetized list (Figure 4-15).
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] termcfg.bin - Emulation Parameters

File Edit Yalue Wiew Help
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Figure 4-15. Alphabetized View in the Configuration Manager
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Chapter 5:

Scripting

This section provides the following information

Overview of Scripting

Launching the Script Editor

Creating Scripts Using the Script Editor
Performing Script Capturing

Editing Scripts

Importing Scripts

Saving and Exporting Scripts
Deploying Scripts

Executing Scripts

Overview of Scripting

Wavelink Telnet Client includes a Script Editor that gives you the ability to
create and execute scripts that automate processes on the Telnet Client.

NOTE The Script Editor is included in Telnet Client 5.1 and later versions.

The following steps outline the process of creating scripts using the Script
Editor:

1

Launch the Script Editor.You can launch the script editor Avalanche
Manager.

Create a script using the Script Editor. You can use the Script Editor to
manually create the script code.

-0r-
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Create a script using the Script Capture option. You can turn on Screen
Capture and perform the actions you want included in your script.

3 Configure an execution method for your script. You need to select from
the available options the way you want to execute your script.

4 Execute your script from the Telnet Client. Using the activation method
you selected for the script, you can activate and execute your script.

Telnet Client allows one active script per emulation session. While one script
is running, other scripts are not allowed to run. Scripts should be designed to
do their action and then immediately exit. This allows the next script to run.

Scripts can only be run while a session is connected to a host. When a
connection is dropped, the script is terminated. If you switch between
sessions, the script running in the first session will be suspended until that
session is returned to being active.

NOTE For detailed information about the using the Script Editor in Telnet CE
Client, refer to the Telnet Client Scripting Reference Guide.

Launching the Script Editor

If you are using Avalanche Manager to deploy the Telnet Client, you can
launch the Script Editor from the Avalanche Manager. Then scripts created by
or imported into the Avalanche Script Editor will automatically be deployed
to the remote devices.

To launch the Script Editor from Avalanche Manager:

1 Ensure the Telnet Client package is installed in Avalanche Manager.

2 From the Tree View in the Avalanche console, right-click the Telnet Client
software package.

3 Select Configure Package > Script Editor (Figure 5-1).
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. | W
Configure Package Haost Profiles
Copy Packane Emulation Parameters
Delete Package Script Editar
Enable Packane keyhoard Creator
LU Localization
FATTI

Figure 5-1. Launching the Script Editor from Avalanche Manager

The Script Editor opens (Figure 5-2).

f‘ Script Editor,

Diore | | Add | | Import | |

Figure 5-2. Script Editor

4 Click Add to open the Script Editor configuration dialog box (Figure 5-3).
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Script Editor

General l Actionz ] Boolean Yariables | Mumber W ariables | String Vanables | Host Profiles

Mame: |

Activation Conditions
I~ Select fram Menu

[~ On Key Combination: | =] [Hexadecimal Valug)
I~ when Session Connects
-
Scan String: | J Scan Type: | J

The data and scan type will be the values for the selected variables when the macro starts. The
"Scan_Sting' action can be used to return the modified information back to Telnet. If the values are
nok returmed, Telnet will ignore the scan.

[~ On Screen Update
The "'0n Screen Update” option should be uzed carefully, zince the script will be started each time the
screen changes. When using thiz option, the script should immediately check if the screen matches
what is desired, and exit if it does nat.

ok | Cancel

Figure 5-3. Script Editor Configuration Dialog Box

Creating Scripts Using the Script Editor

This section provides information on how to create scripts manually using the
Script Editor and includes the following information:

* Configuring the Script Name

* Selecting the Activation Method

* Creating the Script Code

* Creating Variables

¢ Selecting Host Profiles

Use the following steps to create a script manually:

1 Enter a script name and select an activation method.

2 Use the Actions tab to select actions and build the script code.

3 Use the Boolean Variables, Number Variables, or String Variables tabs to
create Variables as needed to complete the script (not required).
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4 Use the Host Profile tab to select host profiles that will be associated with
this script.

Configuring the Script Name

The script name is the name you will select from when activating the scripts
(Figure 5-4).

Script Editor

General ]Actions] Boolean Yariables | Mumber YV ariables | String Vanables | Host Profiles

MNarne: |Script1

Activation Conditions
I Select frorn Menu

[~ On Key Combination: | J | [Hexadecimal \Walue]
™ when Session Connects
-
Scan String: | J Scan Type: | J

The data and scan type will be the values far the selected vanables when the macro startz. The
"Scan_Sting'' action can be used ta return the modified information back to Telnet. If the values are
not returned, Telnet will ignore the scan.

™ On Screen Update
The "On Screen Update” option should be used carefully, since the script will be started each time the
screen changes. When using this option, the script should immediately check if the screen matches
what iz desired, and exit if it does nat.

Ok | Cancel

Figure 5-4. Entering the Script Name

Selecting the Activation Method
You need to select how you want to activate your script, once it is created. A
script with no activation method selected can still be called by another script,

but it cannot be activated by itself.

This section provides information about assigning a method of activation to a
script. The following is a list of the activation methods:

¢ Select from Menu
* On Key Combination
¢ When Session Connects

¢ On Barcode, MSR, or RFID Scan
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* On Screen Update

Select from NMenu

Scripts with the Select from Menu option selected can be run using the menu
option in the Telnet Client.

To configure the Select from Menu method:

1 Select the General tab or the Activate tab in the Script Editor.

2 Enable the Select from Menu option (Figure 5-5).

Script Editor

General l Actiong ] Boolean Variables | Mumber W ariables | String Variables | Host Profiles

MNarme: |script 1

— Artivation-Cenditions ——
<F Select from Menu

| J | [Hexadecimal Walue]
I~ When Session Connects
-
Scan String: | J Scan Type: | J

The data and scan type will be the values for the selected variables when the macro startz. The
"Secah_Sting' action can be used ta return the madified information back to Telnet. If the values are
not returned, Telnet will ignare the scan.

™ On Screen Update
The "'0n Screen Update" option should be used carefully, since the script will be started each time the
screen changes. “When using this option, the script should immediately check if the screen matches
what is desired, and exit if it does nat.

0] | Cancel

Figure 5-5. Select from Menu

3 Click OK.

On Key Combination

This option lets you launch a script whenever a specific key combination is
pressed.

NOTE Use the Diagnostics utility to obtain the key value. Refer to Using the
Telnet Client Diagnostics Utility on page 151 for more information.
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To configure the On Key Combination method:

1 Select the General tab or Activate tab in the Script Editor.

2 Enable the On Key Command option (Figure 5-6).

Script Editor.

General ]Actions] Boolean Yariables | Mumber ' ariables | String Vanables | Host Profiles

Marme: |script 1

Activation Conditions
T Selectfrarrtent
| ¥ OnKey Combinati

- |Alt ﬂ |?8 __—_@adECimal\-"alue]
e ———

Scan String: | J Scan Type: | J

The data and scan type will be the values for the selected variables when the macro startz. The
"Scan_Sting" action can be used to return the modified information back to Telnet. If the values are
nok returmed, Telnet will ignare the scan.

™ On Screen Update

The "'0n Screen Update” option should be used carefully, since the script will be started each time the
screen changes. When using thiz option, the script should immediately check. if the screen matches
what iz desired, and exit if it does nat.

oK | Cancel

Figure 5-6. On Key Combination

3 Use the drop-down menu and text box to assign a key combination to the
script.

When Session Connects

This option causes the script to activate when the host profile it supports is
activated.

If you use this option, it is strongly recommended that you limit the script to
the appropriate host profiles. Since the script will be activated before any
information appears on the emulation screen, you will need to have your
script wait for the appropriate screen to appear before it does anything. You
should not have more than one script set to start when a session begins
because the first script started will prevent any other scripts from running
while it waits for the initial screen.

Refer to Selecting Host Profiles on page 94 for more information.
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To configure the When Session Connects method:

1 Select the General tab or Activate tab in the Script Editor.

2 Enable the When Session Connects option (Figure 5-7).

Script Editor

General l Actiong ] Boolean Variables | Mumber W ariables | String Variables | Host Profiles

MNarme: |Script3

Activation Conditions
[ Select from Menu

I~ ifn Key Combination | = [Hexadecimal Yalue)
v when 5ession Connects
Bl ——
Scan String: | J Scan Type: | J

The data and scan type will be the values for the selected variables when the macro startz. The
"Secah_Sting' action can be used ta return the madified information back to Telnet. If the values are
not returned, Telnet will ignare the scan.

™ On Screen Update
The "'0n Screen Update" option should be used carefully, since the script will be started each time the
screen changes. “When using this option, the script should immediately check if the screen matches
what is desired, and exit if it does nat.

0] | Cancel

Figure 5-7. When Session Connects

3 C(Click Ok.

On Barcode, MISR or RFID Scan

This option allows the script to run with each barcode, MSR or RFID scan.

For detailed information on configuring scripts for barcode, MSR or RFID

scan refer to the Telnet Client Scripting Reference Guide.

To configure the On Barcode, MSR, or RFID Scan method:

1 Createthe Scan String and Scan Type variables.

Once you create these variables, the On Barcode, MSR or RFID Scan
options becomes available.

You will need to create these variables in the String Variables and Number
Variables tabs. Refer to Creating Variables on page 92 for information on

creating variables.
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1 Select the General tab or Activate tab in the Script Editor.
2 Enable the On Barcode, MSR, or RFID Scan option.

3 From the drop-down menu, select the Scan String.

4 From the drop-down menu select the Scan Type.

5 Click OK.

On Screen Update

This option will cause the script to be activated (if activation is allowed) every
time the text on the emulation screen changes. This includes updates from the
Telnet host or when the user presses a key and the key value is shown on the
screen. It is recommended that you limit the host profiles that the script
supports.

For detailed information on configuring scripts for on screen update
execution refer to the Telnet CE Client Scripting Reference Guide.

NOTE This option should be used carefully, since it can cause a script to be
executed very frequently.

To configure the On Screen Update method:

1 Select the General tab or Activate tab in the Script Editor

2 Enable the On Screen Update option (Figure 5-8).
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Script Editor

General ]Actions] Boolean Yariables | Mumber ' ariables | String Varables | Host Profiles

Marme: |Script1

Activation Conditions
™ Select from Menu

™ On Key Combination: | J | [Hexadecimal Walue]
I™ when Session Connects
-
Scan String: | J Scan Type: | J

The data and scan type will be the values for the selected variables when the macro starts. The
"Scan_Sting'' action can be used to return the modified information back to Telnet. If the values are
nok returmed, Telnet will ignare the scan.

[v On Screen Update
The "'0n Screen Update” option should be used carefully, since the script will be started each time the
creen changes—"hen using this option, the script should immediately check if the screen matches
what 7z desired, and exit if it does nat.

Cancel

Figure 5-8. Selecting the On Screen Update Method

3 Click OK.
Creating the Script Code

Once you have named your script and selected an activation method, you can
use the Actions tab in the Script Editor to build the script.

For detailed information and examples about building the script code refer to
the Telnet CE Client Scripting Reference Guide.

Creating Variables

There are three types of values recognized by scripting: booleans (TRUE or
FALSE values only), numbers (integers), and strings. Every argument for
every action is one of these three value types. Every action that returns a
value returns one of these types. Variables provide a way to save the result of
an action for use later as an argument for another command.

Variables can be created and edited under the appropriate Variable tab while
editing the script. It is also possible to create new variables while editing an
action.

When a script first starts, all the variables will have known values: boolean
variables will be FALSE, number variables will be 0, and string variables will
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be empty. One possible exception to this is when a script activates another
script.

To create a variable:

1 Determine which type of variable you want to create: boolean, number or
string.

2 From the Script Editor, select the tab that corresponds with the type of
variable you want to create.

3 C(Click Add.

4 In the Edit Variable dialog box, enter the name of the new variable (Figure
5-9).

Edit Yariable

Mew W anable Name:

Y/ ariable1

ak.

Figure 5-9. Adding a New Variable

5 Click OK.

The new variable appears in the corresponding tab (Figure 5-10).
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Script Editor

General]Actions Boolean Variables | Mumber Variables | String Variables | Host Profiles

Boolean wariables default to FALSE unless assigned a different value by the script calling this script. Use the
Boolean_Set action to assign the variable a different initial value,

“ariablel

Edit Delete |

ok | Cancel

Figure 5-10. New Variable

Selecting Host Profiles

For each script, you can specify which host profiles will be supported by that
script.You may select host profiles from the Host Profiles tab.

If the script is generated by script capturing, it is a good idea to limit that
script to a host profile that was in use when the script was captured. The
default - no host profile - allows the script to be run when any host profile is
used.

To select host profiles:

1 From the Script Editor, select the Host Profiles tab (Figure 5-11).
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Script Editor.

General | Actions | Boolean Variables | Number Variables | String Variables Host Profiles

Add each of the host profiles that this script will suppaort. [ this list is empty, the script will support any host
profile.

oK | Cancel

Figure 5-11. Host Profiles Tab

2 C(Click Add.

The Select Host dialog box opens (Figure 5-12).

Select Host r>_<|

testd

[

Figure 5-12. Selecting Host Profiles

3 Select which host you want to use from the list of hosts.
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NOTE If you have not created any host profiles, this dialog box will be empty.

4 C(Click OK.

The host appears in the Host tab (Figure 5-13).

Script Editor,

General] Actions] Bodlean Yariables | Mumber Variables] String Variables Host Profiles

Add each of the host profiles that thiz script will support. F this list iz empty, the zcript will support any host
profile.

Delete

ak Cancel

Figure 5-13. Selected Profile in Host Profiles Tab

Performing Script Capturing

Script capturing is an easy way to generate a script that will automate doing
something you can do manually. While script capturing is turned on, it will
capture the key presses and mouse/pen cursor movements so they can be
replayed with the script is activated.

To perform a script capture:
1 Position your mouse or cursor at the emulation screen you want to be at
when the automated process starts.

2 From the Term or Options menu, select Scripting > Start Capture
(Figure 5-14).
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Disconnect Session 1: 3179

Scripting
Configure
Yiew Start Capture
About
Exit
Options ... H

Figure 5-14. Starting Script Capture

3 At the prompt, select Yes to verify the current screen text (Figure 5-15).

Select No if you do not want to verify the current screen text.
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el

Script Capturing Initialiaztion

Do you want the script to
verify the current screen
text?

Yes No

Options ... E|4

Figure 5-15. Verifying the Current Screen Test

Selecting Yes makes the captured script start withan If not
command that tells the script to exit if the correct screen is not currently
shown. Unless you know that your script will only run from the correct
screen (for example, a script that is run only when a session first starts, or a
script called by another script), you should select Yes.

NOTE If you select No, click Verify Screen Contents and Save
Cursor Position buttons when you start your script capture. This will
cause your script to wait for Telnet to finish updating the screen before
processing script actions.

4 Perform any actions you want to include in the script.

5 Each time the screen changes, click Verify Screen Contents button
(Figure 5-16).
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NOTE Some devices may only display buttons labeled Screen, Cursor
and Stop. The Screen button refers to the Verify Screen Contents
button. The Cursor button refers to the Save Cursor Position
button. The Stop button refers to the Stop Capturing button.

&l Telnet E]

-Verify Screen Contents|Save Cursor Position|Stop Captu;é C
[Tr— _—— >

Ready Session 1: HOST1 Row 6, Cal 53

Figure 5-16. Verify Screen Contents and Save Cursor Position Buttons

NOTE Clicking the Verify Screen Contents button will cause the
generated script to pause and wait for the screen to be updated. The pauses
are necessary because the scripts can run much faster than the interaction
with the Telnet host.

6 When you are finished capturing the behaviors you want in the script,
click Stop Capture.

Once you have captured a script, Script Editor opens. This allows you to
name the script and select an activation method. You would also use the
Actions tab to add actions for any error condition that the user may
encounter.
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Editing Scripts

You can edit scripts that are created manually and scripts that are generated
from the script capture option.

To edit scripts:

1 Launch the Script Editor.

2 Select the script you want to edit from the Script Editor script list.

3 Click Edit.

4 Make the desired changes in the Script Editor configuration dialog box.

5 Click OK to save your changes.

Once you have completed editing the script you have two options:

* Export the script to a specified location using the Export button in the
Script Editor. Refer to Saving and Exporting Scripts on page 102 for more
information.

* Execute the script by launching the Telnet CE Client and performing the
activation method you assigned to this script. Refer to Executing Scripts on
page 104 for more information.

Importing Scripts

You can use the import button in the Script Editor to import previously
created scripts.

NOTE You can only import scripts that have been created using the Script
Editor.

To import a script:

1 From the Script Editor, click the Import button.

The Select the Script File dialog box opens (Figure 5-17).
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Select the Script File

Lok jr: |@ scripts ﬂ @ ok B3~

fy Recent
Documents

My Metwork. File name: |Script1 22.wls

3 [o=]
Places
Files of type: | Script Files [*wls) ﬂ Cancel

Figure 5-17. Importing a Script File

2 Navigate to and select the script file.

3 C(lick Open.

The name of the file is imported into the Script Editor (Figure 5-18).
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rj Script Editor

zoript fun
Scriptl

Done | Edit | Add | Delete | Expart

Figure 5-18. Imported Script File

Once you have imported the file, you can edit the script. Refer to Editing
Scripts on page 100 for more information.

Saving and Exporting Scripts

After you finish building a script, your script is automatically saved in the
Script Editor. You can also export a script and save it in a specific location on
the network.

NOTE Scripts are saved as .wls files. Scripts can not be viewed outside the
Script Editor and must be imported back in to the Script Editor to view or
edit.

To export a script:

1 From the Script Editor script list, select which script you want to export
(Figure 5-19).
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fj Script Editor

delta login

Ioiin2

Scriptl22

Done | Edit | Add | Drelete | Impaort | Export |

Figure 5-19. Selecting a Script to Export

2 C(lick the Export button.

The Create the Script File dialog box opens (Figure 5-20).

Create the Script File

Gave jr: |@ Sripting j ok B

L afase-delta login with pause then opkion 1.wls
L&é Auto Login {manually added delay for demo version) DeltaS2 ROIZ BDH.wis
My Recent #uito Login Delta5z ROLZ BDH.wis
Docurnents Auto Login to CMD Test Screens-MCN. wis
?'[_: delka roi2 login F11 response test MAS wls
- delta roiZ login F15 response tesk NAS wls
Deskiop delta roi login MAS wis
- Display messages NAS. wis

J lirze login MAS . wis

My Documents

y Computer

ty Netwark, File name:
Flaces

j Save |
ﬂ Cancel

Save as type: |Script Files [*wlz)

Figure 5-20. Exporting a Script

3 Navigate to the location to which you want to export your script.



104 Wavelink Telnet Client User’s Guide

4 C(lick save.

To view an exported script you will need to import that script into the
Script Editor. Refer to Importing Scripts on page 100 for more information.

Deploying Scripts
Scripts are deployed to the Telnet Client the next time the client syncs with
the Avalanche Manager.

Executing Scripts
When you create a script, you configure an activation method for that script.
This section provides information about activating scripts using each of the
following activation methods:
* Select from Menu
* On Key Combination
¢ When Session Connects
¢ On Barcode, MSR, or RFID Scan

* On Screen Update

For information on assigning an activation method to a script, refer to
Selecting the Activation Method on page 87.

NOTE Screen captures may differ according to device type.

Select from Menu
This option allows you to activate a script from the menu.

To activate a script using the Select from Menu option:
1 Launch the Telnet Client.

2 From the Term menu, select Scripting > Execute Script (Figure 5-
21).
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Disconnect Session 1: 3179

Scripting Execute Script

Cancel Script
Configure
Yiew Start Capture
Stop Capture
About i
¥erify Screen Contents
Exit Save Cursor Position
Options ... E|*

Figure 5-21. Executing a Script from the Menu

3 If more than one script is available for the current host profile, select which
script you want to use from the list.

NOTE This option will not be available while a script is running for the
current session or if the session is not connected.

On Key Combination

This option lets you launch a script whenever a specified key combination is
pressed (as long as it is currently possible for script to run).

To execute a script on key combination:

1 Launch the Telnet Client.
2 Enter the key combination you assigned to execute the script.
When Session Connects

This option causes the script to activate when the host profile it supports is
activated.
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To execute when the session connects:

1 Launch the Telnet Client.

2 From the Term or Options menu, select Connect.
3 Select to which host you want to connect.

4 C(Click OK.

The script will run upon connection.

On Barcode, MISR, or RFID Scan

When this option is assigned to a script, the script will activate with each
barcode, MSR, or RFID scan.

On Screen Update

This option causes the script to be activated (if activation is allowed) every
time the text on the emulation screen changes. This includes updates from the
Telnet host or when the user presses a key and the key value is shown on the
screen.
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Chapter 6: Keyboard Creator

This section provides the following information:
* Overview of Keyboard Creator

¢ Launching the Keyboard Creator

* Selecting Keyboard Files

* Creating Keyboards

¢ Importing Keyboard Graphics

¢ Creating and Configuring Keys

¢ Sizing and Positioning Keys and Rows

* Deploying the Keyboard to the Telnet CE Client

Overview of Keyboard Creator

The Keyboard Creator allows you to create or modify the Telnet Client virtual
keyboard.

Use the following steps to create a keyboard using Keyboard Creator:
1 Launch the Keyboard Creator.

2 Select the appropriate keyboard file.

3 Create a new keyboard.

4 Import a keyboard graphic, if desired.

5 Create and configure the keys of the keyboard.

6 Deploy the keyboard to the Telnet Client.

Launching the Keyboard Creator

The Keyboard Creator is installed as part of the Telnet Client Avalanche
software package.
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NOTE The Keyboard Creator is only available in the Avalanche Telnet Client.
You will not be able to access the Keyboard Builder from the ActiveSync

install utility or any other third-party Telnet Client installation and

configuration utilities.

To launch from Avalanche:

1 Select the Telnet Client software package in the Tree View of the Avalanche

Manager.

2 Right-click the package and select Keyboard Creator.

The Keyboard Creator opens (Figure 6-1).

%- EM3270.KB - CreateKB EIE'E'

File Edt Keyboard Wiew Help

] &I[~ +| [ETTHICCHNN -

~
K.evboard

CAPSLOCK ~| [ Tempoay

Size: =« |» NawKayhnard| DelataKeyhnard|

Graphic
Nane
Impart | | |
}
Show Buttans Only Showe Graphics Only
Ken
Label: r
Riow: Calurnr Height: Width:
Walue: | Jl J
C | | =
r
| =
-
Fine Adjustrents: d At Dl

Key Position - j j P

- 1 1n

Far Help, press FL,

Applicat ion Hroea [=]

[
Tab|Q|W|E|R|T|Y]|u| 1 [o][PReg<--

Figure 6-1. Launching the Keyboard Creator
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Selecting Keyboard Files

Keyboard files contain all the keyboards needed for a given emulation (5250,
3270, VT100, VT220, HP, or WEB). Use Table 6-1 to determine the name of the

keyboard file that should be edited for a particular emulation.

Emulation File Name
5250 EM5250.KB
3270 EM3270.KB
VT100, VT220 EMVTKB
HP EMHP.KB
WEB EMWEB.KB

Table 6-1: Emulation Types and File Names
There are two additional keyboards:

* EMNONE.KB are the keyboards displayed when a session is not
connected to a host.

¢ EMNUM.KB are the keyboards displayed for the Numeric keyboard
option.

When the keyboard file is saved, a matching file with the .KBB extension will
also be saved. This file is a binary representation of the keyboard file and will
be used by the terminal to display the keyboards. (Telnet Client ignores the
KB files if they are present.)

To select a keyboard file:

1 Determine the name of the Keyboard file you are creating.

2 Select the file type from the drop-down list (Figure 6-2).
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Figure 6-2. Selecting the File Type

Creating Keyboards

There are two default keyboards: the default alpha keyboard and the default
numeric keyboard. The default alpha keyboard is displayed by default. The
default numeric keyboard is displayed when in a numeric field (5250 and
3270 only).

This section provides the following keyboard information:
* Adding a new keyboard

* Sizing Keyboards

* Deleting Keyboards

Adding a new keyboard

Multiple keyboards can be included in each keyboard file. The keyboards are
linked together by shift keys (special keys which display another keyboard).
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To add a keyboard:
1 Launch the Keyboard Creator.

2 Select Keyboard > New Keyboard from the menu.

3 Enter a new name for the keyboard (Figure 6-3).

Keyboard

Enter new keyboard name:

KEVBOARD

Cancel

Figure 6-3. Creating a New Keyboard

NOTE Keyboard names must start with a letter, may only contain numbers or

letters, and can only be 11 characters long.
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For Help, press FL.

Figure 6-4. Creating a New Keyboard
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4 Use the Key configuration options to configure each key of the keyboard.
Refer to Creating and Configuring Keys on page 113 for more information.
Sizing Keyboards

You can use the mouse to resize a keyboard. As you increase the size of the

keyboard, the size of the application area will decrease.

To resize the keyboard:

1 Mouse over the top border, right-side border, or the upper-right corner of
the keyboard.

2 When the double-sided arrows appear, click and drag the keyboard to the
desired size.

Deleting Keyboards

When deleting a keyboard that has keys which connect to it, an option will be
presented for dealing with any connections to the keyboard. Keys that are
references to the keyboard being deleted can be deleted, set to an empty value
or redirected to another keyboard.

To delete a keyboard:

1 Select Keyboard > Delete Keyboard from the menu.

2 Select what action to take for referenced keys (Figure 6-5).

Deleting Keyboard P§|

After thig keyboard iz deleted, the keys that referenced it should be:;

" azzigned an empty value.

" assigned to thiz keyboard:

| [-]
k. | Cancel |

Figure 6-5. Deleting a Keyboard
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Importing Keyboard Graphics

The default keyboard draws the keys on the computer screen. However, you
can import a graphic to be displayed instead of the created keys. An imported
graphic will be embedded in the .KB and .KBB files, so you will not need to
save the imported graphic file.

Key locations and values will still be used to determine which key the you
clicked when you click on the keyboard graphic. You will need to create and
position keys in the same position as the buttons on the imported graphic.
Use the slider bar change how dark the graphic and buttons are while editing
so that you can size and position the buttons correctly.

NOTE Be sure to label the buttons you create. If the mobile device is unable to
use the bitmap image, the labeled buttons will still appear.

To import a graphic:
1 In the Keyboard Creator, click Import.

2 Navigate to the location of the bitmap image you want to import.
3 Click Open.

4 C(lick the Size Keyboard to Graphic button to make the keyboard
the same size as the imported graphic.

5 Use the slider bar to adjust the how dark and how light the graphics and
buttons appear when editing.
Creating and Configuring Keys
There are three types of keys that can be on a keyboard:

* Normal keys represent letters, numbers, or other characters in the
emulation and can also represent special emulation specific function keys.

* Shift keys can point to any other keyboard in the current keyboard file.

* Hide keys hide the keyboard and allows an unobstructed view of the
emulation screen.
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This section provides the following information:
* Adding a new key

* Sizing and Positioning Keys and Rows

* Deleting Keys

Adding a new key

You can add new keys to a keyboard and configure the key values and
configure the following options:

* Label. Enter the text that will appear on the virtual key when it is
displayed.

* Reverse. Enable this option for a key that indicates the active keyboard
type.

* Key Value. Select from Key, Normal, Keyboard (shift), or Hide. Key values
allow you to select emulation-specific actions to be assigned to the keys.
The list of keys available will vary depending on the emulation type
selected.

NOTE Normal key values can be displayed or entered as a character value (the
actual character created by the keystroke is shown), a decimal value (for
characters which cannot be shown), or a hexadecimal value (for scan codes of
special function keys).

To add a new key:

1 Select Keyboard > Add Key.

The new key will appear in the top left corner of the keyboard, or directly
to the right of a selected key (if it will fit) (Figure 6-6).
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Figure 6-6. Adding a New Key

2 Modify the values for the key using the key configuration options (Figure

6-7).
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Figure 6-7. Configuring a New Key

3

Repeat to create additional keys for the keyboard.

Sizing and Positioning Keys and Rows

You can use the configuration options in the Key region of the Keyboard
Creator to modify the size and position of the keys on the keyboard.

The Fine Adjustments drop-down menu allows you to select what object you
want to modify:

Key Position. Select this option to move a selected key on the keyboard.
You can also adjust the key position by clicking on the key and dragging it
to the desired position.

Row Position. Select this option to move an entire row.

Keyboard Position. Select this option to move all the keys on the
keyboard.

Key Size. Select this option to adjust the size of the key.

Once you select the object you want to modify, you can use the arrow
buttons to position or size the keys and rows. The Adjust Distance slider
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determines the distance that the arrow buttons move or adjust the keys or
rows. You can use the slider to change the distance from 1-10 pixels.

To position a key:

1 Click New Key.
2 From the Fine Adjustments drop-down menu, select Key Position.
3 Use one of the following methods to move the key:

¢ Use the arrow buttons to position the key in the desired location.

* Drag and drop the key to the desired location.

To position a row:

1 Click a key in the row you want to position.
2 From the Fine Adjustments drop-down menu, select Row Position.
3 Use the arrow buttons to position the row in the desired location.

To resize a key:

1 Click New Key or select an existing key.

2 From the Fine Adjustments drop-down menu, select Key Size.
3 Use the arrows to adjust the size.

Deleting Keys

You can delete keys that you do not want from the keyboard.

To delete a key:
1 Select the key you want to delete.

2 Select Keyboard > Remove Key.

Deploying the Keyboard to the Telnet CE Client

Once you have completed creating your keyboard and keys, click the Save
icon to save your keyboard, and then exit the Keyboard Creator. Your Telnet
CE Client will update with the new keyboard the next time the mobile device
syncs with Avalanche Manager.
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Chapter 7: Licensing

This section provides the following information:
* Overview of Licensing
* Types of Licenses

¢ Licensing Methods

Overview of Licensing

The Telnet Client requires a license for full functionality. You can use the
Telnet Client without a license, but you will be limited to the demo version,
which does not provide full Telnet Client functionality.

Telnet Client licensing is on a per-client basis, not on a per-connection basis.
This means that a single license allows the Telnet Client to engage in the
maximum number of Telnet sessions that the Telnet Client is configured to
support (up to four concurrent sessions).

When the Telnet Client does not have a valid license, it operates in demo
mode. When the Telnet Client is operating in demo mode, it will behave as
followings:

¢ Attempt to contact a license server. Each time that you attempt to initiate
a terminal emulation session, the Telnet Client will begin broadcasting in
an attempt to locate a license server. At that point, you are prompted to
either enter a license or to initiate the session in demo mode.

* Prematurely disconnect emulation sessions. While in demo mode, you
may initiate terminal emulation sessions with hosts. However, each
terminal emulation session that you initiate will automatically time out
after one hour (Figure 7-1).
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Connection closed:
Demonstration period
expired.

<Enter> to Connect

Figure 7-1. Demonstration Period Expired

Authorization Methods
There are three ways to license (authorize) the Telnet Client:

* Pre-licensing. The Telnet Client may come pre-installed and pre-licensed
on your mobile device. For pre-licensing information, please consult the
Telnet Client reference guide for your mobile device manufacturer.

* Manually. You may manual input licensing information at the mobile
device through the Telnet Client interface.

* License Server. You may use License Server to automatically provide
Telnet Client licenses to the mobile devices on your network.

NOTE To obtain Telnet Client licenses, please contact Wavelink customer
service. Appendix D: Wavelink Contact Information on page 261 provides
Wavelink contact information.
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Types of Licenses
There are two types of Telnet Client licenses:
* Platform

¢ Maintenance

NOTE Maintenance licenses were added to the 5.0 version of the Telnet Client.
Only platform license are available for 4.x Telnet Clients.

About Platform Licenses

A platform license authorizes you to the version of the Telnet Client that you
purchased and any builds associated with that version. For example, if you
purchased a 5.0 Telnet Client license, then you are entitled to use 5.00-xx
Telnet Client builds. If you want to use the features available in the 6.00-xx
Telnet Client, then you must either buy a 6.0 platform license for your mobile
devices, or you must purchase a maintenance license for your devices.

A platform license provides for minor upgrades and code changes, but does
not allow major upgrades and updates to the Telnet Client.

Platform licenses do not expire, but they do not allow you to upgrade to a
greater version of the Telnet Client.

About Maintenance Licenses

A maintenance license allows you to upgrade your Telnet Client when new
major versions of the Telnet Client become available. For example, a
maintenance license allows you to upgrade from Telnet Client 5.x to Telnet
Client 6.x.

Maintenance licenses are valid only through a specific date. After the
expiration date, if you upgrade the Telnet Client, it will revert to operating in
demo mode.

Licensing Methods

This section provides the following information:
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* Manually Licensing the Telnet Client
* Using License Server to License the Telnet Client
Manually Licensing the Telnet Client

You may key in your authorization information manually through the Telnet
Client interface.

To manually configure a Telnet Client license:

1 Obtain the Telnet Client licensing information from Wavelink Corporation.
2 On the mobile device, launch the Telnet Client.

3 Attempt to establish a connection to a host.

NOTE For information about connecting to a host, see Using the Telnet Client
and Connecting to Hosts on page 129.

If the Telnet Client has not attained a license, when you attempt to connect
to a host, the Authorizing Terminal dialog box appears.

4 In the Authorizing Terminal dialog box, select Add License.
The Authorization dialog box appears.

5 From the Platform drop-down list, select your license type (Figure 7-2).
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Authorization El
Platform:
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Figure 7-2. Selecting the License Type

6 In the License Name text box, type the name of the license.
7 In the Serial # text box, type the serial number for the license.

8 In the Exp. Date text box, type the expiration date of the license, in the
format of MMDDYYYY.

9 In the Code text box, type the authorization code for the license.

10 In the User # text box, enter a user number.

NOTE The user number can be any number between 1 and the number of
users (the limit) for which the license provides. Each Telnet Client should be
configured with a unique user number.

11 In the Limit text box, enter the user limit for the license.
12 Click Authorize.
Using License Server to License the Telnet Client

License Server is a Wavelink application that runs on a host system. The
license server is responsible for supplying licenses to mobile devices that are
using the Telnet Client.
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NOTE The Telnet Client license server should not be confused with the
Avalanche license server. Both are separate Wavelink applications.

NOTE For information about installing and using the Telnet license server, see
Appendix C: Using the Telnet Client License Server on page 141.

Using a Local License Server

When you attempt to initiate a Telnet session with a host, if the Telnet Client
is not already licensed, it will automatically attempt to obtain a license from a
license server by using the following steps:

1 The Telnet Client broadcasts a request for a license on the local IP network.

The Authorizing Terminal dialog box displays on the mobile device while
the Telnet Client attempts to locate a license server (Figure 7-3)

No host connection

<Enter> to Connect

Authorizing Terminal...

Attempting to contact a license server on
the local segment

Add License | Cancel |

Figure 7-3. Authorizing Terminal Dialog Box
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2 Any license servers on the local IP network with an available license

respond by offering a license.

The Telnet Client accepts the first license that it receives and sends back a
reply to the license server.

The Authorizing Terminal dialog box on the mobile device indicates that a
license has been obtained.

If no license server responds to the request for a license, then the
Authorizing Terminal dialog box continues to display until you close the
dialog box, elect to use a demo license, or elect to manually add a license.

Using a Remote or Specific License Server

If the license server is on a remote IP network or you want to specify the
license server from which the Telnet Client should request a license, you must
configure the Telnet Client with the IP address of the license server.

NOTE For more information about configuring the IP address of the license
server, see Configuring License Server IP Address on page 125.

When you attempt to initiate a Telnet session with a host, if the Telnet Client
is not already licensed, it will automatically attempt to obtain a license from
the specified license server using the following steps:

1

The Telnet Client sends a request for a license to the specified license
server.

The Authorizing Terminal dialog box displays on the mobile device while
the Telnet Client attempts to locate a license server (Figure 7-4)
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IS

tions

No host connection

<Enter> to Connect

Authorizing Terminal...

Attempting to contact a license server an
the local segment

Add License | Cancel |

Figure 7-4. Authorizing Terminal Dialog Box

2 The license server on the local IP network respond by sending the Telnet
Client a license.

3 The Telnet Client accepts the first license that it receives and sends back a
reply to the license server.

Using the Demo License

If you cannot obtain a license for the Telnet Client, you may use the
demonstration license.

The demonstration license automatically disconnects an active Telnet session
after one hour.

To use the Telnet Client demo license:

1 Launch the Telnet Client.
2 Use the Telnet Client to initiate a Telnet session with a host.

3 The Select Host dialog box appears.
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NOTE If you have configured the Telnet Client with only one host profile, the
Authorizing Terminal dialog box appears.

4 In the Select Host dialog box, select the host with which you want to
establish a Telnet session.

The Authorizing Terminal dialog box appears in the Authorizing Terminal
dialog box, select Start Demo.

The Telnet Client uses the demonstration license and attempts to connect
to the host that you selected. Before displaying the host emulation screen,
the Telnet Client displays a screen that indicates that you are using a
demonstration license (Figure 7-5).

TN 5250/3270/VT/HP -
mlicensed Software!

For Demonstration
Purposes ONLY

Mot for Resale

Figure 7-5. Telnet Client Running in Demonstration Mode
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Chapter 8: Using the Telnet Client

This chapter provides the following information:

* Using the Telnet Client and Connecting to Hosts

* Working with Multiple Concurrent Telnet Sessions
¢ Using the Standard Virtual Emulation Keyboard

¢ Using Screen Panning

¢ Using ActiveText

¢ Using the Telnet Client Diagnostics Utility

* Using the Telnet Client Options Menu

Using the Telnet Client and Connecting to Hosts
This section provides the following information:
* Launching the Telnet Client
* Initiating a Telnet Session
¢ Disconnecting a Telnet Session
* Exiting the Telnet Client
Launching the Telnet Client

Depending on the method that you used to install the Telnet Client, you will
have different options for launching the Telnet Client.

If you installed the Telnet Client through Microsoft ActiveSync or another
third-party application, then you will be able to launch the application from
the Windows CE Start menu or from the desktop.

If you installed the Telnet Client through Avalanche Manager, then you will
also be able to launch the Telnet Client from the Avalanche Enabler interface
on the mobile device.
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Launching the Telnet Client From Windows

You can launch the Telnet Client from the Programs menu or, in some
instances, from the desktop.

To launch the Telnet Client:

1 On the mobile device, access the Windows CE Start menu.
2 In the Windows CE Start menu, access the Programs group.

3 Inthe Programs folder, double-click the Telnet Client shortcut icon (Figure
8-1).

Figure 8-1. Telnet Client Shortcut Icon

The Telnet Client launches on the mobile device and displays the default
screen (Figure 8-2)



Chapter 8: Using the Telnet Client 131

No host connection

<Enter> to Connect

Figure 8-2. Telnet Client Default Screen

Launching the Telnet Client from Avalanche

If you used Avalanche Manager to install the Telnet Client, then a shortcut
icon for the Telnet Client appears in the Programs screen of the Avalanche
Enabler.

To launch the Telnet Client from the Avalanche Enabler:

1 On the mobile device, launch the Avalanche Enabler.

2 If the Programs view is not available in the Avalanche Enabler, access the
View menu and enable the Programs view.

The Telnet Client shortcut icon appears in the Programs view of the
Avalanche Enabler (Figure 8-3).
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Rl View Help

@)

TelnetCE

Avalanche Enabler 3.50-04
Copyright 2003-2005
Wavelink Corporation.

Figure 8-3. Telnet Client Shortcut Icon in the Avalanche Enabler

3 In the Programs view of the Avalanche Enabler, double-click the Telnet
Client icon.
The Telnet Client launches on the mobile device and displays the default
screen (Figure 8-4).
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No host connection

<Enter> to Connect

Figure 8-4. Telnet Client Default Screen

Initiating a Telnet Session

Use the Telnet Client to initiate a Telnet session with any host for which you
have configured a host profile.

NOTE For more information about host profiles and configuring host profiles
for the Telnet Client, see Chapter 3: Host Profiles on page 33.

To initiate a Telnet session with a host:

1 On the mobile device, launch the Telnet Client.
The Telnet Client launches and displays the default screen.
2 Pressthe Enter key.

The Select Host dialog box appears (Figure 8-5).
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No host connection

<Enter> to Connect

Figure 8-5. Select Host Dialog Box

NOTE If you have configured only one host profile for the Telnet Client, the
Select Host dialog box does not appear. Instead, the Telnet Client
automatically attempts to connect to the host for which you have configured
the single host profile.

3 In the Select Host dialog box, select the host to which you want to connect.
4 Click OK.

The Telnet Client attempts to establish a Telnet session with the host.

NOTE If the client does not have a license, then the Authorizing Terminal dialog
box appears. For more information about Telnet Client licensing, see Chapter
7: Licensing on page 119.
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Disconnecting a Telnet Session

Use the Telnet Client Options menu to disconnect from an active Telnet
session.

To disconnect from a Telnet session:

1 Access the Telnet Options menu.

2 In the Options menu, select Disconnect Session [n]-[name]
(Figure 8-6), where:

* <n> isthe session number that you want to disconnect, as displayed in
the Options menu.

* <name> isthe name of the host from which you want to disconnect, as
displayed in the Options menu.

Disconnect Session 1: Host 1 -
Scripting

Configure o
View v |

About Telnet...

Exit

Figure 8-6. Disconnecting a Telnet Session

When you make the selection, the session that you selected is terminated.
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Exiting the Telnet Client

You can use the Telnet Client Options menu to exit the Telnet Client.
Depending on the configuration of the Telnet Client, you may be required to
supply an exit password before you can exit the Telnet Client.

NOTE By default, the Telnet Client is not configured with an exit password.
For more information about configuring an exit password for the Telnet
Client, see Configuring Passwords on page 121.

To exit and close the Telnet Client:

1 Access the Telnet Client Options menu.

2 In the Telnet Client Options menu, select Exit (Figure 8-7).

Connect Session 1 et vkRessl

Configure

View
— ronnect

About Telnet...

Figure 8-7. Exiting the Telnet Client

If you have configured the Telnet Client with an exit password, the Input
Password dialog box appears.
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If you have not configured an exit password, the Telnet Client closes.
3 In the Input Password dialog box, type the exit password.
4 Select OK.

The Telnet Client closes.

Working with Multiple Concurrent Telnet Sessions
This section provides the following information:
¢ Overview of Multiple Concurrent Sessions
* Initiating an Additional Telnet Session
¢ Switching Between Active Telnet Sessions

* Disconnecting a Session

Overview of Multiple Concurrent Sessions

The Telnet Client supports up to four concurrent Telnet sessions. These may
include simultaneous sessions to the same host or to different hosts.

By default, the Telnet Client is configured to allow a user to engage in only
one Telnet session. To provide for more than one active Telnet session, you
must configure the Telnet Client to allow multiple concurrent sessions.

NOTE For information about configuring the Telnet Client to support multiple
concurrent sessions, see Configuring the Number of Concurrent Sessions on
page 123.

When the Telnet Client is configured to support multiple sessions, then
multiple connection options appear in the Telnet Client Options menu.

Initiating an Additional Telnet Session

If you have configured the Telnet Client to allow multiple Telnet sessions and
the Telnet Client is engaged in one or more Telnet sessions, you may initiate a
new Telnet session from the Options menu.



138 Wavelink Telnet Client User’s Guide

To initiate an additional Telnet session:
1 Ensure that the Telnet Client is configured to allow multiple concurrent
sessions.

2 Access the Telnet Client Options menu.

The Options menu displays the available sessions (between 1 and 4) and
indicates which sessions are connected to a host and which are
unconnected.

3 From the Options menu, select an unconnected session that you want to
use to connect to the host (Figure 8-8).

options_
Disconnect Session 1
Scripting »

Secsion 1: Host 1
Session 2: Host 2
Secsion 3: Host 3

Configure
View b

About Telnet...

Exit

Figure 8-8. Available Unconnected Telnet Session

The Telnet Client now displays the default screen. (The default screen
prompts you to press ENTER to connect to a host.)

4 Pressthe Enter key.

The Select Host dialog box appears.
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5 Use the Select Host dialog box to select the host with which you want to
establish a Telnet session.

6 Select OK.
The Telnet Client attempts to connect to the host that you have selected.

Switching Between Active Telnet Sessions

If the Telnet Client is engaged in more than one Telnet session, use the
Options menu to switch between the sessions.

To switch between Telnet sessions:

1 In the Telnet Client, access the Options menu.

2 In the Options menu, select the active session that you want to view
(Figure 8-9).

Optons
Disconnect Session 3
Scripting

Session 2: Host 2
Secsion 3: Host 3
Session 4: Unconnected

Configure 3
View b

About Telnet...

Exit

Figure 8-9. Switching to a Different Telnet Session

The Telnet Client switches the view to the Telnet session that you selected.
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NOTE You can also use the Next Sess or Prev Sess keys in the virtual
emulation keyboard to switch between sessions. For information about
accessing the virtual emulation keyboard, see Using the Standard Virtual
Emulation Keyboard on page 141.

Disconnecting a Session

Use the Options menu to disconnect a session. You must switch to the session
that you want to disconnect, before you can disconnect it.

To disconnect a Telnet session:

1 In the Telnet Client, access the Options menu.

2 From the list of sessions in the Options menu, select the session that you
want to disconnect.

The Telnet Client switches the view to the session that you selected.
3 Access the Options menu again.

4 In the Options menu, select Disconnect Session [n],where [n] is
the session number that is currently active (Figure 8-10).
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Disconnect Session 1 ationP™
Scripting

Seccion 1: Host 1
Seccion 2: Host 2
Session 3: Unconnected
Session 4: Unconnected

Configurs 3
View b
About Telnet...

Exit

Figure 8-10. Disconnecting a Session

Using the Standard Virtual Emulation Keyboard

The Telnet Client contains a default virtual emulation keyboard. You can
access the keyboard through the Telnet Client Options... menu.

To access the virtual emulation keyboard:

1 Access the Telnet Client Options... menu.

2 Select View > Emulation Keyboard (Figure 8-11).
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Scripting

Disconnect Session 1: Host 1

Configure

Exit

Figure 8-11. Accessing the Virtual Emulation Keyboard

The virtual emulation keyboard appears.

About Telnet.

Emulation Keyboard
Numeric Keyboard

Font

The type of emulation keyboard that displays is dependent on the
emulation type of the current Telnet session. The VI/HP virtual emulation
keyboard is different than the 5270/3270 virtual emulation keyboard. If
there is not active session, then the basic virtual emulation keyboard

appears.

Using the Basic Virtual Emulation Keyboard

Figure 8-12 shows the basic Telnet Client virtual emulation keyboard.

TermiConfig

Prog Info

Mext Sess

HostConfig

Prew Sess

Keyclks | Cuiet | Diags | Erter

Figure 8-12. Telnet Client Virtual Emulation Keyboard
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The following list describes the function of the keys in the basic virtual

emulation keyboard:

TermConfig

Prog Info

Next Session

Host Config

Prev Session
Keyclks
Quiet

Diags

Enter

Close

Allows you to access and configure the emulation
parameters for a specific host profile.

Shows/hides the following information about the
mobile device:

¢ Telnet Client version information
e MAC address
e IP address

e ESSID
Cycles to the next Telnet Client session.

Allows you to access and configure the host profiles
for the Telnet Client.

Cycles to the previous Telnet Client session.
Turns keyclicks on/off.
Turns quiet mode on/off.

Allows you to access the Telnet Client diagnostic
tools.

Connects the session.

Disconnects the session. (Only available when the
session is connected.)

Using the 5250/3270 Virtual Emulation Keyboard

Figure 8-13 shows the Telnet Client virtual emulation keyboard for 5250/3270

emulation.
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I |0]P[res|<--
[k |L | FigldExit

Figure 8-13. Telnet Client 5250/3270 Virtual Emulation Keyboard

The following list describes the function of the control keys that appear at the
bottom of the virtual emulation keyboard:

Alpha Displays the alpha keys for 5250/3270 emulation,
including:

® a-z

e Tab, Caps Lock, Shft, Res, Backspace, FieldExit,
Enter, Space, Alt

Num Displays the numeric keys for 5250/3270 emulation,
including:

e 0-10
* Mathematical symbols
* Reset, Backspace, FieldExit, Enter, Arrow Keys

e Tab, Shft, Space

Func1 Displays the function keys for 5250/3270 emulation,
including:

e F1-F24

e Roll Up, Roll Down, Enter
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Func2 Displays other function keys for 5250/3270
emulation, including:

* Dup, Print, Clear
* Attn, Help, Home
¢ Insert, Roll Up, Roll Down

* Delete, SysRq, ErInp, Reset

Punc Displays punctuation characters for 5250/3270
emulation, including:

* Various punctuation and mathematical symbols

¢ Reset, Field Exit, Enter

Alt Displays the basic virtual emulation keyboard. For
information about the keys in the basic virtual
emulation keyboard, see Using the Basic Virtual
Emulation Keyboard on page 142.

Off Hides the virtual keyboard.

Using the VT/HP Virtual Emulation Keyboard

Figure 8-14 shows the Telnet Client virtual emulation keyboard for VI/HP
emulation.

shit ||Esc{q fw e [r [t |y |u]i [o]p] <
ctrl |[Tab [a [s [d]f [g|h]j [k ][I [Enter
2lt || Caps [z [x [c |v [b[n|m] Space [[+]
RN 1o [Func [Punc | cfg | off [[«[=]4

Figure 8-14. Telnet Client VI/HP Virtual Emulation Keyboard
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The following list provides information about the various control keys that
appear at the bottom of the VI/HP virtual emulation keyboard.

Alpha

Num

Func

Punc

Cfg

Displays the alpha keys for VI/HP emulation,
including:

* a-z
* Esc, Caps lock, Tab, Space, Enter, Backspace

e Shft, Ctl, Alt

Display the numeric keyboard for VI/HP emulation,
which contains the following keys:

e 0-9
e Esc, Tab, Ins, Rem, Backspace, Enter, Space

e Shft

Displays the function keys for VI/HP emulation,
including:

e F1-F10

* Esc, Tab, Prev, Next, Find, Sel, Space, Backspace,
Enter

e Shft, Ctrl, Alt

Display the punctuation keys for VI/HP emulation,
including:

* Punctuation Keys

* Backspace, enter, Space

Display the basic virtual emulation keyboard. For
information about the keys in the basic emulation
keyboard, see Using the Basic Virtual Emulation
Keyboard on page 142.
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Off Hides the virtual keyboard.
Arrow Keys Moves the cursor in the direction of the arrow key
that you press.

Using the WEB Virtual Emulation Keyboard

Figure 8-15 shows the Telnet Client virtual emulation keyboard for WEB
emulation.

Back | Fwd | Stop | Refresh | Home

Prev Sess | Mext Sess Close
Key Clicks |Quiet | Info | Diags [?
alpha [rurn [Func [Punc Off |||+

Figure 8-15. Telnet Client WEB Virtual Emulation Keyboard

The following list describes the function of the keys in the WEB virtual
emulation keyboard.

Back Returns the browser to the previous web page.

Fwd Returns to the screen displayed before Back was
selected.

Stop Stops the web page from loading.

Refresh Reloads the current web page.

Home Returns the browser to the specified home page.

Prev Sess Cycles to the previous Telnet Client session.

Next Sess Cycles to the next Telnet Client session.

Close Disconnects the session. (Only available when the

session is connected.)
Key Clicks Turns key clicks on/off

Quiet Turns quiet mode on/off.
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Info

Diags

Alpha

Num

Func

Punc

Cfg

Shows/hides the following information about the
mobile device:

e Telnet Client version information
e MAC address
e JP address

e ESSID

Allows you to access the Telnet Client diagnostic
tools.

Displays the alpha keys for WEB emulation,
including:

® a-z
e Shift, Ctl, Alt

* Esc, Tab, Caps, Enter, Space

Displays the numeric keyboard for WEB emulation,
including:

e 09
e Shft

* Esc, Tab, Ins, Enter, Space

Displays the function keys for WEB emulation,
including:

e F1-F24

Displays the punctuation keys for WEB emulation,
including:

* Punctuation keys

¢ Enter, Space

Display the virtual emulation keyboard.
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Off Hides the virtual keyboard.
Arrow Keys Moves the web page up and down or from side to
side.

Using Screen Panning

By default, the screen panning feature of the Telnet Client is enabled.

Screen panning feature of the Telnet Client allows a user to use the stylus to
move around an emulation screen. When screen panning is enabled, a user
can tap-and-drag the stylus and scroll across the emulation screen.

Screen panning has two modes of operation:

e Standard. By default, standard screen panning is enabled on the Telnet
Client. When standard screen panning is enabled, the screen scrolls in the
direction that the user drags the stylus across the screen. Standard screen
panning simulates the effect of dragging the display of the mobile device
over the emulation screen.

* Reversed. When reversed screen panning is enabled, the screen scrolls in
the opposite direction that the user drags the stylus. Reverse screen
panning simulates the effect of dragging the emulation screen beneath a
fixed view port (that is, mobile device display).

NOTE For information about configuring screen panning, see Configuring
Screen Panning on page 130.

Using ActiveText
By default, the ActiveText feature of the Telnet Client is enabled.

ActiveText allows the Telnet Client to identify menu items and functions in an
emulation screen and convert them to interactive objects that a user can
double-click to execute.

When a string of text is turned into ActiveText, a user can perform the
following actions on the ActiveText object:
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¢ Single-click. A single click highlights the string of text and indicates that it
has become an ActiveText object.

¢ Double-click. A double-click executes the menu item or the function that
has been converted to an ActiveText object.

You can configure the Telnet Client to recognize two types of text strings that
will be converted to ActiveText objects:

* Simple number menu item

* AS5/400-style function key

NOTE For information about configuring ActiveText, see Configuring
ActiveText on page 132.

Simple Number Menu Item

The Telnet Client can recognize numbered options in a menu and convert
them to an ActiveText object.

The Telnet Client recognizes a string of characters in the following list as a
simple number menu item:

* A beginning of line or a space
* A number (a string of digits)
e A period (")

* A space

* A non-space character

For example, the Telnet Client would convert the menuitem 90. Sign Off
in an emulation to ActiveText. The user could then double-click the
ActiveText to invoke the 90. Sign Off menu option.

AS/400-Style Function Key

The Telnet Client can recognize AS/400-style function key commands in an
emulation screen.
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The Telnet Client recognizes the following string of characters as an AS/400-/
style function key:

* A beginning of line or a space

* The character ‘F’

* A number (string of digits)

* An equal-to character ('=)

* A non-space character

For example, the Telnet Client would convert the function key command
F3=Exit to ActiveText. The user could then double-click the ActiveText to
invoke the F3=Exit command.

Using the Telnet Client Diagnostics Utility

The Telnet Client diagnostics utility allows you to perform the following
tasks:

¢ Capture scan codes for external keyboard character sequences

* Perform a scan test

e Capture scan codes for the Windows virtual keyboard
Accessing the Telnet Client Diagnostics Utility

Use the Telnet Client virtual keyboard to access the diagnostics utility.

To access the diagnostics utility:

1 In the Telnet Client, access the virtual emulation keyboard.

2 In the virtual keyboard, click Diags.

NOTE Diags appears in the basic virtual emulation keyboard. For VI/HP
emulation, Diags appearsinthe Cfg display of the virtual keyboard. For
5250/3270 emulation, Diags appearsinthe Alt display of the virtual
keyboard.
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The Program Diagnostics screen appears in the Telnet Client (Figure 8-16).

PROGEAM DIAGNOSTICS

Eeyboard Test
Scan/MSR Test
Windows EKeyboard Te
Quit Diagnostics

Figure 8-16. Telnet Client Diagnostics Utility

3 Select one of the options in the Program Diagnostics screen:

e Press K to perform a keyboard test, which allows you to obtain scan
codes for the external keyboard and the Telnet Client virtual keyboard.

e Press S to perform a scan test, which allows you to determine the type
of barcode for a scan

* Press W to perform a Windows keyboard test, which allows you to
obtain scan codes for the Windows virtual keyboard.

* Press Q to quick the diagnostics utility.
Performing a Keyboard Test

Use the Telnet Client to obtain scan codes for the external keyboard and the
Telnet Client virtual keyboard.
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To perform a keyboard test:

1 Ensure that you have an active VI/HP or 5250/3270 Telnet session.

NOTE An active session is required to test the Telnet Client virtual keyboard.
The virtual keyboard displays keys based on the current Telnet session type.

2 Use the Telnet Client virtual keyboard to access the Program Diagnostics
screen.

3 Press K for Keyboard Test.
The Keyboard Test screen appears.

4 Use the external keyboard or the virtual keyboard to submit a character
sequence to the Telnet Client.

The Telnet Client displays the scan code for the character sequence (Figure
8-17).

EEYBOARD TEST
——Press @ to return—-

Figure 8-17. Performing a Keyboard Test
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5 Press Q to exit the Keyboard Test screen.
6 Press Q to exit the Telnet Client diagnostics utility.
Performing a Scan Test

Use the Telnet Client diagnostics utility to perform a scan test. A scan test
allows you to verify the type and value of scanned data. The scan test utility
does not process any scan handlers, scan identifiers, or pre- or post-amble
strings. However, scan identifiers that you have configured are added to the
scan.

To use the diagnostics utility to perform a scan test:

1 In the Telnet Client, access the diagnostics utility.
The Program Diagnostics screen appears.
2 Select S for Scan/MSR Test.
The Scan/MSR Test screen appears.
3 Use the scanner on the mobile device to perform a test scan.

The Scan/MSR Test screen displays the results of the scan (Figure 8-18).
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SCAN/MSR TEST
——Press Q to return—-
Barcode #1:

Length 12
123456789012

Figure 8-18. Performing a Scan Test

4 Press Q to close the Scan/MSR Test screen.
Performing a Windows Keyboard Test

Use the Telnet Client diagnostics utility to obtain scan codes for the Windows
virtual keyboard.

To use the diagnostics utility to obtain Windows scan codes:

1 In the Telnet Client, access the diagnostics utility.
The Program Diagnostics screen appears.

2 Select W for Windows Keyboard Test.
The Windows Keyboard Test screen appears.

3 Access the Windows virtual keyboard.

4 Select a character sequence in the Windows virtual keyboard.
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The diagnostics utility displays the scan code for the character sequence
that you submitted to the Telnet Client (Figure 8-19).

Optons
INDOWS EEYBOARD TEST
——FPress ) to return——

indows Virtual
Eey Code: o041

Figure 8-19. Performing a Windows Keyboard Test

5 Press Q to exit the Windows Keyboard Test screen.

6 Press O to exit the diagnostics utility.

Using the Telnet Client Options Menu

This section provides a description of each option in the Telnet Client
Options menu.

Connect Session [n] Select this option to use the current session to initiate
a Telnet connection with a host, where [n] is the
session number that is currently active.

Disconnect Session [n] Select this option to disconnect the current session,
where [n] is the session number that is currently
active.
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Session [n] -
[name]junconnected

Web > Back

Web > Forward

Web > Stop
Web > Refresh

Web > Home

Web > Text Size

Scripting > Execute
Script

Select this option to switch between sessions, where:

[n] indicates the session number

[name] indicates that the session is currently
connected to [name] host

unconnected is a constant that indicates that
the session is not currently in use

Select this option to return the browser to the
previous web page.

Select this option to return to the screen displayed
before Back was selected.

Select this option to stop the web page from loading.

Select this option to reload the current web page.

Select this option to return the browser to the
specified home page.

Select this option to change the text size. The
available options are:

XXX

Scripting > Cancel Script XXX

Scripting > Start
Capture

XXX

Scripting > Stop Capture XXX

Largest
Larger
Medium
Smaller

Smallest
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Scripting > Verify
Screen Contents

Scripting > Save Cursor
Position

Configure > Host
Profiles

Configure > Emulation

Configure > Scripting

Configure >
Authorization

Configure > Localization

View > Emulation
Keyboard

View > Numeric
Keyboard

View > Font

About Telnet...

Exit

XXX
XXX

Select this option to configure host profiles for the
Telnet Client.

Select this option to configure emulation parameters
for the Telnet Client.

XXX

Select this option to configure licensing for the Telnet
Client.

Select this option to configure localization for the
Telnet Client.

Shows/hides the virtual emulation keyboard.
Shows/hides the numeric keyboard.

Displays the font settings for the Telnet session. Use
the Font tab in the dialog box to modify the font
settings for the Telnet session.

Displays the About window, which provides
information about the Telnet Client.

Select this option to exit and close the Telnet Client.
Depending on the configuration of the Telnet Client,
you may need to supply an exit password.
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Chapter 9: Industrial Browser (WEB

Emulation)

This chapter provides information about using and developing for the Telnet
Client Industrial Browser. This chapter includes the following information:

* Overview of the Industrial Browser

¢ Licensing

¢ Industrial Browser Host Profile Settings
¢ Using the Industrial Browser

* Developing Web Pages for the Industrial Browser

Overview of the Industrial Browser

Licensing

Wavelink Telnet Client includes an Industrial Browser interface that gives you
the ability to access web-based applications from a mobile device. The
Industrial Browser supports PocketPC 2003, Windows Mobile 5.0, Windows
2000/XP, and Windows CE .NET 4.2/5.0.

NOTE The Industrial Browser is included in Telnet Client 6.0 and later
versions.

The Telnet Client Industrial Browser requires a license for full functionality.
There are two ways to license Telnet Client Industrial Browser:

¢ If you do not currently have a Telnet Maintenance license, you can
purchase a Telnet Client 6.0 Standalone Browser license. (A separate
Browser Maintenance license is also available.)

¢ If you currently have a Telnet Maintenance license, you can purchase an
Industrial Browser add-on license. (Browser Maintenance is included).
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NOTE For more information on licensing, see Chapter 7: Licensing on page 119

Industrial Browser Host Profile Settings

This section describes the parameters of each tab used to configure WEB
emulation settings in the Host Profiles dialog box.

NOTE For more information on Host Profile Settings, see “Host Profiles” on
page 33.

HTTP Proxy

Use the HTTP Proxy tab to configure proxy connections for WEB emulation.

HTTPS Prowsy bccess List Configuration
Host HTTP Prouy
Connection Type:
|Jze Prowy Serer w
Proxy Server; Port:
| 8020

[]Do not use the proxy server when contacting local hosts
[Hosts without a period in their name)

Figure 9-1. Configuring the HTTP Proxy tab
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The following list describes the options and configurable parameters in the

HTTP Proxy tab.

Connection Type

Proxy Server

Port

Do not use the proxy
server when contacting
local hosts

HTTPS Proxy

Indicates the type of connection for the host profile
to use.

Possible Values: <Direct Connection> <Use Explorer
Default> <Use Proxy Server>

Default Value: <Direct Connection>
Indicates the location of the proxy server.

Possible Values: Any valid IP address, host name, or
web address.

Default Value: <None>
Indicates the network port for the proxy server.
Possible Values: Any valid port number.

Default Value: <8080>

Indicates whether the Telnet Client should use the
proxy server when contacting hosts that reside on
the same network.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Use the HTTPS Proxy tab to configure secure proxy connections for WEB

emulation.
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Huost HTTF Prosy
HTTPS Prosy fieoess List Carfiguration

Conrection Type:
[Jze Prowy Server L

Prowy Server: Poart:
| s0a0

[ Do not uge the prowy server when contacting local hosts
[Hosts withaut a penad in their name]

Figure 9-2. Configuring the HTTPS Proxy Tab

The following list describes the options and configurable parameters in the

HTTPS Proxy tab.

Connection Type Indicates the type of connection for the host profile
to use.
Possible Values: <Direct Connection><Use Explorer
Default> <Use Proxy Server>
Default Value: <Direct Connection>

Proxy Server Indicates the location of the proxy server

Possible Values: Any valid IP address, host name, or
web address.

Default Value: <None>
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Port Indicates the network port for the proxy server.
Possible Values: Any valid port number.

Default Value: <8080>

Do not use the proxy Indicates whether the Telnet Client should use the
server when contacting proxy server when contacting hosts that reside on
local hosts the same network.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Access List
Use the Access List tab to configure which web addresses can be accessed by
the Telnet Client Industrial Browser.
Huozt HTTF Prowy
HTTPS Proxy Access List Configuration

Allowed 'Web Server Addreszes:

vy, wavelink, com

[ Add Address l [ Delete Address

[] &llaws web servers on the local netwark [subnet]

[F the Allowed ‘web Server dddresses list iz empty and the
local netwark, checkbax iz not checked, the client iz
allowed to communicate with AMY web server.

Figure 9-3. Configuring the Access List Tab
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The following list describes the options and configurable parameters in the

Access List tab.

Allowed Web Server
Addresses

Allow web servers on
the local network
(subnet)

Add Address

Delete Address

Using the Industrial Browser

A list of web addresses that the Telnet Client is
permitted to connect with.

Possible Values: Any valid IP address, host name, or
web address.

Default Value: <None>

Indicates whether the Telnet Client can connect with
any web server, or only with severs on the local
network.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Select this button to add a new IP or web address to
the list of addresses that Telnet Client is permitted to
connect with.

Select this button to delete any address in the list.

This section provides information about using the Telnet Client Industrial
Browser, including the following:

* Basic Navigation

* Specifying the Home Page

Basic Navigation

The Telnet Client Industrial Browser interface provides basic commands for

navigating web pages.

To navigate within the Industrial Browser:

1 Tap and hold the on the screen.

A menu appears.
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2 From this menu, you can select from the following options:

Back Returns the browser to the previous web page.
Forward Returns to the screen displayed before Back was
selected.
Stop Stops the web page from loading.
Refresh Reloads the current web page.
Home Returns the browser to the specified home page.
Text Size Displays a menu with the following text size options:
e Largest
e Larger
¢ Medium
e Smaller
e Smallest

Specifying the Home Page

The home page is the first page users will see when connecting to the
Industrial Browser; it is also the page users will be returned to when they
select Home. The home page will be the location you set up in the Host Profile
for WEB emulation. This can either be an IP address or a specific web address.

Developing Web Pages for the Industrial Browser

This section provides information on the META tags and IDA commands
supported by the Telnet Client Industrial Browser. You can use these tags to
develop custom web pages that will enable specific functionality in the
Industrial Browser. The following information is included:

¢ META Tags

e IDA Commands
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META Tags

META tags are included at the top of a web page between the <HEAD> and
</HEAD> tags. They are evaluated in the order they appear in the web page
(from top to bottom). The Industrial Browser is designed to work only with
tags it recognizes; it will ignore tags it does not recognize. If a META tag starts
with the iBrowse prefix, that prefix will be ignored. For example,
iBrowse ScannerNavigate isthe sameas ScannerNavigate.

Each META tag has the following format:
<meta http-equiv="action name” content="action type”>

In the preceding format, the action type canbea URL, an IDA action, or
a JavaScript function. Some actions allow the action type to include
replacement values; a $s or %d or %$1d string can be used to indicate
where each replacement item belongs.

NOTE These strings are interchangeable and can be used in any format that
you prefer.

The following are META tags supported by the Telnet Client Industrial
Browser:

®* OnAllKeys, OnKey..., OnKeyOx...

® OnStartup, IDA

* Printing

® Scanner

® ScannerNavigate, ScannerProcessed
* Symbologies

OnAllKeys, OnKey..., OnKeyOx...

The OnKey... and OnKeyOx... META tags describe an action that will
occur if a particular key is pressed. The key values that are evaluated are the
same key values used by Keyboard Creator.
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The OnKeyOx format requires a hexadecimal number, while the OnKey
format will require a decimal format. The key value is also case sensitive.

For example:
OnKey50 and OnKey0x32 will both respond to the 2 key.

OnKey65 and OnKey97 would be used to respond to both the upper and
lowercase A.

The OnAllKeys tag will perform the prescribed action each time a key is
pressed. The action type can include one argument, which is the string
representing the decimal value of the key.

NOTE Due to browser limitations, some keys (such as Tab) may not always
be handled by this tag.

OnStartup, IDA

The OnStartup and IDA META tags allow you to specify actions that will
be taken when the web page is first loaded. The action type must be one of the
action types described in IDA Commands on page 170.

Printing

You can send data to the printer by including the data in the META tags. Use
the Print Continue and Print Finish action names to specify the
print data. The print data is in the action type of these META tags. The print
data in each META tag should all be on the same line and should not be more
than 1024 characters in length; however the total print data can be larger than
1024 characters. In addition to standard characters, you can use the following:

* \r to specify a return character

* \n tospecify a newline character

* \t tospecify a tab character

* \\ to specify a backslash character

o \## or \x## to specify any other character, where ## is replaced
with a two-digit hexadecimal number



168

Wavelink Telnet Client User’s Guide

Print Continue should be used for all but the last section of print data,
and Print Finish should be used for the last section of print data.

NOTE If desired, the action names Print Done, Print Final,
PLSeriesLabel Print and ZebralLabel Print can be used instead of
Print Finish.

The META tag Print Callback can be used to specify the action that will
occur after the printing is completed. The argument will be 0 if the printing
was successful, or a non-zero number if the printing failed.

NOTE If desired, the action names Print Complete,
Zebralabel Complete and PLSeriesLabel Complete can be used
instead of Print Callback

The META tag Print Setup TP can be used to specify the IP Address and
port of the printer if using TCP printing. If this tag is used, it must be
specified before the Print Finish tag. The formatis address:port.

For example:

<meta http-equiv="Print Setup TP”
content="192.168.1.59:7429">

<meta http-equiv="Print Continue”
content="\22First Line\22\r\n”>

<meta http-equiv="Print Continue”
content="\22Middle\22\r\n”>

<meta http-equiv="Print Finish”
content="\22Last Line\22\r\n”>

<meta http-equiv="Print Callback”
content="printresult.htm&status=%s”
Scanner

If the action name is Scanner and the action typeis Enabled or Resume,
the scanner will be enabled when the page is first loaded. If the action type is
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Disabled or Suspend, the scanner will be disabled when the page is first
loaded.

There are three additional scanner action types supported by Telnet Client
Industrial Browser:

e AutoTab
® AutoEnter
® AutoEnterAndTab

These action types will enable the scanner and will cause the scan data to be
followed by an enter or tab key (or both).

Once enabled or disabled, the scanner will stay in that state until some other
action (such as a META tag or IDA action) changes the state or until the user
changes sessions. It is recommended that every web page include support for
enabling and disabling the scanner as appropriate.

ScannerNavigate, ScannerProcessed

The ScannerNavigate META tag is used to handle raw scan data. The
ScannerProcessed tag is similar, but gives the scan data after it has been
modified by the scan handlers, etc. in the Emulation Parameters.

If the action type has 0 to 3 arguments, then the arguments are (from left to
right): the barcode data, the symbology type, and the time stamp.

If the action type has 4 or 5 arguments, then the arguments are (from left to
right): the barcode data, source scanner name, symbology type, time stamp,
and barcode length.

NOTE Refer to the following section for supported symbology types.

Symbologies

It is possible to enable and disable different symbologies by using the
symbology as the action name, and Enabled or Disabled as the action
type. The symbologies supported by Telnet Client Industrial Browser are as
follows:

AUSTRALIA POSTAL CUECODE PLANET
AZTEC D20OF1ATA PLESSY



170

Wavelink Telnet Client User’s Guide

AZTECMESA D20F5 POSICODE
BOOKLAND DATAMATRIX POSTNET
BRITISH POSTAL DUTCH_ POSTAL QRCODE
CANADA POSTAL EANS RSS14
CHINA POSTAL EAN13 RSSEXPANDED
CODABAR I20F5 RSSLIMITED
CODABLOCK JAPAN POSTAL SIGNATURE
CODE11 KOREA POSTAL TELEPEN
CODE16K MACROPDF TLC39
CODE32 MACROMICROPDF TRIOPTIC39
CODE39 MAXICODE Ucclzs8
CODE49 MATRIX20F5 UPCA
CODE93 MICROPDF UPCE
CODE128 MSI UPCEOQ
COMPOSITE OCR UPCE1
COUPONCODE PDF417 WEBCODE

In addition to the preceding symbologies, the value ALL DECODERS can be
used to enable or disable all the symbologies.

For example:

To enable only UPCA, use the META tags in this order

<meta http-equiv="ALL DECODERS” content="Disabled”>
<meta http-equiv="UPCA” content="Enabled”>

IDA Commands

IDA commands are special values used to invoke a device action, program
action, or emulator action within the Telnet Client Industrial Browser. These
values can be specified in many of the special META tags described above, as
URLSs for the user to click on, or called inside JavaScript functions.

For example:

<a href="ida:IDA_SESSION_DISCONNECT”>
Close the session</a>

_Or_
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<script language=javascript>
function OnError ( )
{
// Disconnect the Session
location.href = “ida:IDA SESSION DISCONNECT” ;

// Alternate Method
document.location = “ida:IDA SESSION DISCONNECT” ;

// BAnother Alternate Method

window.navigate ( “ida:IDA SESSION DISCONNECT” ) ;
}
</script>

NOTE It is recommended that each IDA command be preceded by the ida
prefix; however, the command will generally work without the prefix.

The following are IDA commands supported by the Telnet Client Industrial
Browser:

IDA_KEYBOARD WEB, IDA KEYBOARD SHOW, or IDA KEYBOARD UP
e IDA KEYBOARD NUM or IDA KEYBOARD NUMERIC

¢ IDA KEYBOARD NONE, IDA KEYBOARD HIDE, or
IDA KEYBOARD DOWN

e IDA REPRINT
e IDA SCAN DISABLE or IDA SCAN SUSPEND
e IDA SCAN DISABLE or IDA SCAN RESUME
e IDA SESSION DISCONNECT

e IDA SIP SHOW or IDA SIP UP

e IDA SIP HIDE or IDA SIP DOWN

e IDA SIP TOGGLE or IDA SIP TOGGLEHIDE

e IDA URL BACK or IDA BACK
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e IDA URL BACK DISABLE or IDA BACK DISABLE

e IDA URL BACK ENABLE or IDA BACK ENABLE

e IDA URL FORWARD or IDA FORWARD

e IDA URL FORWARD DISABLE or IDA FORWARD DISABLE
e IDA URL FORWARD ENABLE or IDA FORWARD ENABLE
e IDA URL HOME or IDA HOME

e IDA URL HOME DISABLE or IDA HOME DISABLE

e IDA URL HOME ENABLE or IDA HOME ENABLE

e IDA URL REFRESH or IDA REFRESH

e IDA URL STOP or IDA STOP

e IDA ZOOM DISABLE or IDA FONT DISABLE

e IDA ZOOM ENABLE or IDA FONT ENABLE

e IDA ZOOM LARGER or IDA FONT LARGER

e IDA ZOOM LARGEST or IDA FONT LARGEST

e IDA ZOOM MEDIUM or IDA FONT MEDIUM

e IDA ZOOM MINUS or IDA FONT MINUS

e IDA ZOOM PLUS or IDA FONT PLUS

e IDA ZOOM SMALLER or IDA FONT SMALLER

e IDA ZOOM SMALLEST or IDA FONT SMALLEST

IDA_KEYBOARD_WEB, IDA_KEYBOARD_SHOW, or IDA_KEYBOARD_UP

Using one of these commands causes the emulation on-screen keyboard to be
displayed.
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IDA_KEYBOARD_NUM or IDA_KEYBOARD_NUMERIC

Using one of these commands causes the numeric on-screen keyboard to be
displayed.

IDA_KEYBOARD_NONE, IDA_KEYBOARD_HIDE, or
IDA_KEYBOARD_DOWN

These commands cause the emulation and numeric on-screen keyboards to be
hidden.

IDA_REPRINT

Using this command causes the last data supplied to the printer to be sent
again. The print data will remain available until something else is printed or
until the session is disconnected.

IDA_SCAN_DISABLE or IDA_SCAN_SUSPEND

Use one of these commands to disable the bar code scanner. When the bar
code scanner is disabled, pressing the mobile device trigger will have no
effect.

IDA_SCAN_DISABLE or IDA_SCAN_RESUME

Using one of these commands enables the bar code scanner. The bar code
scanner will not actually scan for bar codes unless the mobile device trigger is
pulled.

IDA_SESSION_DISCONNECT

Use this command to disconnect the session and close the Industrial Browser.

IDA_SIP_SHOW or IDA_SIP_UP

These commands cause the SIP on-screen keyboard to become visible.

IDA_SIP_HIDE or IDA_SIP_DOWN

These commands cause the SIP on-screen keyboard to become hidden.

IDA_SIP_TOGGLE or IDA_SIP_TOGGLEHIDE

Using one of these commands will cause the SIP on-screen keyboard to
become visible if it is hidden, or hidden if it is visible.

IDA_URL_BACK or IDA_BACK

These commands cause the Industrial Browser to display the screen previous
to the current screen. If there are no previous screens, no action will be taken.
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IDA_URL_BACK _DISABLE or IDA_BACK_DISABLE

Use one of these commands to disable the Back menu option so it cannot be
selected by the user.

NOTE The IDA URL BACKor IDA BACK commands are not affected and
will still work.

IDA_URL_BACK_ENABLE or IDA_BACK_ENABLE

Use one of these commands to enable the Back menu option so it can be
selected by the user. The menu option could still be disabled if there is no
page to go back to.

IDA_URL_FORWARD or IDA_FORWARD

These commands cause the Industrial Browser to display the screen that was
being displayed before the last Back command. If there was no previous
screen, no action will be taken.

IDA_URL_FORWARD_DISABLE or IDA_FORWARD_DISABLE

Use one of these commands to disable the Forward menu option so it
cannot be selected by the user.

NOTE The IDA URL FORWARD or IDA FORWARD commands are not
affected and will still work.

IDA_URL_FORWARD_ENABLE or IDA_FORWARD_ENABLE

Use one of these commands to enable the Forward menu option so it can be
selected by the user.

NOTE The menu option could still be disabled if there is no page to return to.

IDA_URL_HOME or IDA_HOME

These commands cause the Industrial Browser to proceed to the location
specified by the current Host Profile. It is completely independent from the
Home location for any other web browsers on the device.
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IDA_URL_HOME_DISABLE or IDA_HOME_DISABLE

Use one of these commands to disable the Home menu option so it cannot be
selected by the user.

NOTE The IDA URL HOME or IDA HOME commands are not affected and
will still work.

IDA_URL_HOME_ENABLE or IDA_HOME_ENABLE

Use one of these commands to enable the Home menu option so it can be
selected by the user.

IDA_URL_REFRESH or IDA_REFRESH

These commands cause the web page to be reloaded. The server will be
queried to verify that the page contents are up-to-date.

IDA_URL_STOP or IDA_STOP

These commands cause the web page to stop loading. If the web page is
already fully loaded, this action has no effect.

IDA_ZOONM_DISABLE or IDA_FONT_DISABLE

Use these commands to disable the Text Size menu to be disabled so it cannot
be selected by the user.

NOTE The IDA options to set the zoom level (text size) are not affected and
will still work.

IDA_ZOOM_ENABLE or IDA_FONT_ENABLE

Use these commands to enable the Text Size menu so it can be selected by the
user.

IDA_ZOOM_LARGER or IDA_FONT_LARGER

Using one of these commands causes the Industrial Browser to display the
text using a large text size.

NOTE This is a global setting. Other Telnet sessions, Internet Explorer, and
Pocket Internet Explorer will default to using this text size as well.
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IDA_ZOOM_LARGEST or IDA_FONT_LARGEST

Using one of these commands causes the Industrial Browser to display the
text using the largest text size supported by the browser.

NOTE This is a global setting. Other Telnet sessions, Internet Explorer, and
Pocket Internet Explorer will default to using this text size as well.

IDA_ZOOM_MEDIUM or IDA_FONT_MEDIUM

Using one of these commands causes the Industrial Browser to display the
text using a medium text size.

NOTE This is a global setting. Other Telnet sessions, Internet Explorer, and
Pocket Internet Explorer will default to using this text size as well.

IDA_ZOOM_MINUS or IDA_FONT_MINUS

These commands cause the Industrial Browser to display the text using the
next-smaller text size than the current text size.

NOTE This is a global setting. Other Telnet sessions, Internet Explorer, and
Pocket Internet Explorer will default to using this text size as well.

IDA_ZOOM_PLUS or IDA_FONT_PLUS

These commands cause the Industrial Browser to display the text using the
next-larger text size than the current text size.

NOTE This is a global setting. Other Telnet sessions, Internet Explorer, and
Pocket Internet Explorer will default to using this text size as well.

IDA_ZOONM_SMALLER or IDA_FONT_SMALLER

Using one of these commands causes the Industrial Browser to display the
text using a small text size.
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NOTE This is a global setting. Other Telnet sessions, Internet Explorer, and
Pocket Internet Explorer will default to using this text size as well.

IDA_ZOOM_SMALLEST or IDA_FONT_SMALLEST

Using one of these commands causes the Industrial Browser to display the
text using the smallest text size supported by the browser.

NOTE This is a global setting. Other Telnet sessions, Internet Explorer, and
Pocket Internet Explorer will default to using this text size as well.
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Chapter 10: Avalanche Integration

This section provides the following information:

* Overview of Avalanche Integration

¢ Using Session Monitor

¢ Using Real-Time Statistics

Overview of Avalanche Integration

A number of additional features are available for the Telnet Client when you
choose to install the Telnet Client via the Avalanche framework.

Avalanche-installed Telnet Clients offer the following Avalanche-integrated
features:

Session Monitor. Allows you to monitor and to take control of the Telnet
Client remotely from the Avalanche Management Console.

Real-Time Statistics. Allows you to view real-time statistics, including
session length and number of scans, from the Avalanche Client Controls
dialog box in the Avalanche Management Console.

To take advantage of the Avalanche features of the Telnet Client, your
Avalanche environment must meet the following requirements:

Avalanche Manager 3.5 (or greater version) for Session Monitor
Avalanche Manager 3.4 (or greater version) for Real-Time Statistics
Avalanche Enabler 3.x (or greater version)

A valid Avalanche license for the mobile device running the Telnet Client
A valid platform or maintenance license for the Telnet Client

Telnet Client 5.x (or greater version)
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Using Session Monitor
The Session Monitor utility allows you to view the Telnet Client on a mobile
device from the Avalanche Management Console. Session Monitor includes
an override feature that allows you to take control of the Telnet Client on the
mobile device. Session Monitor also includes a logging feature that allows
you to create a trace for Telnet sessions.
This sections provides the following information:
* Enabling Session Monitor
* Configuring Session Monitor
¢ Launching Session Monitor

¢ Session Override

¢ Tracing Sessions

NOTE Session Monitor requires Avalanche Manager 3.5 (or greater version)
and a valid Avalanche license.

Enabling Session Monitor

The following tasks are required to enable Session Monitor.

1 Install the Telnet Client 5.0 package in Avalanche Manager.
2 Configure the Telnet Client to use Session Monitor.

3 Preform an Avalanche update to deploy the Telnet Client to the mobile
device.

4 Launch the Telnet Client on the mobile device.
5 Launch Session Monitor from Avalanche Manager.
Configuring Session Monitor

Configure the following Session Monitor parameters in the Telnet Emulation
Parameters:
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To

Session Monitor Address. These are the IP addresses of computers that
the Telnet Client allows to do session monitoring. If no addresses are
specified, the Telnet allows session monitoring from any computer.

Session Monitor Override Timeout. This is the maximum number of
minutes that Session Monitor is allowed to override the session. After the
time expires, the override setting is disabled and control returns to the
client device. The default time-out for override mode is set to 0 (never).
This means the override mode will never time-out and the client regains
control only if override mode is disabled manually.

Session Monitor Password. This is the password required for Session
Monitor connections. The password is loaded in the Emulation Parameters
file and is never entered by the user. It has a 63 character limit. If no
password is entered, the Telnet Client will not accept Session Monitor
connections.

Session Monitor Port. This is the port that the Telnet Client listens to for
Session Monitor connections.

configure Session Monitor

Locate the Telnet Client software package in the Tree View of the
Avalanche Manager.

Right-click the software package.

Select Configure Package > Emulation Parameters.
Configuration Manager launches.

Expand the Emulation folder.

Expand the Session Monitor folder.

Double-click the Session Monitor menu items to change the parameters.

NOTE The Session Monitor Password is the only required configuration. The
other parameters are optional configurations.

7

Once you have configured the Session Monitor parameters, click the Save
button.



180

Wavelink Telnet Client User’s Guide

8 Close the configuration utility.

9 Perform an Avalanche update to download the new configuration to the
mobile device.

Launching Session Monitor
You can launch Session Monitor from the Avalanche Management Console.

To launch Session Monitor

1 From the Device View of Management Console, right-click the device you
want to monitor.

2 Selectthe Launch Session Monitor option (Figure 10-1).

Type | Termin...| MAC Address | IP Address | LI P LW

FPCZ003 ) St ooos e R
% Client Settings... E::i

Fing Client

Send Text Messane

Lipdate Mowe (Disallow User Override)
Update Mow {allow Llser Override)
Delete Client

an Manitar

Figure 10-1. Launching Session Monitor

NOTE The client device and the Avalanche Manager need to be
communicating over the network.

The Telnet Session Monitor screen opens and connects to the session. The
yellow-lined box represents what the device user can see (Figure 10-2).
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ﬁ Telnet - Session Monitor E]
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Figure 10-2. Connecting to Session Monitor

NOTE If both the mobile device and the Avalanche PC have SSL support
installed, the Session Monitor network information will be encrypted.

Session Override

Use the session override option of Session Monitor to take control of the
Telnet Client. When you enable session override, the mobile device user will
not be able to interact with the Telnet Client.

To enable override mode

1 In Session Monitor, access the Monitor menu.

2 Selectthe Session Override option (Figure 10-3).
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&1 Telnet - Session Monitor

gl Yiew  Session Help

Disconneckt From 10.21.0,15

Figure 10-3. Enabling Session Override

The session remains in override mode until the override timeout minutes
expire or until you manually disable the session override option.

Tracing Sessions

Use the Log Flle Settings dialog box to configure the Session Monitor log file to
trace Session Monitor sessions.

To trace a session

1 In Session Monitor, access the File menu.
2 Selectthe Log to File option.
3 Configure the log file settings.

4 Inthe Log File Path textbox, enter the path to the directory where
you want to save the log file (Figure 10-4).

5 Click OK.
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Log File Settings E|
[ Stop recording after |15 rninLike(s

[ Stop recording when log file iz 100 KB in size

Log File Path:
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Figure 10-4. Configuring Log File Settings

NOTE The log file is saved as sessionlog.txt in the directory specified in Log
File Path text box. If sessionlog.txt already exists, the log file will attempt to
save as sessionlog?2.txt, sessionlog3.txt, etc. until it finds a non-existing file
name in the specified log file path.

Using Real-Time Statistics

The Telnet Client periodically transmits emulation-specific information to
Avalanche Manager. Avalanche Manager displays the information it receives
in the Properties tab of the Avalanche Client Controls dialog box for the mobile
device.

The Avalanche Manager displays Telnet session information including:

¢ Telnet-Specific Information. This includes information on the current
Telnet Client version, the mobile device battery power, and SSL support
and use.

* Session-Specific Information. This includes information on barcode, MSR
and RFID scanning, session connect time, and running time of the current
session.
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By default, the Telnet Client transmits emulation-specific information to
Avalanche Manager every five minutes (300 seconds). You can modify this
RealTimeStatsInterval property in the Properties tab of the Avalanche Client
Controls dialog box.

This document provides the following information:
* Viewing real-time statistics

* Modifying real-time statistics

NOTE Real-Time Statistics requires Avalanche Manager 3.4 (or greater
version) and a valid Avalanche license for the mobile device.

Viewing Real-Time Statistics

You can view the real-time statistics from the Properties tab of the Avalanche
Client Controls dialog box.

To view the statistics:

1 From the Device View of Management Console, right-click the device you
want to monitor.

2 Select Client Settings.
The Avalanche Client Controls dialog box opens.
3 C(lick the Properties tab.

The Properties tab contains a number of entries specific to the Telnet Client
(Figure 10-5).
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Figure 10-5. Viewing Real-Time Statistics in Avalanche Manager

The following list describes the Telnet Client real-time statistics that are
displayed in the Properties tab.

RealTimeStatsinterval

Indicates how often the Telnet Client sends real-time

statistics information to Avalanche Manager. The
interval is measured in seconds.

Default: 300 seconds

Note: It is recommended to change the time to five
(5) seconds when you are monitoring a device.

Telnet Version
Telnet SSL Supported

Telnet Battery Power

device.

Indicates whether SSL is supported.

Displays the current version of the Telnet Client.

Indicates the remaining battery power of the mobile
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Telnet Average Time
Total

Telnet Average Time
Display

Telnet Time Running

Telnet Session <n>
Connect Time

Telnet Session <n> SSL
in Use

Telnet Session <n>
Barcode Scans

Indicates the length of time the session statistics are
tracked.

Default: 600 seconds

Indicates the interval time for barcode, MSR, and
RFID scans and transactions. The default setting (60
seconds) means that scans display as a number of
scans per minute. If you change this to property to
120 seconds, the scans display as number of scans
per two minutes.

Default: 60 seconds

Displays the current running time for the Telnet
Client.

Displays the amount of time the Telnet session has
been running, where <n> indicates the Telnet session
(1-4).

Indicates whether the Telnet session is using SSL,
where <n> indicates the Telnet session (1-4).

Displays the number of barcode scans per <x>
seconds for the Telnet Session, where <n> indicates
the Telnet session (1-4) and <x> indicates the time set
in the Telnet Average Time Display property.

Telnet Session <n>MSR Displays the number of MSR scans per <x> seconds

Scans

for the Telnet Session, where <n> indicates the Telnet
session (1-4) and <x> indicates the time set in the
Telnet Average Time Display property.

MSR scan information displays only if the mobile
device supports MSR scanning.
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Telnet Session <n> Displays the number of transactions per <x>seconds

Transaction for the Telnet Session, where <n> indicates the Telnet
session (1-4) and <x> indicates the time set in the
Telnet Average Time Display property.

Telnet Session <n> RFID Displays the number of RFID scans per <x> seconds
for the Telnet Session, where <n> indicates the Telnet
session (1-4) and <x> indicates the time set in the
Telnet Average Time Display property.

RFID scan information displays only if the mobile
device supports RFID scanning.

Modifying Real-Time Statistics

While many of the Telnet session parameters indicate they are changeable,
you should only modify RealTimeStatsInterval, Telnet Average Time Total,
and Telnet Average Time Display.

To modify a statistic:

1 From the Device View of Management Console, right-click the device you
want to monitor.

2 Select Client Settings.
The Avalanche Client Controls dialog box opens.
3 Click the Properties tab.
4 Click the Value column of the statistic you want to change.
5 Type the new Value.
6 Click the Apply Changes button.

7 Update the device to download the new property values to the device.

NOTE If the Telnet Client is currently running, modified real-time statistics
will not display until the next real-time statistics transmit to Avalanche
Manager. For example, if you modify the RealTimeStatsInterval property
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from 300 seconds to five (5) seconds, it may take the remaining seconds of the
previous 300-second setting before the statistics begin to update every five
seconds.
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Chapter 11: Manually Configuring the Telnet
Client

This section provides the following information:

You can configure certain Telnet Client parameters manually (that is, at the
mobile device), including:

* Manually Configuring Host Profiles

* Manually Configuring Emulation Parameters

Manually Configuring Host Profiles

You can manually perform the following tasks with the Telnet Client
interface:

* Creating a New Host Profile
* Modifying an Existing Host Profile

* Deleting an Existing Host Profile

NOTE When you download a new Telnet Client configuration to the mobile
device using Microsoft ActiveSync or Avalanche Manager, any manual
changes that you have made will be overwritten.

NOTE For information about host profiles, see Chapter 3: Host Profiles on
page 33.

Accessing Host Profiles

To add, modify, or delete host profile, you must access the Host Profiles dialog
box.

To access the host profiles dialog box:

1 On the mobile device, launch the Telnet Client.

2 In the Telnet Client, access the Options menu.
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3 From the Options menu, select Configure > Host Profiles.
The Input Password dialog box appears.

4 In the Input Host Config Password text box, type the RF Config
Password.

NOTE The default RF Config Password is “system”. For information about
modifying the RF Config Password, see Configuring Passwords on page 229. If
no RF Config Password is configured, the Telnet Client will not prompt you
for a password.

5 Pressthe Enter key.

The Edit Host Profile dialog box appears.
6 Use the Edit Host Profile dialog box to add, modify, or delete host profiles.
Creating a New Host Profile

You can use the Edit Host Profile dialog box to create a new host profile for the
Telnet Client.

To create a new host profile:

1 On the mobile device, launch the Telnet Client.

2 Use the Telnet Client Options menu to access the Edit Host Profiles dialog
box.

3 Inthe Edit Host Profile dialog box, click Add.
A new Edit Host Profile dialog box appears.

4 Use the Edit Host Profile dialog box to configure the basic parameters of the
host profile (alias, IP address, TCP port number, and emulation type).

5 Select More to access and configure other configuration parameters that
are specific to the emulation type that you have selected.

NOTE For more information about other configurable parameters for a host
profile, see Host Profile Settings on page 193.
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6 After you have finished configuring the host profile, select Save in the

Edit Host Profile dialog box.

The Edit Host Profiles dialog box appears, and you are returned to the first
Edit Host Profile dialog box, which now displays the new host profile.

Select Done.

The Edit Host Profile dialog box closes and you return to the primary Telnet
Client interface.

NOTE To exit either of the Edit Host Profile dialog box without saving the
changes that you have made, press Esc.

Modifying an Existing Host Profile

You can use the Edit Host Profile dialog box to modify the parameters of an
existing host profile.

To modify an existing host profile:

1

2

On the mobile device, launch the Telnet Client.

From the Telnet Client Options menu, access the Edit Host Profile dialog
box.

In the list of profiles in the Edit Host Profile dialog box, select the host
profile dialog box that you want to modify.

Select Edit.

Use the Edit Host Profile dialog box to modify the basic parameters of the
host profile (alias, IP address, TCP port number, and emulation type).

Select More to access and configure other emulation type-specific
parameters for the host profiles.

NOTE For more information about the parameters in the Edit Host Profile
dialog box and the parameters in the other emulation type-specific dialog
boxes, see Host Profile Settings on page 193.

7

After you have modified the parameters for the host profile, select Save.
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The changes that you have made are applied to the host profile. The Edit
Host Profile dialog box closes and you return to the first Edit Host Profile
dialog box.

8 Select Done.

The Edit Host Profile dialog box closes and you return to the primary Telnet
Client interface

NOTE To exit either of the Edit Host Profile dialog boxes without saving the
changes that you have made, press Esc.

Deleting an Existing Host Profile
You can use the Edit Host Profile dialog box to delete an existing profile.

To delete an existing host profile:

1 On the mobile device, launch the Telnet Client.

2 From the Telnet Client Options menu, access the Edit Host Profile dialog
box.

3 From the list of host profiles in the Edit Host Profile dialog box, select the
host profile that you want to delete.

4 Select Delete.

The host profile is deleted from the list of host profiles in the Edit Host
Profiles dialog box.

5 Select Done.

The Edit Host Profile dialog box closes and you return to the primary Telnet
Client interface.

NOTE To exit the Edit Host Profile dialog box without saving the changes that
you have made, press Esc.
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Host Profile Settings

This section provides details about the configurable parameters that are
available in the various host profile dialog boxes.

Edit Host Profile Parameters

The following list describes the options and configurable parameters in the
Edit Host Profile dialog box.

Alias

Address

Port

Emulation

Save

Indicates the name of the host profile. Usually, this is
the name or alias of the host system with which the
mobile device creates a Telnet session.

Possible Values: 1 - 50 alpha-numeric characters

Default: <None>

Indicates the IP address or host name of the host
system.

Possible Values: Any valid IP address, host name, or
web address

Default: <None>

Indicates the TCP port on which the host system is
listening for Telnet connections.

Possible Values: 0 - 65535

Default: 23

Indicates the type of emulation that the host system
uses.

Available Options: <IBM-5251-11> <IBM-3278-2>
<IBM-3279-2> <IBM-3279-2E> <VT100> <VT220>
<HP> <WEB>

Default: <IBM-5251-11>

Select this button to save the host profile and close
the Edit Host Profile dialog box.
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More Select this button to access other, emulation type-
specific parameters for the host profile.

Config Select this button to modify the emulation
parameters for the host profile.

More 5250 Options

The More 5250 Options dialog box appears when the following criteria are
met:

* You set the emulation type is to 5250 in the Edit Host Profile dialog box.

* Youclick More in the Edit Host Profile dialog box.
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The following list describes the options and configurable parameters in the
More 5250 Options dialog box.

Device Name

oK

More VT Options

Indicates the workstation ID that mobile devices use
to connect to the host system. This includes static
characters and the following switches, which are
used to capture dynamic data that is specific to each
mobile device:

* %a - %d. Captures specific octets of the IP
address of the mobile device. For example, use
Y%a%b%c%d to capture all four IP octets of the
address of the mobile device, or use %d to
capture only the last octet of the IP address of the
mobile device.

* %m - %r. Captures specific octets of the MAC
address of the mobile device. (For example, use
%pY%q%r to capture the last three octets of the
MAC address of the mobile device.)

*  %s. Captures the session number.

* %t. Captures the Avalanche terminal ID of the
mobile device. (If the mobile device is not an
Avalanche client, this parameter is invalid.)

Possible Values: 1 - 20 alpha-numeric characters
plus switches (see above)

Default Value: None

NOTE: IBM hosts usually truncate workstation IDs
that are more than 10 characters. Also, the
workstation ID should not begin with a numeric
character.

Select this button to save the changes that you have
made and return to the Edit Host Profile dialog box.

The More VT Options dialog box appears when the following criteria are met:
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* You have set the emulation type in the Edit Host Profile dialog box to

VT100, VT220, or HP.

* Youclick More in selected in the Edit Host Profile dialog box.

The following list describes the options and configurable parameters in the
More VT Options dialog box.

Telnet Negotiation
String

oK

Login

Edit AutolLogin

Indicates the Telnet negotiation string that the
mobile device should use when establishing a Telnet
session with the host system.

Possible Values: Any valid Telnet negotiation string

Default: <None>

Select this button to save the changes that you have
made and return to the Edit Host Profile dialog box.

Select this button to access the Edit AutoLogin dialog
box, which allows you to configure auto login
parameters for the host connection.

The Edit AutoLogin dialog box is accessed through the Login button in the
More VT Options dialog box.

The following list describes the options and configurable parameters in the
Edit AutoLogin dialog box.

Name Prompt

Name

Indicates the user name prompt that the host system
uses.

Possible Values: Any valid user name prompt

Default: <None>

Indicates the user name that the mobile device
supplies at the user name prompt.

Possible Values: Any valid user name

Default: <None>
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Password Prompt

Password

Command Prompt

Command

oK

Indicates the password prompt that the host system
uses.

Possible Values: Any valid password prompt

Default: <None>

Indicates the password that the mobile device
supplies at the password prompt.

Possible Values: Any valid user password

Default: <None>

Indicates the command prompt that the host system
uses.

Possible Values: Any valid command prompt

Default: <None>

Indicates the command that the mobile device
supplies at the command prompt.

Possible Values: Any valid command

Default: <None>

Select this button to save the changes that you have
made and return to the More VT Options dialog box.

Manually Configuring Emulation Parameters

You can manually configure certain Telnet Client emulation parameters on a

per-host basis.

NOTE For more information about global and per-host emulation parameters,
see Chapter 4: Emulation Parameters on page 63.
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NOTE You must use the Configuration Manager to modify most emulation
parameters. For information about using Configuration Manager, see Using
Configuration Manager on page 76.

Accessing and Modifying Per-Host Emulation Parameters
You can manually modify certain per-host emulation parameters.

To access and modify global emulation parameters:

1 On the mobile device, launch the Telnet Client.

2 Access the Telnet Client Options menu.

3 From the Telnet Client Options menu, select Configure > Emulation.
The Input Password dialog box appears.

4 In the Input Terminal Config Password text box, type the term config
password.

NOTE The default Term Config password is “config”. For information
modifying the Term Config password, see Confiquring Passwords on page 229.
If no Term Config password is configured, the Telnet Client will not prompt
you for a password.

5 Select OK.
The Select Host dialog box appears.

6 In the Select Host dialog box, select the host profile that contains the
emulation parameters that you want to modify.

7 Select OK.
The Settings dialog box appears for the host profile.

8 Use the various tabs in the Settings dialog box to modify the emulation
parameters for the host profile.
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NOTE For more information about the tabs and the configurable parameters
in each tab of the Settings dialog box, see Per-Host Emulation Parameters on
page 199.

9 After you have configured the emulation parameters for the host profile,
select the OK button in the upper right corner of the Settings dialog box.

The Settings dialog box closes and you return to the primary Telnet Client
interface.

Per-Host Emulation Parameters

This section provides information about the parameters in the various tabs of
the Settings dialog box.

VTXX Settings

Use the VTXX tab in the Settings dialog box to configure parameters for V-
type emulation. If the host profile is configured for IBM-type emulation, you
do not need to configure the VTXX tab.

The following list describes the parameters in the VTXX tab.

Local Echo Indicates whether the Telnet Client echoes characters
that it received from a VT host.

Possible Values: <Enabled> <Disabled>

Default: <Disabled>
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8 Bit Control Codes Indicates whether to use 8-bit ANSI control codes for
VT-type emulation.

Possible Values: <Enabled> <Disabled>

Default: <Disabled>

Backspace Sends Delete Indicates whether the Telnet Client should send a
delete control character when a user presses the
backspace key.

Possible Values: <Enabled> <Disabled>

Default: <Disabled>

IBM Host Settings

Use the IBM Host tab in the Settings dialog box to configure parameters for
IBM-type emulation. If the host profile is configured for VI-type emulation,
you do not need to configure the IBM Host tab.

The following table describes the configurable options in the IBM Host tab.

5250 - Column Indicates whether the Telnet Client displays a period
Separator Dot or vertical line between each character when the host
system uses a special column format mode.

Possible Values: <Enabled> <Disabled>

Default: <Enabled>
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5250 Swap Enter Key / Indicates whether the enter key is mapped to the

Field Exit

3270 - Alternate
System Request

WEB Settings

field exit key and the clear key is mapped to the
enter key.

Possible Values: <Enabled> <Disabled>

Default: <Disabled>

Indicates whether the Telnet Client encodes 3270
system requests as requests instead of default
interrupt processes.

Possible Values: <Enabled> <Disabled>

Default: <Disabled>

Use the WEB tab in the Settings dialog box to configure parameters for WEB

emulation.

The following table describes the configurable options in the WEB tab.

WEB Detect Out-Of-
Range

WEB Display Images

Indicates whether Telnet will prevent the user from
interacting with a web page if the Wireless LAN
adapter is not associated with an Access Point.

Possible Values: <Enabled> <Disabled>

Default: <Enabled>

Determines if embedded images and/or placeholders
should be displayed on web pages.

Possible Values: <No Images or Placeholders>
<Display Placeholders Only> <Display Images Only>
<Display Images and Placeholders>

Default: <Display Images and Placeholders>
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WEB HTTP Version for Determines if the HTTP 1.0 or HTTP 1.1 protocol
Direct Connections should be used for direct (non-proxy) connections.

Possible Values: <HTTP 1.0> <HTTP 1.1>

Default: <HTTP 1.1>

WEB HTTP Version for Determines if the HTTP 1.0 or HTTP 1.1 protocol
Proxy Connections should be used through proxy connections.

Possible Values: <HTTP 1.0> <HTTP 1.1>

Default: <HTTP 1.0>

WEB Play Background Determines whether or not sounds embedded in the
Sounds web page will be played.

Possible Values: <No> <Yes>

Default: <Yes>

WEB Underline Links Determines if links (anchors) on the web page will be
underlined.

Possible Values: <No> <Yes>

Default: <Yes>

Message Settings

Use the Message tab of the Settings dialog box to configure the settings for
messages that the mobile device receives from the host system. Certain
parameters in the Message tab are applicable only to 5250- and 3270-type
emulation.
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The following list describes the configurable options in the Message tab.

Message Line
(5250/3270 Only)

Auto Reset Delay
(5250/3270 Only)

Message Beeps
(5250/3270 Only)

Specifies the line from the host screen that the Telnet
Client reads to display as the message line. The
Telnet Client displays the message line each time its
contents change. When the contents of the message
line are not valid, the line appears in reverse video at
the top of the display.

Possible Values: 0 - 24
Default: 24

NOTE: Use a value of 0 to prevent the display
message.

Indicates the amount of time (in seconds) the Telnet
Client waits before sending a reset to the host when
the Reset Required parameter is set to Never.

Possible Values: 0 - 5 (seconds)

Default: 2

Indicates the number of additional beeps that occur
on the mobile device when the Telnet Client receives
a system message.

Possible Values: Up to 255 characters, but only
integer values are valid

Default: 0
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Reset Required Indicates the situations that require the user to press
(5250/3270 Only) the reset key.

Options include:

* On All Messages. Requires a reset on screens
that display information on line 24 (the
bottom display line).

* On Errors. Requires a reset on screens that
have an error indicator.

* Never. Requires the user to use a reset, but
Telnet Client automatically performs the reset
when it detects an error indicator.

Possible Values: <OnErrors> <On All Messages>
<Never>

Default: <Disabled>

Use Enter As Reset Indicates whether the enter key on the mobile device
functions as the reset key when the mobile device is
in an error state.

Possible Values: <Enabled> <Disabled>

Default: <Disabled>

Font Settings

Use the Font tab in the Settings dialog box to configure the way that text
displays for the host connection.
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The following list describes the configurable options in the Font tab.

Name

Size

Weight

Left (Clipping)

Right (Clipping)

Indicates the font that the Telnet Client uses to
display text in the emulation screen.

Possible Values: Any font installed on the mobile
device

Default Values: <Courier New>

Indicates the size (in points) in which text displays in
the emulation screens.

Possible Values: 6 - 24

Default Value: 7

Indicates the weight that is applied to text in the
emulation screens.

Possible Values: <Normal> <Bold>

Default Value: <Normal>

Indicates the amount of white space (in font points)
that the Telnet Client crops from the left of the font.

Possible Values: Up to 255 characters, but only
integer values are valid

Default Value: 0

Indicates the amount of white space (in font points)
that the Telnet Client crops from the right of the font.

Possible Values: Up to 255 characters, but only
integer values are valid

Default Values: 0
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Top (Clipping)

Bottom (Clipping)

Display Settings

Indicates the amount of white space (in font points)
that the Telnet Client crops from the top of the font.

Possible Values: Up to 255 characters, but only
integer values are valid

Default Values: 0

Indicates the amount of white space (in font points)
that the Telnet Client crops from the bottom of the
font.

Possible Values: Up to 255 characters, but only
integer values are valid

Default Value: 0

Use the Display tab in the Settings dialog box to configure how the Telnet

Client displays.

The following list describes the configurable options in the Display tab.

Menu

Hide Menu (Button)

Hide Menu (Text Box)

Indicates whether the Telnet Client displays the
Telnet Client menu during an active Telnet session.

Possible Values: <Enabled> <Disabled>

Default Value: <Enabled>

Click this button to access a dialog box that will
allow you to configure a key sequence that will hide
the Telnet Client menu during an active Telnet
session.

Indicates the key sequence that is configured to hide
the Telnet Client menu during an active Telnet
session.
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Vertical Scrollbar

Horizontal Scrollbar

Hide Keyboard (Button)

Hide Keyboard (Text
Box)

View Settings

Indicates whether the Telnet Client displays the
vertical scrollbar during a Telnet session.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Indicates whether the Telnet Client displays the
horizontal scrollbar during a Telnet session.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Click this button to access a dialog box that will
allow you to configure a key sequence that hides/
reveals the Telnet Client emulation keyboard.

Indicates the key sequence that is configured to hide/
reveal the Telnet Client emulation keyboard.

Use the View tab in the Settings dialog box to configure how the view screen
functions for the host connection.

The following list describes the configurable options in the View tab.

Free Cursor

Scrolling (Full Screen
Mode)

Indicates whether a user is allowed to move the
cursor into “protected” areas of the screen.

Possible Values: <Enabled> <Disabled>

Default Value: <Enabled>

Indicates whether the Telnet Client uses full-screen
mode, which allows the user to scroll around the
virtual display.

Possible Values: <Enabled> <Disabled>

Default Value: <Enabled>
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Scroll Offsets - Vert Specifies the number of columns that the vertical
(Full-Screen Mode Only) display moves when the cursor crosses the vertical
edge of the screen.

Possible Values: 0 - 80
Default Value: 0

NOTE: Use 0 to indicate the current vertical display
size.

Scroll Offsets - Horz Specifies the number of rows that the virtual display
(Full-Screen Mode Only) moves when the cursor crosses the horizontal edge
of the screen.

Possible Values: 0 - 24
Default Value: 0

NOTE: Use 0 to indicate the current horizontal
display size.

Fixed Screen Mode Indicates whether the Telnet Client fixes the display
on the mobile device to a specific position in the
virtual display. When fixed-screen mode is enabled,
the same portion of the virtual display appears on
the display screen without regard to the location of
the cursor.

Possible Values: <Enabled> <Disabled>
Default Value: <Disabled>

NOTE: If you enable fixed-screen mode, you must
also specify the position in the Fixed Screen
Window Origin group.
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Window Origin - Left
(Fixed-Screen Mode
Only)

Window Origin - Top
(Fixed-Screen Mode
Only)

Cursor Settings

Specifies the virtual screen column where the
display screen of the mobile device is fixed.

Possible Values: 1 - 79

Default Value: 1

Specifies the virtual screen row where the display
screen of the mobile device is fixed.

Possible Values: 1 - 24

Default Value: 1

Use the Cursor tab in the Settings dialog box to configure the function of the
cursor in emulation screens for the host connection.

The following list describes the configurable options in the Cursor tab.

Cursor Edge Zones -
Left

Cursor Edge Zones -
Right

Specifies the left border of the cursor zone in the
virtual display. When the cursor moves outside of
the border, the Telnet Client repositions the screen
over the virtual display, centering the cursor on the
display screen of the mobile device.

Possible Values: Up to 255 characters, but only
integer values are valid

Default Value: 4

Specifies the right border of the cursor zone in the
virtual display. When the cursor moves outside of
the border, the Telnet Client repositions the screen
over the virtual display, centering the cursor on the
display screen of the mobile device.

Possible Values: Up to 255 characters, but only
integer values are valid

Default Value: 1
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Tiling - Vert Mode

Tiling - Horz Mode

Tiling - Vert

Tiling - Horz

Determines how the Telnet Client handles vertical
tiling. Options include:

* None. The Telnet Client repositions the screen
on the cursor.

¢ TopOnly: The Telnet Client repositions the
screen in the uppermost row of tiles.

¢ AllL The Telnet Client always tiles vertically.
Possible Values: <All> <None> <TopOnly>

Default Value: <TopOnly>

Determines how the Telnet Client handles horizontal
tiling. Options include:

* None. The Telnet Client positions the screen
around the cursor.

¢ LeftOnly. The Telnet Client positions the
screen around the leftmost column of tiles.

¢ AllL The Telnet Client always tiles
horizontally.

Possible Values: <All> <LeftOnly> <None>

Default Value: <LeftOnly>

Specifies the height of the logical screen in “tiles” for
tiling mode.

Possible Values: 0 - screen height (in rows)

Default Value: 0

Specifies the width of the logical screen in “tiles” for
tiling mode.

Possible Values: 0 - screen width (in rows)

Default Value: 0
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Beeps Settings
Use the Beeps tab in the Settings dialog box to configure the beeps that the
mobile device plays when it receives messages or errors from the host system.

The following list describes the configurable options in the Beeps tab.

Message Beep Indicates the sound that the mobile device generates
when it receives a message from the host system.

Possible Values: <Default> <SystemAsterisk>
<SystemExclamation> <SystemExit> <SystemHand>
<SystemQuestion>

Default Value: <Default>

Error Beep Indicates the sound that the mobile device generates
when it receives an error from the host system.

Possible Values: <Default> <SystemAsterisk>
<SystemExclamation> <SystemExit> <SystemHand>
<SystemQuestion>

Default Value: <Default>

Silent Mode Indicates whether silent mode is enabled. If silent
mode is enabled, the mobile device will not play
beeps when it receives messages or errors from the
host system.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Test Tests the beep settings that are configured. The
mobile device will play the beeps that are configured
for messages and errors, in that order.

Telnet Settings

Use the Telnet tab in the Settings dialog box to configure the Telnet auto-
connect feature for connections to the host system.
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The following list describes the configurable options in the Telnet tab.

Auto Connect

Printer Settings

Indicates whether the mobile device should attempt
to reconnect to the host system when the host system
terminates the session.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Use the Printer tab in the Settings dialog box to configure the printer that the
mobile device is using for the host connection.

The following list describes the options and configurable parameters in the

Printer tab.

Printer

Port

Baud

Indicates the printer that the mobile device uses.

Possible Values: <’S1000> <PS1001> <PS1004>
<LINEPRINTER> <DUMB> <COMTEC>
<PATHFINDER> <RASCAL> <RENEGADE>
<COMTECL_PS> <CODE_COURIER>
<COMTEC_RF> <COMTEC_RF_960> <TEC> <User
Defined>

Default Value: <PS1000>

Indicates the COM port on the mobile device to
which the printer is connected.

Possible Values: <COM1>

Default Value: <COM1>

Indicates the baud rate of the serial connection to the
printer.

Possible Values: <9600> <14400> <19200> <38400>
<57600> <115200>

Default Value: <9600>
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Parity

Data

Stop

Wakeup

Indicates the parity of the serial connection to the
printer.

Possible Values: <None> <Even> <Mark> <Odd>
<Space>

Default Value: <None>

Indicates the data bits (the number of bits in each
octet) of the serial connection to the printer.

Possible Values: <4> <5> <6> <7> <8>

Default Value: <8>

Indicates the number of stop bits that the serial
connection to the printer uses.

Possible Values: <1> <2>

Default Value: <1>

Indicates the string of characters that the mobile
device sends to the printer as a wakeup. You can
represent the wakeup string as an ASCII or hex
value.

¢ Hex Value. Type the hex values of the
characters that you want the mobile device to
send to the printer. For example, 0000 sends
two nulls to the printer.

* ASCII Value. Use “<>” to enclose ASCII hex
values. For example, <00> <00> sends two
nulls to the printer.

Possible Values: Any valid wakeup string

Default Value: <None>
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Hardware Flow Control Indicates whether the serial connection to the printer
uses hardware flow control.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>

Software Flow Control Indicates whether the serial connection to the printer
uses software flow control.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>
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Appendix A: Using Microsoft ActiveSync

This section provides information about creating Microsoft ActiveSync
connections between host systems and mobile devices.

Requirements

Before you create a Microsoft ActiveSync partnership, ensure that you have
the following:

* Microsoft ActiveSync 3.7 (or better) installed on the host system
* Serial cable or USB cable to connect the host system to the mobile device

¢ Device cradle for the mobile device

Overview of Creating a Partnership
Creating a partnership involves the following tasks:

* Selecting the Microsoft ActiveSync Connection Method on the Mobile
Device.

* Selecting the Microsoft ActiveSync Method on the Host System.
* Freeing a COM Port.

* Creating a Partnership.

Selecting the Microsoft ActiveSync Connection Method on the
Mobile Device

Most mobile devices allow Microsoft ActiveSync connections over a serial or
USB connection. Before you can establish a Microsoft ActiveSync partnership,
you must select the connection method (serial or USB) on the mobile device.

To select the Microsoft ActiveSync connection method on the mobile device:

1 On the mobile device, launch Microsoft ActiveSync.

2 From the Microsoft ActiveSync Tools menu, select Options.
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NOTE The Options option is only available when the mobile device is not
engaged in an active partnership with a host system.

The PC Synchronization dialog box appears.

3 In the PC tab of the PC Synchronization dialog box, enable the Sync with
this PC during manual sync checkbox.

4 C(Click Options....
The PC Synchronization Options dialog box appears.
5 Enable the Enable PC sync using this connection checkbox.

6 From the Enable PC sync using this connection menu list, select the
connection method.

¢ If you are using a USB cable to connect the host system and the mobile
device, then select USB Default.

¢ Ifyou are using a serial cable to connect the host system and the mobile
device, select the appropriate baud rate.

7 Click OK.
The PC Synchronization Options dialog box closes.
8 Click OK.

The PC Synchronization dialog box closes and you are returned to the
Microsoft ActiveSync interface.

The mobile device is now configured with the correct synchronization
method.

Selecting the Microsoft ActiveSync Method on the Host
System

Use the Microsoft ActiveSync interface on the host system to configure the
connection method (USB or serial).
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To configure the connection method on the host system:

1 On the host system, launch Microsoft ActiveSync.

2 From the Microsoft ActiveSync File menu, select Connection
Settings....

The Connection Settings dialog box appears.

3 Use the Connection Settings dialog box to configure the connection method
between the host system and the mobile device:

¢ If you are using a USB connection, then enable the Allow USB
connection with this desktop computer checkbox.

¢ If you are using a serial connection, then enable the Allow serial or
infrared connection to this COM port checkbox, and then use the
corresponding menu list to select the COM port that you are using.

Figure A-1 provides an example.
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Connection Settings E|

Q Click Get Connected to connect your mobile device to this

iﬂa compuker.

Status: Waiting for device to connect et Conhected... |

[ Allow zerial cable or infrared connection to this COM port:

| [

Statuz:  COM port iz not available

v iAllowy USE connechion with thiz deskbop computer
Statuz:  USE iz available

[ Allow netwark [Ethernet] and Remate Access Service [RAS)
zerver connechion with thiz desktop cormputer.

Statuz:  Mebwork iz available

Statuz ican

Iv Show status icon in Taskbar.

] Cancel Help

Figure A-1. Selecting the Connection Method on the Host System

4 C(Click OK.

The Connection Settings dialog box closes and you are returned to the
Microsoft ActiveSync interface.

The host system is now configured with the correct Microsoft ActiveSync
connection method.
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Freeing a COM Port

If you are using a serial cable to connect the host system and the mobile
device, you may need to ensure that the COM port to which you connect the
serial cable is available for Microsoft ActiveSync to use.

Applications, including Microsoft ActiveSync, contend for “ownership” or
exclusive use of the COM ports on the host system. Before you attempt to
create a partnership, ensure that no other applications are using the COM
port through which you will establish the partnership with the mobile device.

To free the COM port for Microsoft ActiveSync, shut down the application or
stop the service that has control of the COM port.

For example, if you have installed Avalanche Manager on the host system and
have used Avalanche Manager to perform serial updates on the mobile
device, then Avalanche Manager may have exclusive control of the COM
ports on the host system. To free the COM port(s), access the Services
administrative tool on the host system and stop the Wavelink Avalanche
Manager service.

Creating a Partnership
Microsoft ActiveSync uses two types of partnerships:

* Standard. A standard partnership allows you to synchronize data (for
example, scheduling information) between the host system and the mobile
device. Additionally, when you create a standard partnership, you do not
have to recreate the partnership each time you reconnect the host system
and the mobile device, which is the case with guest partnerships.

* Guest. A guest partnership does not synchronize data between the host
system and the mobile device, but it requires less setup time than a
standard partnership. However, because no synchronization takes place,
you must re-establish a partnership each time you reconnect the host
system and the mobile device.

You may use either a standard or guest partnership to install the Telnet Client
and to download Telnet Client configurations to the mobile device.
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Creating a Standard Partnership

You may use a standard partnership to install the Telnet Client and download
Telnet Client configurations to the mobile device.

A standard partnership synchronizes data and settings between the host
system and the mobile device.

To create a standard Microsoft ActiveSync partnership:

1 Connect the mobile device to the host system with a serial or USB cable.

2 On the mobile device, ensure that you have selected the correct connection
method.

NOTE For more information about selecting the connection method, see
Selecting the Microsoft ActiveSync Connection Method on the Mobile Device on
page 215.

3 On the host system, ensure that you have enabled the correct connection
method.

NOTE For more information about configuring the connection method on the
host system, see Selecting the Microsoft ActiveSync Method on the Host System
on page 216.

4 If you are using a serial port to connect to the mobile device, ensure that
the serial port on the host system is free for Microsoft ActiveSync to use.

NOTE For more information about freeing a COM port on the host system, see
Freeing a COM Port on page 219.

5 On the host system, launch Microsoft ActiveSync.
6 From the Microsoft ActiveSync File menu, select Get Connected. . ..

The Get Connected dialog box appears (Figure A-2).
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Get Connected @

Get Connected

To connect your device to this PC:

1. Connect the cable to the PC
2. Turn on the device

3. Place the device in itz cradle

ActiveSunc should automatically detect vour device.

|f wour device iz not automatically detected, click Mest.
|f wouw are using infrared [IR], click Help.

Cancel Help

Figure A-2. Get Connected Dialog Box

7 C(Click Next.
Microsoft ActiveSync attempts to communicate with the mobile device.

Once Microsoft ActiveSync establishes a connection with the mobile
device, the New Partnership dialog box appears.

8 Inthe New Partnership dialog box, enable the Standard Partnership option.
9 C(Click Next.

The Specify how to synchronize data dialog box appears (Figure A-3).
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Mew Parinership @

Specify how to spnchromize data
Chooge to zunchronize with your desktop andfar a zerver

You can synchronize data, such az e-mail meszages and calendar itemsz, between wour
device and this desktop computer. Howewer, if you have access to a Microzoft Exchange
Semer with Exchange ActiveSync, pou can alzo chooze some information twpes to
synichronize directly with a server, getting the most up-to-date information, even when your
desktop computer is turned off.

Howe do wou want to synchronize with your device?

(s Sunchronize with this desktop computes

" Synchronize with Microzoft Exchange Server and/or this desktop computer

[Mote: viou muzt have acceszs to Microzoft Exchange Server with Exchange ActiveSync
or Microzoft Mobile Information Server. )

< Back | Mext = | Cancel Help

Figure A-3. Select Synchronization Settings Dialog Box

10 In the Specify How to Synchronize Data dialog box, enable the
synchronization option that you want to use.

11 Click Next.
The Select Synchronization Settings dialog box appears.
12 In the Select Synchronization Settings dialog box, enable the checkboxes the

components that you want to synchronize between the host system and
the mobile device.

NOTE You do not have to synchronize any data types to install the Telnet
Client and download Telnet Client configurations to the mobile device.

Figure A-4 shows the Select Synchronization Settings dialog box.
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Mew Parinership

Select Synchronization 5ettings
Select the type of information you want to synchronize.

To synchionize a particular type of information, select itz check box. To stop
spnchranization of that information, clear itz check baox

Maohile Device Desktop Computer i
. AvantGo LovantGo Channels

E Calendar Microzoft Qutlook,

EI Contacts icrosaft Qutlook

EJ Favaorites Intemet Explarer

1158 Files Synchronized Files =
W Inbos Microsoft Outloak,

|:| Mates Microzaft Qutloak w

To find out more about and to customize what gets synchronized, click

on that information type in the lizt and then click Settings.

< Back | Mext = | Cancel | Help |

Figure A-4. Selecting the Components to Synchronize

13 Click Next.
The Setup Complete dialog box appears.

14 Click Finish.

Microsoft ActiveSync indicates that the mobile device and the host system
are connected and synchronized (Figure A-5).
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<) Microsoft ActiveSync g|§|

Eile Wiew Tools Help

©

Sync Details Explore Options
Connected @
Synchronized
Information Type Stakus
Synchronized
Elt:n:nntacts Synchronized
Tasks Synchronized
[ﬁ' Favorites Synchronized
@Inl:u:nx Svnchronized

Figure A-5. Host System and Mobile Device Are Synchronized

The standard partnership is complete. You are now able to disconnect and
re-connect the mobile device to the host system without having to re-
create the partnership.

Creating a Guest Partnership

You may use a guest partnership to install the Telnet Client and download
Telnet Client configurations to the mobile device.

To create a guest partnership:

1 Connect the mobile device to the host system with a serial or USB cable.

2 On the mobile device, ensure that you have selected the correct connection
method.



Appendix A: Using Microsoft ActiveSync 225

NOTE For more information about selecting the connection method, see
Selecting the Microsoft ActiveSync Connection Method on the Mobile Device on
page 215.

3 On the host system ensure that you have selected the correct connection
method.

NOTE For more information about configuring the correct connection method
on the host system, see Selecting the Microsoft ActiveSync Method on the Host
System on page 216.

4 If you are using a serial port to connect to the mobile device, ensure that
the serial port on the host system is free for Microsoft ActiveSync to use.

NOTE For more information about freeing a COM port on the host system, see
Freeing a COM Port on page 219.

5 On the host system, launch Microsoft ActiveSync.
6 From the Microsoft ActiveSync File menu, select Get Connected.. ..

The Get Connected dialog box appears (Figure A-6).
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Get Connected @

Get Connected

To connect your device to this PC:

1. Connect the cable to the PC
2. Turn on the device

3. Place the device in itz cradle

ActiveSunc should automatically detect vour device.

|f wour device iz not automatically detected, click Mest.
|f wouw are using infrared [IR], click Help.

Cancel Help

Figure A-6. Get Connected Dialog Box

7 C(Click Next.
Microsoft ActiveSync attempts to communicate with the mobile device.

Once Microsoft ActiveSync establishes a connection with the mobile
device, the New Partnership dialog box appears.

8 In the New Partnership dialog box, select the Guest Partnership option.
9 C(Click Next.

Microsoft ActiveSync indicates that the guest partnership has been created
(Figure A-7).
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<) Microsoft ActiveSync

Eile Wiew Tools Help

Details Explore Options

Connected @

Information Tvpe Skatus

Figure A-7. Microsoft ActiveSync Guest Partnership
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Appendix B: Common Configuration Tasks

This section provides information about where to locate and configure
common parameters for the Telnet Client, including:

Configuring Passwords

Configuring the Number of Concurrent Sessions
Configuring IP Printing

Configuring License Server IP Address

Configuring Telnet Client Display Settings
Configuring Telnet Client Lockdown

Configuring Key Macros

Configuring Screen Panning

Configuring ActiveText

Configuring Scan Handlers

Configuring Autologin for VT Emulation
Configuring Telnet Negotiation Strings for VT Emulation
Configuring Workstation IDs for 5250/3270 Emulation

Enabling Battery Strength and Signal Strength Icons

Configuring Passwords

Certain components of the Telnet Client are password protected. Users at the

mobile device must supply a password to perform the following functions:

Manually configure host profiles
Manually configure per-host emulation parameters

Exit the Telnet Client
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NOTE By default, an exit password is not configured. If an exit password is
not configured, users are not prompted for a password when they choose to
exit the Telnet Client application.

Table B-1 provides information about and describes where each of these
parameters can be configured in host profiles.

Location in
Configuration
Function Manager Parameter Name Default Setting
Configure Host Emulation > RF Config Password | SYSTEM
Profiles Common
Configure Per-Host Emulation > Term Config CONFIG
Emulation Common Password
Parameters
Exit Telnet Client Emulation > Program Exit <None>
Common Password

Table B-1: Configuring Telnet Client Passwords

To configure a password:

1 Access the Configuration Manager.

2 In the Configuration Manager, locate the password parameter (see Table
B-1) that you want to modify.

3 Use the dialog box for the password parameter to configure the password
(Figure B-1).

Program Exit Password

Enter the passward:

|eave
Cancel

i

Figure B-1. Configuring the Terminal Configuration Passwords

4 C(Click OK.
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5 Save the new configuration.

6 Close the Configuration Manager and download the new configuration to
the mobile device.

NOTE For more information about using the Configuration Manager, see
Chapter 4: Emulation Parameters on page 63.

Configuring the Number of Concurrent Sessions

The Telnet Client allows up to four concurrent Telnet sessions. However, by
default, the Telnet Client is configured to allow a user to initiate and maintain
one session. Use the Configuration Manager to specify the number of
concurrent Telnet sessions that the Telnet Client should support.

To modify the maximum number of concurrent sessions:

1 Access the Configuration Manager.

2 Locatethe Emulation > Common > Number of Sessions
parameter.

3 Use the Number of Sessions dialog box to specify the maximum number of
sessions (Figure B-2).

Mumber of Sessions

Enter the number of sessions: K

] |
4 Cancel

Figure B-2. Modifying the Maximum Number of Concurrent Sessions

4 Click OK.
5 Save the new configuration.

6 Close the Configuration Manager and download the new configuration to
the mobile device.
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NOTE For more information about using the Configuration Manager, see
Chapter 4: Emulation Parameters on page 63.

Configuring IP Printing

Most mobile devices do not use a printer that is directly connected. Instead,
mobile devices print over the network via IP.

Use the Configuration Manager to configure mobile devices for IP printing.

To configure the Telnet Client for IP printing:

1 Access the Configuration Manager.

2 Inthe Configuration Manager, locate the Emulation > Printing >
Printer Protocol parameter.

3 In the Printer Protocol dialog box, select TCPIP (Figure B-3).

Printer Protocol

Select protocol;
TCRIP bl

Cancel

Figure B-3. Configuring Mobile Devices for IP Printing

4 Click OK.
5 Save the new configuration.

6 Close the Configuration Manager and download the new configuration to
the mobile device.

NOTE For more information about using the Configuration Manager, see
Chapter 4: Emulation Parameters on page 63.
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Configuring License Server IP Address

The Telnet Client requires a valid license for full functionality. You can
configure a license at the mobile device manually, or you can configure the
client to obtain a license from a license server on the network.

A mobile device will automatically find the license server on the local IP
subnet. However, if your license server is located on another subnet, you will
need to configure the mobile device with the IP address of the license server.

Use the Configuration Manager to configure the license server IP address.

To configure the IP address of a remote license server:

1 Access the Configuration Manager.

2 In the Configuration Manager, locate the Emulation > Common > License
Server Address parameter.

3 Use the License Server Address dialog box to configure the IP address of the
license server (Figure B-4).

License Server Address

Enter IP addresz/Host Mame of License Server's

Ok |
192.168.1.200

Cancel

Figure B-4. Configuring the License Server IP Address

4 Click OK.
5 Save the new configuration.

6 Close the Configuration Manager and download the new configuration to
the mobile device.

NOTE For more information about using the Configuration Manager, see
Chapter 4: Emulation Parameters on page 63.
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Configuring Telnet Client Display Settings

You can modify and customize the way that the Telnet Client displays,
including:

* Whether the Windows Start menu displays while the Telnet Client is
active.

¢ Whether the Telnet Client menu displays while the Telnet Client is
engaged in a Telnet session.

* Whether the vertical or horizontal scrollbars display during an active
Telnet session.

Use the Configuration Manager to customize these (and other) display
features of the Telnet Client.

Table B-2 provides a list of display options and the parameters (in the
Configuration Manager) that are used to customize these options.

Display Option

Location in the
Configuration
Manager

Parameter Name

Default Setting

Hide Windows Start

Emulation > Display

WinCE Hide Start

<Show Standard

Menu Menu Start Menu>
Hide Telnet Client Emulation > Display | WinCE Hide Menu <No>

Menu

Hide the Telnet Client | Emulation > Display | WinCE Hide Vertical | <Yes>
Vertical Scrollbar Scrollbar

Hide the Telnet Client | Emulation > Display | WinCE Hide <Yes>

Horizontal Scrollbar

Horizontal Scrollbar

Create a Key

Emulation > Display

WinCE Menu Toggle

<Default> (No key

Sequence to Hide/ Key sequence
Reveal the Telnet configured)
Client command bar

Specify the Font that Emulation > Display | WinCE Font Name <Standard>
Emulation Uses

Specify the Font Size Emulation > Display | WInCE Font Size <7>

that Emulation Uses

1 Access the Configuration Manager.

Table B-2: Customizing the Telnet Client Display

To configure a display setting:
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2 In the Configuration Manager, locate the display option that you want to
modify (see Table B-2).

3 Use the dialog box for the parameter to configure the display option
(Figure B-5).

Start ke Option:

Hide Start Menu

Cancel

Figure B-5. Configuring the Telnet Client to Hide the Windows Start Menu

4 Click OK.
5 Save the new configuration.

6 Close the Configuration Manager and download the new configuration to
the mobile device.

NOTE For more information about using the Configuration Manager, see
Chapter 4: Emulation Parameters on page 63.

Configuring Telnet Client Lockdown

You can configure several Telnet Client parameters to effectively lockdown
the Telnet Client and prevent users at the mobile device from launching other
applications on the mobile device.

NOTE When you configure Telnet Client lockdown, record your passwords
and key sequences in a secure location for administrative purposes. By
configuring lockdown, you can effectively lock yourself out of the mobile
device. If you forget the passwords that you have configured, you will be
required to reboot the system and reconfigure the Telnet Client.

Use the Configuration Manager to lockdown the mobile device.
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Table B-3 lists the parameters in the Configuration Manager that you must
use to effectively lockdown the Telnet Client.

Location in the

Parameter to Modify Configuration Manager Parameter Setting
WinCE Hide Start Menu Emulation > Display <Hide Start Menu>
WinCE Hide Menu* Emulation > Display <Yes>

WinCE Menu Toggle Key* Emulation > Display Do not configure a toggle

key (by default, no toggle
key is configured)

RF Config Password Emulation > Common Configure a secure
password

Term Config Password Emulation > Common Configure a secure
password

Program Exit Password Emulation > Common Configure a secure
password

Program Exit Key Emulation > Common Configure an exit key

* Hiding and preventing access to the Telnet Client is not mandatory to locking down the
Telnet Client, but provides an additional layer of security.

Table B-3: Configuring Telnet Client Lockdown

To configure Telnet Client lockdown:

1 Access the Configuration Manager.

2 Inthe Configuration Manager, modify the lockdown parameters (see Table
B-3).

Figure B-6 provides an example.

WinCE Hide Menu (%]
Hide Menu’:
es Cancel

Figure B-6. Configuring One of the Parameters for Lockdown

3 Save the new configuration.

4 Close the Configuration Manager and download the new configuration to
the mobile device.
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NOTE For more information about using the Configuration Manager, see
Chapter 4: Emulation Parameters on page 63.

Configuring Key Macros

Use the Configuration Manager to create, configure, or remove key macros
for emulation.

To configure a key macro:

1 Access the Configuration Manager.

2 In the Configuration Manager, locate and right-click the Emulation >
Common > Key Macro parameter.

A menu list appears.
3 From the menu list, select Add.
The Key Macros dialog box appears.

4 Use the Key Macros dialog box to configure the new key macro (Figure B-

7).
Key Macros
Enter a macro: K, |
Q020: %0008
Cancel

Figure B-7. Configuring a Key Macro

5 After you have configured the key macro, click OK.

The new key macro now appears beneath the Key Macros parameters
in the Configuration Manager (Figure B-8).
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#--[ Com Pork

=[] Ermulation
+--[0 5250 and 3270
=--[®] Cormrmon

H

M-~~~

H

o]

* 0 8 L L

o]

Auko Conneck Session
Zaps Lock,
Detect Out-OF-Range
Disconneck Inackiviky Timeouk
Disconneck Sleep Timeouk
Function Key active Menu
key Macros

g 002010005

License Server Address

Figure B-8. Key Macro in Configuration Manager

6 Save the new configuration.

7 Close the Configuration Manager.

8 Download the new configuration to the mobile device.

NOTE For more information about modifying configuration parameters and
using the Configuration Manager, see Chapter 4: Emulation Parameters on

page 63.

Configuring Screen Panning

Use the Configuration Manager to configure Telnet Client screen panning.

The screen panning feature of the Telnet Client allows a user to scroll around
the screen by tapping and dragging the stylus. By default, screen panning is
enabled on the Telnet Client.

Screen panning has two methods of operation:

e Standard

¢ Reversed
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If you want to use reverse screen panning, you must enable standard screen
panning.

To configure screen panning:

1 Access the Configuration Manager.

2 In the Configuration Manager, locate and right-click Emulation >
Display > Screen Panning.

The Screen Panning dialog box appears.

3 Use the Screen Panning dialog box to enable or disable screen panning for
the Telnet Client (Figure B-9).

S5creen Panning

Enter the value:
-

Cancel

Figure B-9. Configuring Screen Panning

4 C(Click OK.

5 If you want to enable/disable reverse screen panning, locate and right-click
Emulation > Display > Screen Panning Reversed parameters.

The Screen Panning Reversed dialog box appears.

6 Use the Screen Panning Reversed dialog box to enable or disable reverse
screen panning.

NOTE For reverse screen panning to work, you must also enable screen
panning.

7 Click OK.
8 Save the new configuration.

9 Close the Configuration Manager.
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10 Download the new configuration to the mobile device.

NOTE For more information about modifying configuration parameters and
using the Configuration Manager, see Chapter 4: Emulation Parameters on
page 63.

Configuring ActiveText

Use the Configuration Manager to configure the ActiveText feature of the
Telnet Client.

The ActiveText feature of the Telnet Client identifies certain strings of text and
converts them to objects that a user can select-and-click.

The ActiveText feature can identify two types of strings:

¢ Simple menu item

* AS/400-style function key

By default, both types of ActiveText are enabled on the Telnet Client.

Table B-4 indicates the parameters in Configuration Manager that control the
different types of ActiveText.

ActiveText Type Configuration Manager Parameter

Simple Menu Item Emulation > Common > Simple Number Menu Active Text

AS/400-Style Function Key Emulation > Common > Function Key Active Menu

Table B-4: ActiveText Parameters in Configuration Manager

To configure ActiveText:

1 Access the Configuration Manager.

2 In the Configuration Manager, locate and right-click the parameter for the
type of ActiveText that you want to configure (see Table B-4).

A dialog box for the ActiveText type appears.

3 Use the dialog box to enable or disable the ActiveText (Figure B-10).
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Function Key Active Menu

Alloves Function key on screen o be active:

Ensble [

Cancel

Figure B-10. Configuring ActiveText

4 Click OK.
5 Save the new configuration.
6 Close the Configuration Manager.

7 Download the new configuration to the mobile device.

NOTE For more information about modifying configuration parameters and
using the Configuration Manager, see Chapter 4: Emulation Parameters on
page 63.

Configuring Scan Handlers

Use the Configuration Manager to configure scan handlers.

Scan handlers allow you to define special functions that are applied to the
processing of a scan. A scan handler allows you to strip data from the
beginning or end of a scan and/or to replace certain characters within a scan.

To configure a scan handler:

1 Access the Configuration Manager.

2 In Configuration Manager, locate and right-click the Scanner >
Common > Scan Handler parameter.

A menu list appears.
3 Click add.

The Scan Handler dialog box appears.
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4 Use the Scan Handler dialog box to configure a new scan handler (Figure B-

11).

Scan Handler

Enter the Scan Handler:

|N[III][SEE]

Cancel

X
o]
owea |

Figure B-11. Configuring a Scan Handler

5 Click OK.

6 The new scan handler now appears beneath the Scan Handler
parameter in the Configuration Manager (Figure B-12.).

=[] Scanner

+--[1 Codabar
[ Codell
O Codelzs
[ Code3a
[ Code93
[ Commaon
H-- % Add Scan Identifier
&l Scans Strip End
&l Scans Strip Skark
Allow Scan Ahead
Auto Send Scans
Bidir Redundancy
Disable Scanner

B0

-

Scan Escape Code
Scan Handler

o [N
#-- % Scan Identifier

L - R

Figure B-12. Scan Handler in the Configuration Manager

7 Save the new configuration.

Mo Scanner Configuration
Remove Barcode Header
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8 Close the Configuration Manager.

9 Download the new configuration to the mobile device.

NOTE For more information about modifying configuration parameters and
using the Configuration Manager, see Chapter 4: Emulation Parameters on
page 63.

Configuring Autologin for VT Emulation

You can configure the mobile device to send automatic responses to prompts
from a host. This allows for automatic login for VI/HP emulation.

Because autologin is specific to each host system, autologin is configured in
the Host Profiles dialog box.

To configure a mobile device for automatic login to a host:
1 Access the Host Profiles dialog box.

2 From the list of host profiles in the Host Profiles dialog box, select the host
for which you want to configure autologin parameters.

3 Ensure that you have selected a VT-type or HP emulation type from the
Emulation drop-down menu in the Host tab of the Host Profiles dialog box.
(If you have not selected VI/HP emulation, you will not be able to
configure a autologin.)

4 Select the Autologin tab.

5 Configure the Autologin tab (Figure B-13).
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%3 Host Profiles rg|
Host 1 : i ig
TermProw 1 ] Language] T Settings  Autclogin l Config 41 *
Host 3
CFG in
Prompts terminal Responses

M ame: lagiry: [ fuser
Fassword: |Pazaword: [ |password
Comrmand: I

Hew Delete Cancel 0k

Figure B-13. Configuring VT Autologin

NOTE For information about the parameters in the Autologin tab, see Chapter
3: Host Profiles on page 33.

6 After you have configured the Autologin tab, click OK.

7 Download the new configuration to the mobile device.

NOTE For more information about configuring host profiles, see Chapter 3:
Host Profiles on page 33.

Configuring Telnet Negotiation Strings for VT Emulation

A Telnet negotiation string is used to identify a mobile device to a host system
and to present a client with the appropriate emulation options.

Because Telnet negotiation strings are host specific, they configured in the
Host Profiles dialog box.
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To configure a Telnet negotiation string:

1

2

Access the Host Profiles dialog box.

From the list of host profiles in the Host Profiles dialog box, select the host
for which you want to configure the Telnet negotiation string.

Ensure that you have selected a VT-type or HP emulation type from the
Type drop-down list in the Host tab of the Host Profiles dialog box. (If you
have not selected VI/HP emulation, you will not be able to configure a
Telnet negotiation string.)

In the Host Profiles dialog box, select the VT Settings tab.

In the Telnet Negotiation String text box, configure the Telnet negotiation
string that the mobile device should use when connecting to the host
system (Figure B-14).

'::‘.‘ Host Profiles

Hoszt 1 .
_ TermProxy 1 ] Language T Settings l.-'l'«uh:ulcugin] Config 4 | *
Hoszt 3
Telhet Megatiation String: |rrgun
Hew Delete Cancel 0k

Figure B-14. Configuring a Telnet Negotiation String

6

7

Click OK.

Download the new configuration to the mobile device.
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NOTE For more information about configuring host profiles, see Chapter 3:
Host Profiles on page 33.

Configuring Workstation IDs for 5250/3270 Emulation

The Telnet Client allows you to dynamically generate a workstation ID for a
mobile device. Because workstation IDs are specific to each host connection,
workstation IDs are configured in the Host Profiles dialog box.

To configure the Telnet Client to dynamically generate a workstation ID:

1

2

Access the Host Profiles dialog box.

From the list of host profiles in the Host Profiles dialog box, select the host
connection for which you want to configure a workstation ID.

Ensure that you have selected 5250/3270 emulation from the Type drop-
down list in the Host tab. (If you have not selected a 5250/3270 emulation
type, you will not be able to configure a workstation ID.)

Select the IBM Settings tab.

Use the Workstation ID text box to configure the dynamic generation of a
workstation ID for mobile devices that use the host profile (Figure B-15).
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=3 Host Profiles rg|
Hast 2 Hast | TemProsmy 1| Language |BM Settings l Configuration |
Hogt 3

Woorkstation |0 |D CxaxbZoid

MOTE: The warkstation D MUST be different for
each terminal. Use the follmwing to create a unigue
workstation 1D:

%a-¥d = |P address

Em - %r = MAC address

= = Session number

b = terminal 1D

Hew Delete Cancel 0k

Figure B-15. Configuring the Workstation ID

6 Click OK.

The new configuration is saved to the host system and the Host Profiles
dialog box closes.

7 Download the new configuration to the mobile device.

NOTE For more information about configuring host profiles, see Chapter 3:
Host Profiles on page 33.

Enabling Battery Strength and Signal Strength Icons
Battery-strength and wireless signal-strength indicator icons are available in
Telnet Client 5.1 (and greater versions). You may configure the following
indicator-icon settings:

* Whether to display the signal strength icon

* Whether to display the batter power icon
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* Whether to display the icon(s) on the Windows system tray, the Telnet
Client command bar, or elsewhere on the screen

* The relative size (large or small) of the icon(s)

To enable the battery power indicator:

1 Access the Configuration Manager for the Telnet Client global emulation
parameters.

2 In Configuration Manager, locate Emulation > Display >
Indicators (Figure B-16).

+--[J Common
=-[ Display

H

&8 BB BB - BB BB - - BB

o= [ ST S-S R - S-S

ClearType Enable

ClearType Font Smookhing Contrast
Cursor Colurnn OFfset

Cursor Fow Offset

Enable Scrolling

Fixed Screen Left Edge

Fixed Screen Mode

Fixed Screen Top Edge

Font Clip Bokbom

Font Clip Left

Font Clip Right

Font Clip Top

Fank Mame

Fank Size

Font Weight

Force Black and White

Horizontal Scroll

Indicators
% Enable Battery Strength Indicator
% Enable Signal strength Indicator
¢ Indicators Preferred OFf-Screen
% Indicators Screen Settings

Figure B-16. Configuring Indicators

3 Usethe Enable Battery Strength Indicator parameter to
enable/disable the battery strength indicator icon.
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4 Usethe Enable Signal Strength Indicator parameter to enable/
disable the wireless signal strength indicator.

5 Usethe Indicators Preferred Off-Screen parameter to
configure where the icon(s) are displayed (the Windows system tray, the
Telnet Client command bar, or on the screen itself).

6 If you did not use the Indicators Preferred Off-Screen
parameter to display icons only in the Windows system tray or Telnet
Client command bar, then use the Indicators Screen Settings
parameter to configure the location and relative size (large or small) of the
indicator icon(s) on the screen.

7 Save the new configuration.
8 Close the Configuration Manager.

9 Download the new configuration to the mobile device.

NOTE For more information about configuring global emulation parameters,
see Chapter 4: Emulation Parameters on page 63.

Configuring Indicator Settings

Table B-5 provides information about configuring the indicator settings to
meet your needs:

Parameter in
Configuration

command bar or Windows
system tray (whichever is

available, starting with the
Windows system tray)

Indicators > Indicators
Preferred Off-Screen

Desired Effect Manager Setting Notes
Display icon(s) in Windows Emulation > Display > | <System Tray Do not hide
task-tray only Indicators > Indicators | Only> the Windows

Preferred Off-Screen start menu
Display icon(s) in Telnet Client | Emulation > Display > | <Command Do not hide
command bar only Indicators > Indicators | Bar Only> the Telnet

Preferred Off-Screen Client

command bar

Display icon(s) in Telnet Client | Emulation > Display > | <Command —

Bar or System
Tray>

Table B-5: Configuring Battery and Signal Strength Indicators
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Parameter in
Configuration
Desired Effect Manager Setting Notes
Display icon(s) on emulation Emulation > Display > | <No> —
screen (not in the command Indicators > Indicators
bar or the system tray) Preferred Off-Screen
Specify location and size of Emulation > Display > | Select your Set Indicators
icons Indicators > Indicators | preferred Preferred Off-
Screen Settings option for Screen to No
location and
size

Table B-5: Configuring Battery and Signal Strength Indicators
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Appendix C: Using the Telnet Client License
Server

This section provides the following information:
* Telnet Client License Server Overview
¢ Installing the Telnet Client License Server

* Using the License Server

Telnet Client License Server Overview

The Telnet Client license server is a Windows-based application that provides
licenses to mobile devices that are using the Telnet Client.

NOTE The Telnet Client license server should not be confused with the
Avalanche license server. They are separate applications.

The Telnet Client license server allows you to store licenses for Telnet Clients
at a central location. Those licenses are then automatically distributed to
mobile devices that request them.

Telnet Client licenses are distributed to mobile devices in the following
manner:

1 When the Telnet Client application is first activated on a mobile device, the
mobile device broadcasts a request for a license.

2 The license server responds to the mobile device with a license.
3 The mobile device accepts a license and responds to the license server.

Once a Telnet Client obtains a license, it keeps the license until one of the
following criteria are met:

* The license expires.

¢ The Telnet Client discovers that another mobile device is using the same
license.
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When either of these criteria are met, the Telnet Client discards the license
and requests a new license from the license server.

NOTE You can also configure the Telnet Client to request a license from a
license server on a remote network. For more information about configuring
the Telnet Client to request a license from a specific license server, see
Configuring License Server IP Address on page 233.

License Server Versions and Maintenance Licenses

Currently, two versions of license server are available: version 1.0 and version
2.0. Version 1.0 does not support Telnet Client maintenance licenses or 5.0 (or
greater) platform licenses.

If you will be using a license server to distribute 5.0 (or greater) platform
licenses or maintenance licenses, please contact Wavelink customer service to
obtain the latest version of license server.

NOTE Appendix D: Wavelink Contact Information on page 261 contains Wavelink
contact information.

To see which version of license server you have:

1 Launch the license server application.

2 Right-click the title bar of the license server window.
A menu list appears.

3 Select About License Server....

The About License Server dialog box appears (Figure C-1).



Appendix C: Using the Telnet Client License Server 253

About License Server

Wavelink License Server

Gj) Yerzion 2.0
=

Copynght 2002-2005 ' avelink Corporation

Figure C-1. About License Server Dialog Box

The About License Server dialog box displays the license server version
number.

Installing the Telnet Client License Server

This section provides information about installing the Telnet Client license
server as a basic Windows application or as a dedicated Windows service.

Installation Methods

You may use one of the following methods to install the Telnet Client license
server:

* Windows Application. When you use this method, the Telnet Client
license server runs as a basic application on the host system. If you reboot
the host system, you must manually re-launch the license server.

* Windows Service. When you use this method, you configure the Telnet
Client to run as a dedicated Windows service on the host system. This
allows you to automatically restart the license server in the event that the
host system must be rebooted. It also allows the license server to operate
without requiring a Windows login.

Installing the License Server as a Windows Application

You can install the Telnet Client as a basic Windows application. In the event
that the host system is rebooted, you must manually relaunch the license
server application on the host system.
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Installation Requirements

Ensure that the system on which you will install the Telnet Client license
server meets the following specifications:

e Microsoft Windows 2000/XTP
¢ 1MB hard disk space

* Network connection that provides bi-directional communication with
Telnet Clients that will receive licenses from the license server.

Installing the License Server

The Telnet Client license server is a simple executable that should be

transferred to the host system.

To install the license server:

1 Obtain the LicenseServer.exe file.

NOTE For information about obtaining client licenses and the Telnet Client
license server, contact Wavelink Corporation or your Wavelink
representative. Appendix D: Wavelink Contact Information on page 261 contains
Wavelink contact information.

2 Copy LicenseServer.exe toan accessible location on the host system.

NOTE You may want to create a shortcut to LicenseServer.exe onthe
desktop of the host system.

3 Double-click LicenseServer.exe tobegin running the Telnet Client
license server.

The license server interface appears.

NOTE For information about using the license server, see Using the License
Server on page 255.




Appendix C: Using the Telnet Client License Server 255

Installing License Server as a Windows Service

It is possible to create a dedicated Windows service from the
LicenseServer.exe file.

To create a license server service, you will need the Service Installer
application that is included in the Microsoft Windows 2000 Resource Kit.

Because creating the license server service requires you to modify Windows
registry settings, the exact process that is required is not detailed in this

document. Please work directly with Microsoft to configure the license server
to run as a dedicated Windows service.

Using the License Server

This section provides information about using the Telnet Client license server,
including:

* Launching the License Server

¢ Adding a License

* Releasing a License

* Viewing License Information

¢ Removing a License

Launching the License Server

To launch the license server and access the GUI that will allow you to add,
remove, and view licenses, execute LicenseServer.exe.

When you launch LicenseServer.exe, the License Server GUI appears (Figure
C-2).
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W License Server
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Wiew License

Remove License

Release License
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Figure C-2. License Server GUI

The following is a list of notes about running the license server.

* Only one instance of a license server may be running on the network. If
you launch the license server and another license server is running, you
will receive an error message.

¢ If you are running the license server as a Windows service, stop the service
before you launch LicenseServer.exe.

Adding a License

Add a license to the license server that the license server can then distribute to
mobile devices running the Telnet Client.

To add a license to license server:

1 Launch the license server.
The license server GUI appears.

2 C(lick Add Licenses.
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The Wavelink Authorization dialog box appears (Figure C-3).

&F Wavelink Authorization

Licenzee Mame

Platfarm Werzion

Serial Humber

Expiration Date

|
|
|
[Jzer Lirnit |
|
Authanzation Code |

Add

Figure C-3. Wavelink Authorization Dialog Box

3 In the Wavelink Authorization dialog box, input the information for the
license, where:

¢ Licensee Name is the name of the party to which the license was
distributed.

¢ Platform Version is the list of emulation types that the license
supports. (The platform version is case sensitive.)

¢ Serial Number is the serial number of the license.
¢ User Limit is the number of users that the license supports.

¢ Expiration Date is the expiration date of the license in the format
MMDDYYYY.

e Authorization Code is the authorization code for the license.
4 After you have input the license information, click Add.

A dialog box appears that indicates that the license was successfully added
as shown.

5 Click OK.

6 Click Close to exit the Wavelink Authorization dialog box.
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The license now appears in the license server GUIL

7 Expand the license to view how many of the user spaces in the license
have been taken.

Licenses that have been taken display the MAC address of the mobile
device that acquired the license.

Releasing a License

You can use the license server GUI to free up a license. This does not
immediately force the client that holds the license to release that license.
Instead, it frees the license for the license server to distribute to another
mobile device. You should make sure that the mobile device that previously
acquired the license is not operating on the network.

To release a license:

1 Access the license server GUI.
2 Locate the license that you want to release.
3 C(Click Release License.
The LicenseServer dialog box appears.
4 Click Yes.

The license server GUI now indicates that the client license is unassigned
and can be distributed to another mobile device.

Viewing License Information

You can use the license server GUI to view information about a license.

To view information about a license:

1 Access the license server GUI.
2 From the list of installed licenses, select the license that you want to view.
3 C(lick view License.

The View License dialog box appears and displays the details of the
license.
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4

Click Close to close the View License dialog box.

Removing a License

If a license is no longer valid, you may remove it from license server.

To remove a license from license server:

1

2

Access the license server GUI.

From the list of licenses that are installed, select the license that you want
to remove.

Click Remove License.

The LicenseServer dialog box appears and requests confirmation of the
deletion.

Click Yes.

The license is deleted from the license server and removed from the license
server GUI.
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Appendix D: Wavelink Contact Information

If you have comments or questions regarding this product, please contact
Wavelink Customer Service via email or telephone.

Email: customerservice@wavelink.com

Phone: 425-823-0111
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802.11/a/b

access point

ad hoc mode

Agent

AP

automatic WEP

Avalanche Agent

Avalanche Client

Avalanche Enabler

The IEEE standards for wireless Ethernet. 802.11
provides for wireless networking speeds up to 2
Mbps at 2.4 GHz. 802.11b provides wireless
networking speeds up to 11 Mbps at 2.4 GHz.
802.11a provides wireless networking speeds up to
54 Mbps at 5 GHz.

A device that acts as a bridge between wireless
LANSs and wired LANS.

A mode of operation in wireless networks wherein
wireless devices communicate directly with each
other without the use of an access point. Also
sometimes referred to as peer-to-peer mode or an
independent basic service set (IBSS).

In the context of Avalanche Manager, an Avalanche
Agent. See Avalanche Agent.

Access Point. See Access Point.

A dynamic implementation of WEP keys, wherein
the key used on the wireless network changes
periodically. Clients must synchronize their WEP
key use with the AP.

An Avalanche Manager Agent. A software
component that provides the core functionality of
Avalanche Manager. The Agent facilitates
communication with Avalanche clients.

A mobile device with an installed Avalanche
Enabler, which allows the client to communicate
with an Avalanche Agent and to be configured and
managed through Avalanche Manager.

A software component that is installed on mobile
devices which allows you to configure and manage
the device through Avalanche Manager. The Enabler
facilitates communication between the mobile device
and an Agent.
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Avalanche Enabler SDK A software development kit that allows you to create
Avalanche Enablers for Windows CE devices.

Avalanche Management The GUI that allows you to interact with and
Console configure Avalanche Agents.

Avalanche Manager Wavelink Corporation’s management application
that allows you to configure and manage mobile
devices throughout your network infrastructure.

Avalanche Monitor A component of certain Avalanche Enablers that
communicates with the Avalanche Agent and, at
certain times, checks for available updates.

Avalanche Update A component of certain Avalanche Enablers that

Utility provides most of the functionality. You can use the
Avalanche Update Utility to configure the network
parameters of the mobile device, view the progress
of a download, and/or install updates that have been
downloaded to the client.

Avalanche Software A specially bundled piece of software, for example a

Package firmware update to a radio card or a commonly used
application, that you can download to a client
through Avalanche Manager.

Avalanche Update A download (or modification) that is available to a
client through Avalanche Manager. Examples of
updates include software packages and network
profiles. The deletion of orphaned packages from a
client through Avalanche Manager is another type of

update.

BOOTP Bootstrap Protocol. A protocol that allows clients to
automatically obtain IP parameters from a BOOTP
server.

client In the context of Avalanche Manager, an Avalanche

client. See Avalanche Client. In the context of the
TNCE Client, a mobile device that connects via the
TNCE Client to a host system.

DHCP Dynamic Host Configuration Protocol. An IP service
that allows DHCP clients to automatically obtain IP
parameters from a DHCP server.



Glossary 265

DNS Domain Name System. A service that provides host
name-to-IP address mapping.

.edf Enabler Definition File

Emulation Parameters A feature of the TNCE Client that allows you to pre-
configure and install terminal emulation-related
functions to a mobile device.

Emulation Parameters, Terminal emulation-related functions that apply to
global all host profiles that are configured on a mobile
device.

Emulation Parameters, Terminal emulation-related functions that apply to
host specific only a specific host profile that is configured on a
mobile device.

Enabler In the context of Avalanche Manager, an Avalanche
Enabler. See Avalanche Enabler.

Enabler Configuration A software package that allows you to configure the

Utility various Avalanche Windows Enabler settings on a
client from the Avalanche Management Console.
(Specific to the Windows Enabler.)

Enabler Profile In the context of the Avalanche Enabler SDK, a set of
parameters that a developer specifies that are used
by the Avalanche Enabler SDK to produce an
Avalanche Enabler. The parameters of the profile are
stored in an .edf file.

Enabler SDK See Avalanche Enabler SDK.

ESS ID Extended Service Set ID. The identifier of an
extended service set for devices that are

participating in an infrastructure mode wireless
LAN.

FTP File Transfer Protocol. A TCP-based service that
provides connection-oriented file transfers.

FTP Server A host system that provides FIP services. Users are
required to log into the FTP service to gain access to
files that can be downloaded from the server.
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gateway

GUI

host

host profile

IBSS

ICMP

IDA Commands

infrastructure mode

IP address

LAN

lease

localization

A device on a local network through which data to
other networks is routed. Also called a router.

Graphical User Interface

A server or workstation that hosts a specific software
or network service.

A service of the TNCE Client that allows you to
install pre-configured host information (such as IP
address and Telnet service TCP port) on mobile
devices.

Independent Basic Service Set. See ad hoc mode.

Internet Control Messaging Protocol. Part of the
TCP/IP protocol suite that provides services for
testing IP network connections.

A special value used to invoke a device action,
program action, or emulator action within the Telnet
Client Industrial Browser.

A wireless network configuration wherein devices
communicate with each other through an access
point.

Internet Protocol address. A virtual address that
uniquely identifies a network connection.

Local Area Network

A DHCP lease. The parameters surrounding the IP
address a client has obtained from a DHCP server.

A service of the TNCE Client that allows you to
configure the TNCE Client to display in a specific
language.
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MAC address Media Access Controller address. The hard-coded
layer-2 address of a network connection which
consists of a 12-digit hexadecimal number. The first 6
hexadecimal characters identify the manufacturer.
The last 6 hexadecimal numbers are unique for each
network device produced by the manufacturer. The
MAC address is also sometimes called the hardware
address.

Management Console  In the context of Avalanche Manager, the Avalanche
Management Console. See Avalanche Management

Console.

MB Megabytes

Mbps Megabits / second

META tag Tags that allow web pages to enable specific
functionality in the browser.

mobile device A wireless device or a PC with a wireless network
connection.

net mask See subnet mask.

network profile A set of pre-configured network parameters (ESS ID,

IP address, and so forth) that can be downloaded to
a client through Avalanche Manager.

orphaned package A software package that has been deployed to a
client through Avalanche Manager, but has been
disabled or is not recognized by the Agent. You must
orphan a software package before you can use
Avalanche Manager to delete it from the client.

ping An IP service that is used to test IP connectivity. Part
of the ICMP service.
RAM Random Access Memory. Volatile memory in a

computer system.
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real-time statistics A feature that allows the Telnet Client to send Telnet
session information to Avalanche Manager. That
information can then be viewed from the Avalanche
Client Controls dialog box. The real-time statistics
feature is only available for Avalanche-deployed
Telnet Clients.

RF Radio Frequency. Usually used in the context of a
type of network connection.

router See gateway.

SDK Software Development Kit.

selection criteria A feature of Avalanche Manager that allows you to

configure a set of filters that target specific mobile
devices on the network. You can filter by MAC
address, IP address, device type, operating system,
and so forth. Selection criteria are used to target
specific mobile devices on the network for
Avalanche Updates.

Session Monitor An Avalanche-integrated component of the Telnet
Client that allows a user at the Avalanche
Management Console to monitor or control the
Telnet Client. Session Monitor is available for
Avalanche-deployed Telnet Clients only.

silent install A feature of the Avalanche Enabler that allows for
the installation of software packages on clients
without the consent of the user at the client.

silent mode A feature of the Avalanche Enabler that allows the
Avalanche Monitor to run in the background on the
client in a manner that is transparent to the user at
the client.

software package In the context of Avalanche Manager, an Avalanche
software package. See Avalanche Software Package.

SSID Service Set Identifier. A unique name, up to 32
characters long, that is used to identify a wireless
LAN. The SSID is attached to wireless packets and
acts as a password to connect to a specific BSS or
ESS.
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static WEP

subnet

subnet mask

TCP/IP

Telnet

TFTP

Telnet Client

update

WEP

Windows CE

Static (or manual) implementation of WEP keys.
When the administrator of the network changes the
WEP key, users must manually select the correct
key.

A logical network wherein each client is
participating on the same IP network.

A type of filter that allows IP clients to determine
which part of their IP address defines the network
and which part defines the host.

Transmission Control Protocol/Internet Protocol. A
suite of protocols that provides virtual addressing,
connection-oriented and connectionless
communication, and a number of other network
services and utilities.

A TCP/IP utility that is used for terminal emulation
and that allows a client to connect and interact with
a remote host system.

Trivial File Transfer Protocol. A UDP-based service
that provides connectionless file transfers.

Wavelink Corporation application that provides
client-side terminal emulation services for Microsoft
Windows CE-based mobile devices.

In the context of Avalanche Manager, an Avalanche
update. See Avalanche Update.

Wired Equivalent Privacy. An encryption standard
for wireless networks that provides the equivalent
security of a wired connection for wireless
transmissions.

A Microsoft Windows-based operating system for
mobile devices.
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Windows Enabler

WINS

An Avalanche Enabler that is designed for Microsoft
Windows 9x/ME/NT/2000/XP systems with installed
802.11b wireless cards.

Windows Internet Naming Service. A service that
provides Windows name-to-IP address mapping.
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Numerics
5250/3270 virtual keyboard 143
802.11/a/b 263

A
about
emulation parameters 63
global emulation parameters 64
host profiles 12
keyboard creator 13
localization 13
maintenance licenses 121
per-host emulation parameters 63
platform licenses 121
scripting 13
SSL 13
Telnet Client 11
access point 263
accessing
global emulation parameters 64
per-host emulation parameters 69
activation method 87
on barcode, MSR or RFID Scan 90
on key combination 88
on screen update 91
select from menu 88
when session connects 89
activetext
configuring 240
using 149
ad hoc mode 263
adding
alicense 256
host profiles 36
agent 263

alphabetized view, configuration
manager 80

AP 263
authorization 119

autologin for VT emulation, configuring 243

automatic WEP 263
Avalanche Agent 263
Avalanche client 263
Avalanche Enabler 263
Avalanche Enabler SDK

edf, defined 265

enabler profile, defined 265

Avalanche Management Console,
defined 264

Avalanche Manager, defined 264
Avalanche Monitor, defined 264
Avalanche software package, defined 264
Avalanche update 264

Avalanche update utility, defined 264

battery strength icon 247
beeps settings 211
BOOTP 264

C
certificate verification, enabling 42
client 264
cold boot recovery 18
COM port, freeing 219
concurrent telnet sessions, configuring 231
configuration manager
alphabetized view 80
find 79
using 76
configuration support matrix 20
configuring
activetext 240
autologin for VT emulation 243
emulation parameters 64
failover 47
host profiles 35
IP printing 232
key macros 237

license server IP address 233
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number of concurrent sessions 231
passwords 229

scan handlers 241

screen panning 238

session monitor 178

Telnet Client 18

Telnet Client display settings 234

Telnet Client lockdown 235

Telnet Client with Avalanche Manager 21

Telnet Client with Microsoft
ActiveSync 23

telnet negotiation strings for VT
emulation 244

TermProxy-only connections 45

workstation IDs for 5250/3270
emulation 246

connecting to hosts 129
contact information 261
creating script code 92

cursor settings 209

D
deleting host profiles 38

demo license, using 126
deploying
configurations 24
configurations via Avalanche Manager 25

configurations via Microsoft
ActiveSync 31

deploying keyboards 117
deploying scripts 104
developing
web pages 165
DHCP 264
diagnostics utility
accessing 151
performing a keyboard test 152
performing a scan test 154
performing a Windows keyboard test 155
diagnostics utility, using 151

disconnecting a Telnet session 135

display settings 206
display settings, configuring 234
DNS 265
document
assumptions 9
conventions 9

revision history 11

edit autologin 196
editing scripts 100
emulation parameters
about 12, 63
configuring 64
defined 265
global 64
global, defined 265
manually configuring 197
modifying 78
per-host 63
per-host, defined 265
using configuration manager 76
Emulation Parameters, global 265
Emulation Parameters, host specific 265
Enabler 265
Enabler configuration utility 265
Enabler profile 265
enabling
certificate verification 42
indicator icons 247
session monitor 178
SSL 40
ESSID 265
executing scripts
on barcode, MSR or RFID scan 106
on key combination 105
on screen update 106
select from menu 104
when session connects 105
exiting the Telnet Client 136
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exporting 102
exporting scripts 102

F
figures
about license server dialog box 253

accessing per-host emulation
parameters 74

accessing the virtual emulation
keyboard 142

ActiveSync installation and configuration
utility 19

alphabetized view in the configuration
manager 81

authorizing terminal dialog box 124, 126

available unconnected Telnet session 138

configuration manager 66, 68, 77

configuration manager for per-host
emulation parameters 72, 75

configuring autologin settings 60

configuring emulation parameters from
Avalanche 67

configuring host settings 49
configuring IBM settings 56
configuring indicators 248

configuring log file settings 183

configuring per-host emulation parameters

from Avalanche 73

configuring per-host emulation settings 62

configuring TermProxy settings 52
configuring the Telnet Client package 21
configuring the TermProxy tab 48
configuring VT settings 58
connecting to session monitor 181
demonstration period expired 120
disconnecting a session 141
disconnecting a Telnet session 135
emulation parameter information 78
enabling certificate validation 43
enabling session override 182

enabling SSL for a host profile 41

enabling TermProxy-only connections 46
exiting the Telnet Client 136
get connected dialog box 221, 226
host profiles dialog box 36
host system and mobile device are
synchronized 224
inputting a string to find 80
launching session monitor 180
license server GUI 256
managing SSL certificates 44
Microsoft ActiveSync guest
partnership 227
modifying an emulation parameter 78
performing a keyboard test 153
performing a scan test 155
performing a Windows keyboard test 156
RAPI gateway in Avalanche Manager 27
select host dialog box 134

select synchronization settings dialog

box 222

selecting the components to
syncrhonize 223

selecting the connection method on the
host system 218

selecting the license type 123

selecting to configure per-host emulation
parameters 71

serial ports enabled in Avalanche
Manager 26

setting the software collection
synchronization medium 29

switching to a different Telnet session 139

Telnet Client 5250/3270 virtual emulation
keyboard 144

Telnet Client available host profiles 34
Telnet Client default screen 131, 133
Telnet Client diagnostics utility 152

Telnet Client running in demonstration
mode 127

Telnet Client shortcut icon 130

Telnet Client shortcut icon in the Avalanche
Enabler 132
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Telnet Client virtual emulation
keyboard 142

Telnet Client VT/HP virtual emulation
keyboard 145

viewing real-time statistics in Avalanche
Manager 185

Wavelink authorization dialog box 257

Wavelink product configuration dialog

box 23,31, 65,70
find 79
font settings 204
freeing a COM port 219
FTP 265
FTP server 265

G
gateway 266

global emulation parameters
about 64
accessing 64

GUI 266

H
host 266
host failover 47
host profile
WEB settings 169
host profile, defined 266
host profiles 94
about 12
adding 36
and SSL. 39
and TermProxy 45
configuration settings 62
configuring 35
deleting 38
edit autologin 196
host settings 49
IBM settings 55
manually configuring 189

modifying 37

more 5250 options 194
more VT options 195
overview 33
TermProxy settings 51
VT settings 57

WEB settings 55

IBM Host settings 200

IBSS 266

ICMP 266

IDA Commands 170

IDA Commands,defined 266
importing keyboard graphics 113

importing scripts 100

indicator icons 247

Industrial Browser

basic navigation 164
host profile settings 164
overview 159

using 164

infrastructure mode 266

initiating a Telnet session 133

installing

license server 253

SSL support package on host system 39
SSL support package on mobile device 40
Telnet Client 17

IP address 266
IP printing, configuring 232

K

key macros, configuring 237

keyboard creator

about 13
launching 107

overview 107

keyboard files 109
keyboard test 152
keyboards
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deploying 117
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sizing 112
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keys
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configuring 113
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L
LAN 266
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session monitor 180
Telnet Client 129
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Telnet Client from Windows 130
lease 266
license server
installation methods 253
installing 253
using 255
versions 252
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licenses
maintenance 121
platform 121
licensing
adding a license 256
demo license 126
manually licensing the Telnet Client 122
methods 120, 122

overview 119

releasing a license 258

removing a license 259

the Telnet Client 119
types 121

using license server 123

viewing license information 258

localization
about 13
defined 266

lockdown, configuring 235

M

MAC address 267

maintenance licenses
about 121

license server versions 252

management console 267

MB 267

Mbps 267

message settings 201
META tag, defined 267
META tags 165
Microsoft ActiveSync

creating a guest partnership 224
creating a standard partnership 220
freeing a COM port 219

selecting connection method on host

system 216

selecting mobile device connection

method 215
mobile device 267
modifying

emulation parameters 78
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o

options menu 156
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P
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creating a standard partnership 220
guest partnership 224
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about 63
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IBM host settings 200
Industrial Browser settings 201
manually configuring 199
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printer settings 212
telnet settings 211
view settings 207
VTXX settings 199
ping 267
platform license 121
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RAM 267
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releasing a license 258

removing a license 259

RF 268
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S

saving scripts 102
scan handlers, configuring 241
scan test 154
screen panning
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using 149
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script code 92
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launching from Avalanche Manager 84
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deploying 104
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Microsoft ActiveSync connection on mobile
device 215

selection criteria 268

session monitor
configuring 178
enabling 178
launching 180
session override 181
tracing sessions 182
using 178

signal strength icon 247
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